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LEADTOOLS ePrint 5 Professional

Introduction

 XE "What LEADTOOLS ePrint 5 Professional Can Do " \* MERGEFORMAT What LEADTOOLS ePrint 5 Professional Can Do

LEADTOOLS ePrint 5 Professional allows you to:
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Convert and save your files, using any application that supports printing, to any of over 140+ file-supported formats. These include:

· Document file formats such as searchable PDF, DOC, RTF, HTML, and Text;

· Raster file formats such as TIFF, JPEG, GIF, PNG, and non-searchable PDF;

· Vector file formats such as DXF, DWF, PCL, and CGM.
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Save one or more printed jobs, whether they are document files, vector files or raster images, using any of the supported file formats.
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Combine multiple documents or images into one single document file (such as PDF) or image file (such as TIFF).
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Create PDF documents with enhancements like PDF watermarks, bookmarks, or security.
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Redirect your printed job(s) to one or more physical printers at the same time.
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Manipulate your printed job(s) using ePrint's "Enhanced Printing" features.
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Add annotation objects to the printed document through the LEADTOOLS ePrint 5 Workstation.
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Add stationery or forms to the printed document to customize the appearance of the document pages.
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Configure the Email settings and access the contact list from the default or user specified MAPI client.
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Control the file naming and renaming options when saving multi-page files with each page as a separate file.
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Add Task Printers that can perform complex batch processing from any application that can print, with or without user interaction.
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In addition to all of the above, LEADTOOLS ePrint 5 Professional provides all the standard features of a windows printer driver.

Supported Environments:

LEADTOOLS ePrint 5 Professional comes in WIN32 and x64 editions that can run under the following environments:
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Microsoft Windows ME
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Microsoft Windows 2000
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Microsoft Windows XP (32 and 64 bit)
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Microsoft Windows 2003 (32 and 64 bit)
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Microsoft Windows Vista (32 and 64 bit)

For full details regarding all ePrint components and platforms, refer to:

ePrint Documentation
 XE "References " \* MERGEFORMAT 

 XE "Documentation " \* MERGEFORMAT ePrint Documentation

LEADTOOLS is committed to fully documenting its products. Please feel free to contact us with any errors or omissions.

Microsoft HTML Help 1.0

Microsoft HTML Help 1.0 (.chm) files for all ePrint components and platforms are installed with your product. Help files are found on the installation path in the \Help\ subdirectory (for example, C:\Program Files\LEAD Technologies, Inc\LEADTOOLS ePrint 5\Help\).

WebHelp

WebHelp that contain the most-current version of LEADTOOLS documentation is available online at:

http://www.eprintdriver.com/help-files.html
Printable reference manuals

Printable reference manuals that contain the same information as online help can be downloaded from our website at:

http://www.eprintdriver.com/help/v5.0/Printable_Documentation/.

For more information:

Specific help references for each ePrint component and platform are available as follows:

	
	WebHelp (Online)

	

	
	ePrint 5 Activation

	
	ePrint 5 API SDK

	
	ePrint 5 COM SDK

	
	ePrint Terminal Server edition

	
	LEADTOOLS Screen Capture Application

	
	LEADTOOLS Screen Capture Toolbar


See Also:

Technical Support
 XE "Worldwide Web " \* MERGEFORMAT 

 XE "Technical support " \* MERGEFORMAT 

 XE "Support " \* MERGEFORMAT 

 XE "Phone " \* MERGEFORMAT 

 XE "Internet " \* MERGEFORMAT 

 XE "Home page " \* MERGEFORMAT 

 XE "FTP " \* MERGEFORMAT 

 XE "FAX " \* MERGEFORMAT 

 XE "BBS " \* MERGEFORMAT Technical Support

As a registered user, free technical support is available. You must register your software to receive any technical support. You can contact us through the following methods:

	E-mail:
	eprintsupport@leadtools.com

	FAX: 
	(704) 372-8161

	Home page: 
	http://www.eprintdriver.com

	Forum:
	http://support.leadtools.com/SupportPortal/cs/forums/26/ShowForum.aspx

	FAQ:
	http://www.eprintdriver.com/faq.html

	FTP:
	ftp.leadtools.com


You can also contact LEAD by mail at:

LEAD Technologies, Inc.
Attn: Technical Support
Suite 400
1201 Greenwood Cliff,
Charlotte, NC 28204

Before contacting technical support, please look in the online documentation and the example programs for an answer to your question.

 XE "Shortcuts " \* MERGEFORMAT Copyright Notices

©Copyright LEAD Technologies, Inc. 1991-2007. ALL RIGHTS RESERVED

Portions of the PCDLIB32.DLL, PCDLIB.DLL, LFFPX7.DLL, LFKODAK.DLL, EKFPIXJPEG140.DLL, PDC_SDK.DLL, PROFIRE.DLL and DC120V154_32.DLL files contain material that is ©Copyright Eastman Kodak Company, 1996.

Portions of the LFFPX7.DLL and LFKODAK.DLL files contain material that is ©Copyright Hewlett Packard, 1996.

The "FlashPix" format uses Microsoft's OLE structured storage.

Use of the embedded font features for certain Licensed Fonts found in the PDF Properties portion of the software may require a license from the owner of the applicable Licensed Font. Please refer to the software Help file for more information.

Portions hereof licensed under US patent 5,327,254 and foreign counterparts.

Trademarks

LEAD®, LEADTOOLS® and ePrint ® are registered trademarks of LEAD Technologies, Inc.

Microsoft, Windows, Windows NT, Visual Basic, Visual FoxPro, and Microsoft Access are either trademarks or registered trademarks of the Microsoft Corporation. 

FlashPix™ is a trademark of Eastman Kodak Company.

All other brand or product names used in this online help are trademarks of their respective holders.

Address and Contact Information

LEAD Technologies, Inc.
Suite 400,
1201 Greenwood Cliff,
Charlotte, NC 28204
FAX: (704) 372-8161
Technical support: eprintsupport@leadtools.com
Home page: http://www.eprintdriver.com.

Installation

 XE "Windows XP " \* MERGEFORMAT 

 XE "Windows NT " \* MERGEFORMAT 

 XE "Windows ME " \* MERGEFORMAT 

 XE "Windows 98 " \* MERGEFORMAT 

 XE "Windows 95 " \* MERGEFORMAT 

 XE "Windows 2000 " \* MERGEFORMAT 

 XE "WIN32 " \* MERGEFORMAT 

 XE "System requirements " \* MERGEFORMAT 

 XE "SP3 " \* MERGEFORMAT 

 XE "Operating system requirements " \* MERGEFORMAT 

 XE "NTFS " \* MERGEFORMAT 

 XE "Memory " \* MERGEFORMAT 

 XE "LEADTOOLS ePrint 5 Professional Minimum System Requirements " \* MERGEFORMAT 

 XE "ePrint IV " \* MERGEFORMAT LEADTOOLS ePrint 5 Professional Minimum System Requirements

LEADTOOLS ePrint 5 Professional comes in WIN32 and x64 editions that can run under the following environments:

[image: image18.png]


Microsoft Windows ME
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Microsoft Windows 2000
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Microsoft Windows XP (32 and 64 bit)
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Microsoft Windows 2003 (32 and 64 bit)
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Microsoft Windows Vista (32 and 64 bit)

Installation Notes:

[image: image23.png]


For installation you will need either a CD-ROM drive (if you plan on installing the program from a CD), or an Internet connection (if you intend to download the program).
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ePrint requires Administrator rights to install and Ordinary User rights or above to use.
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After installation, the ePrint program takes up approximately 15 MB in the system folder and 25 MB in the target directory for the installation. 

[image: image26.png]


Memory and additional hard disk space requirements when ePrint is being used depend on the printer settings used, the paper size used, and the number of pages printed. More information is provided in the following sections.

Memory requirements: 

System memory requirement for ePrint depends upon specified paper size and printed DPI. The larger the paper dimensions, and the greater the specified DPI, the more system memory required.

To calculate memory required in MB, multiply (paper width in inches) X (paper length in inches X specified DPI) X (6) X (.001).

For example, for Paper size=letter and DPI=300, memory required=(8.5) x (11) X (300) X 6 = approximately 50 MB. For Paper size=letter and DPI=600, memory required= approximately 200 MB.

Hard-Disk requirement:

ePrint needs space to store processed pages. ePrint stores its processed pages in the system Temp directory, and deletes them when it has finished processing them. Each page (depending on the paper dimension and the amount of information in the printed page) needs approximately 2MB on the hard disk. For example, 100 pages require approximately 200 MB of free space on the drive that contains the system Temp folder.

Miscellaneous:

For the Windows 2000 users, the Use Document Name option will not work properly unless you install SP3.

For the NTFS file system users, ePrint requires read access to the System Temp folder to work properly.

It is not necessary to uninstall ePrint IV before installing ePrint 5.

 XE "Task Printers Manager " \* MERGEFORMAT 

 XE "Task Printers " \* MERGEFORMAT 

 XE "Screen Capture Application " \* MERGEFORMAT 

 XE "Read Me First " \* MERGEFORMAT 

 XE "Printers Folder " \* MERGEFORMAT 

 XE "LEADTOOLS ePrint Workstation " \* MERGEFORMAT 

 XE "LEADTOOLS ePrint Printer Driver " \* MERGEFORMAT 

 XE "LEADTOOLS ePrint 5 Professional Components " \* MERGEFORMAT 

 XE "Installing the driver " \* MERGEFORMAT 

 XE "Installing for development " \* MERGEFORMAT 

 XE "ePrint IV " \* MERGEFORMAT Quick Look at LEADTOOLS ePrint 5 Professional Components

LEADTOOLS ePrint 5 Professional consists of the following components:
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LEADTOOLS ePrint Printer Drivers
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LEADTOOLS ePrint Workstation
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Task Printers Manager
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LEADTOOLS Screen Capture Application
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LEADTOOLS Screen Capture Toolbar

When LEADTOOLS ePrint 5 Professional is installed, icons to launch LEADTOOLS ePrint Workstation, Task Printers Manager, LEADTOOLS Screen Capture, Read Me First, and Help are added to the Windows Start menu. At the same time, ePrint and ePrint Workstation are installed as virtual printers in your system Printers folder. They will appear in the list of optional printers in the Print dialog of any application on your computer that supports printing. Finally, the LEADTOOLS Screen Capture Toolbar is made available on your Windows taskbar.

It is not necessary to uninstall ePrint IV before installing ePrint 5.

File Conversion via Virtual Printing

When LEADTOOLS ePrint 5 Professional is installed, two virtual printers are installed to the Printers folder on your system:
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ePrint 5
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ePrint 5 Workstation

Use the ePrint 5 printer to perform quick, simple printing and file conversion tasks. You can use this printer from within any application by using its print command. When the Print dialog appears, select the LEADTOOLS ePrint 5 printer as your printer and click OK (if the application prints directly to the printer with no Print dialog, be sure to set the ePrint 5 printer as your default printer before you print). The LEADTOOLS ePrint Save As dialog will appear to give you the ability to save, email, or route the document being printed.

Use the ePrint 5 WorkStation printer when you also want to perform advanced functions like add annotations to files, create stationery or forms, combine multiple files, or perform document management. Access the LEADTOOLS ePrint 5 Workstation directly from the Start menu. Then use the Workstations File -> Open command to load the file with which you want to work. You can also use the ePrint 5 Workstation from within any application by using its print command. When the Print dialog appears, select the LEADTOOLS ePrint 5 Workstation printer, then click OK (if the application prints directly to the printer, be sure to set the ePrint 5 Workstation printer to be the default printer beforehand). This loads the LEADTOOLS ePrint 5 Workstation application, with the item being printed loaded as a print job. 

Batch Processing, eMailing, and Printing

The LEADTOOLS ePrint 5 Workstation lets you create a "task printer" that can perform a series of defined actions, for example to convert, save, and send a series of images to specific printers or email addresses. Use the Task Printers Manager to manage the task printers that you create. Access the Task Printers Manager directly from the Start menu (LEADTOOLS ePrint 5 -> Tools-> Task Printers Manager), or from within LEADTOOLS ePrint 5 Workstation (Tools -> Task Printers Manager).

API help files, code examples, and binaries are also installed that enable developers to programmatically control printer settings from within their own applications. For more information, refer to the  LEADTOOLS ePrint 5 API Help.

LEADTOOLS Screen Capture

LEADTOOLS ePrint 5 Professional also includes a powerful screen capture application, and a quick-use screen capture toolbar that you can add to your Windows taskbar. For more information on these components, refer to the  LEADTOOLS Screen Capture Application and  LEADTOOLS Screen Capture Toolbar help files.

See Also

How To: Use LEADTOOLS ePrint 5 Professional for the First Time
How To: Use LEADTOOLS ePrint 5 Workstation for the First Time
ePrint Task Printer Creation Wizard
Task Wizard
 XE "watermarks " \* MERGEFORMAT 

 XE "Serial Number " \* MERGEFORMAT 

 XE "Extension Code " \* MERGEFORMAT 

 XE "Extending " \* MERGEFORMAT 

 XE "Activation Wizard " \* MERGEFORMAT 

 XE "Activation Code " \* MERGEFORMAT 

 XE "Activating " \* MERGEFORMAT 

 XE "30 days " \* MERGEFORMAT 

 XE "15 days " \* MERGEFORMAT Activation Wizard

Use the  Activation Wizard to activate the LEADTOOLS ePrint 5 Professional product or to extend the evaluation period from 15 days to 30 days.

To display the Activation Wizard, from the main menu, choose Help -> Activate Product.

 XE "Uninstalling LEADTOOLS ePrint 5 Professional " \* MERGEFORMAT Uninstalling LEADTOOLS ePrint 5 Professional

	1.
	Click the Windows Start button.

	2.
	Choose Settings -> Control Panel.

	3.
	Double-click the Add/Remove Programs utility icon.

	4.
	Select the Change or Remove Programs tab.

	5.
	Find LEADTOOLS ePrint 5 Professional in the list of installed programs and click on it to select it.

	6.
	Click the Remove button.

	7.
	A message box will appear to verify removing LEADTOOLS ePrint 5 Professional from the system.

	8.
	Click the Yes button.

	9.
	Follow the on-screen prompts.


ePrint Quick Start: How To...

 XE "How To:Use LEADTOOLS ePrint 5 Professional for the First Time " \* MERGEFORMAT 

 XE "How To " \* MERGEFORMAT How To: Use LEADTOOLS ePrint 5 Professional for the First Time

This topic briefly describes how to get started and use the basic features of LEADTOOLS ePrint 5 Professional. For more information, please refer to the relevant help sections.

The easiest way to access and change the settings for ePrint is to print from any application that supports printing:

	1.
	Open a file in your preferred application, then select "File"  "Print".

	2.
	When the "Print" dialog appears, select "LEADTOOLS ePrint 5", then click the Print button.

	3.
	The LEADTOOLS ePrint Save As dialog will appear to allow you to save the printed document.

	4.
	Use the dialog to select the file type and format for the version you wish to save, along with any special options.


See Also

How To: Save to a Document File (Searchable PDF, MS DOC, HTML, etc.)
How To: Save to an Image File (TIFF, JPEG, GIF, PNG, etc.)
How To: Save to a Vector File (CGM, DXF, SHP, etc.)
 XE "Word to .pdf conversion " \* MERGEFORMAT 

 XE "TIFF to PDF " \* MERGEFORMAT 

 XE "TIFF conversion " \* MERGEFORMAT 

 XE "Text to PDF " \* MERGEFORMAT 

 XE "Searchable PDF " \* MERGEFORMAT 

 XE "RTF to PDF " \* MERGEFORMAT 

 XE "RTF converter " \* MERGEFORMAT 

 XE "print to pdf " \* MERGEFORMAT 

 XE "print to file " \* MERGEFORMAT 

 XE "print to almost any file format " \* MERGEFORMAT 

 XE "PPT to PDF " \* MERGEFORMAT 

 XE "Powerpoint to PDF " \* MERGEFORMAT 

 XE "PDF to TIFF " \* MERGEFORMAT 

 XE "PDF to JPG " \* MERGEFORMAT 

 XE "PDF to JPEG " \* MERGEFORMAT 

 XE "pdf printer " \* MERGEFORMAT 

 XE "pdf creator " \* MERGEFORMAT 

 XE "PDF converter " \* MERGEFORMAT 

 XE "MS DOC file conversion " \* MERGEFORMAT 

 XE "image conversion " \* MERGEFORMAT 

 XE "html to Word " \* MERGEFORMAT 

 XE "HTML to DOC " \* MERGEFORMAT 

 XE "How To:Convert Files " \* MERGEFORMAT 

 XE "How To " \* MERGEFORMAT 

 XE "File conversion " \* MERGEFORMAT 

 XE "DRW conversion " \* MERGEFORMAT 

 XE "DOC to PDF " \* MERGEFORMAT 

 XE "DOC converter " \* MERGEFORMAT 

 XE "Converting files " \* MERGEFORMAT 

 XE "Adobe writer " \* MERGEFORMAT 

 XE "Adobe converter " \* MERGEFORMAT 

 XE ".txt to .pdf " \* MERGEFORMAT 

 XE ".tif to .pdf " \* MERGEFORMAT 

 XE ".rtf to .pdf " \* MERGEFORMAT 

 XE ".ppt to .pdf " \* MERGEFORMAT 

 XE ".pdf converter " \* MERGEFORMAT 

 XE ".html to Word " \* MERGEFORMAT 

 XE ".html to .doc " \* MERGEFORMAT 

 XE ".doc to .pdf " \* MERGEFORMAT 

 XE ".doc converter " \* MERGEFORMAT How To: Quickly Convert Files Using the ePrint 5 Printer

Using any application that includes a print function, the ePrint 5 virtual printer can convert from one file format to any of the 140 file formats LEADTOOLS ePrint 5 Professional supports.

The following example will show you how to use LEADTOOLS ePrint 5 Professional to convert a document file from Microsoft Word (.doc) to searchable PDF (.PDF) format. Use this example’s basic steps to convert file(s) from any format to any other format:

	1.
	Open a .doc file in Microsoft Word and then select File -> Print.

	2.
	Select LEADTOOLS ePrint 5 from the printer Name list and click OK.

	3.
	The LEADTOOLS ePrint Save As dialog will appear to allow the user to save the printed document.

	5.
	Select the "Document Formats" item from the File type list.

	6.
	Select the "PDF" item from the Save as list.

	7.
	Click the Options button to show the PDF Save As Options dialog.

	8.
	In the General Tab, ensure "Automatic" is selected in the Version list. Click the Options button to show the PDF Save As Options dialog. For more information on other PDF formatting options, visit the PDF Save As Options page of the help documentation.

	9.
	Now click the OK button to save the options.

	10.
	Now click the Save button to save searchable PDF file.

	11.
	After a few moments, you should find the saved PDF document on the path that you selected with the name you specified.


For more information, please refer to:

Technical Support
 XE "How To:Use LEADTOOLS ePrint 5 Workstation for the First Time " \* MERGEFORMAT 

 XE "How To " \* MERGEFORMAT How To: Use LEADTOOLS ePrint 5 Workstation for the First Time

This topic briefly describes how to use the basic features of LEADTOOLS ePrint 5 Workstation and provides you with all you need to know in order to get started. For more information, please refer to the relevant help section.

Launching ePrint 5 Workstation

There are two ways to access and change the settings for the LEADTOOLS ePrint 5 Workstation:

[image: image34.png]


ePrint 5 Workstation is accessible when printing from any application with printer support by selecting the printer Name: LEADTOOLS ePrint5 Workstation from the Print dialog. Or, 

[image: image35.png]


open ePrint 5 Workstation directly from the Windows Start menu: Start -> Programs -> LEADTOOLS ePrint 5 Professional menu.

Each of these methods is described in detail in the following sections.

When Printing from an Application

	1.
	Open a file in your preferred application that supports printing and select "File"  "Print".

	2.
	When the "Print" dialog appears, select "LEADTOOLS ePrint 5 Workstation", then click the Print button.

	3.
	The LEADTOOLS ePrint 5 Workstation will open with the file loaded into the work area.

	4.
	Edit, annotate, or otherwise manipulate the file.

	5. 
	From the menu, select "File"  "Save As…", select the desired file type and format, and then click Save.


When Launching from the Start menu

You can also access the LEADTOOLS ePrint 5 Workstation application from the start menu:

The Workstation will open and documents can be imported manually.

	1.
	From Start -> Programs -> LEADTOOLS ePrint 5 Professional menu, select LEADTOOLS ePrint Workstation. The LEADTOOLS ePrint 5 Workstation will open.

	2.
	From the menu, select File  Open. The file selection dialog will open.

	3.
	Navigate to and select the file you want to work with, then click OK.

	4.
	Edit, annotate, or otherwise manipulate the file.

	5. 
	From the menu, select File  Save As…, select the desired file type and format, and then click Save.


See Also

How To: Use LEADTOOLS ePrint 5 Professional for the First Time
 XE "Word to .pdf conversion " \* MERGEFORMAT 

 XE "Word File Format " \* MERGEFORMAT 

 XE "TIFF to PDF " \* MERGEFORMAT 

 XE "TIFF conversion " \* MERGEFORMAT 

 XE "Text to PDF " \* MERGEFORMAT 

 XE "Searchable PDF " \* MERGEFORMAT 

 XE "Searchable files " \* MERGEFORMAT 

 XE "Saving searchable files " \* MERGEFORMAT 

 XE "Saving PDF files " \* MERGEFORMAT 

 XE "Saving DOC files " \* MERGEFORMAT 

 XE "RTF to PDF " \* MERGEFORMAT 

 XE "RTF converter " \* MERGEFORMAT 

 XE "PPT to PDF " \* MERGEFORMAT 

 XE "Powerpoint to PDF " \* MERGEFORMAT 

 XE "PDF to TIFF " \* MERGEFORMAT 

 XE "PDF to JPG " \* MERGEFORMAT 

 XE "PDF to JPEG " \* MERGEFORMAT 

 XE "pdf printer " \* MERGEFORMAT 

 XE "PDF File Format " \* MERGEFORMAT 

 XE "pdf creator " \* MERGEFORMAT 

 XE "PDF converter " \* MERGEFORMAT 

 XE "MS Word File Format " \* MERGEFORMAT 

 XE "MS DOC file conversion " \* MERGEFORMAT 

 XE "MS DOC " \* MERGEFORMAT 

 XE "image conversion " \* MERGEFORMAT 

 XE "html to Word " \* MERGEFORMAT 

 XE "HTML to DOC " \* MERGEFORMAT 

 XE "How To:Save to a Searchable PDF: MS DOC: HTML: etc. File " \* MERGEFORMAT 

 XE "How To " \* MERGEFORMAT 

 XE "File conversion " \* MERGEFORMAT 

 XE "DRW conversion " \* MERGEFORMAT 

 XE "DOC to PDF " \* MERGEFORMAT 

 XE "DOC File Format " \* MERGEFORMAT 

 XE "DOC converter " \* MERGEFORMAT 

 XE "Converting files " \* MERGEFORMAT 

 XE "Combine files " \* MERGEFORMAT 

 XE "Adobe writer " \* MERGEFORMAT 

 XE "Adobe converter " \* MERGEFORMAT 

 XE ".txt to .pdf " \* MERGEFORMAT 

 XE ".tif to .pdf " \* MERGEFORMAT 

 XE ".rtf to .pdf " \* MERGEFORMAT 

 XE ".ppt to .pdf " \* MERGEFORMAT 

 XE ".pdf converter " \* MERGEFORMAT 

 XE ".html to Word " \* MERGEFORMAT 

 XE ".html to .doc " \* MERGEFORMAT 

 XE ".doc to .pdf " \* MERGEFORMAT 

 XE ".doc converter " \* MERGEFORMAT How To: Save to a Document File (Searchable PDF, MS DOC, HTML, etc.)

Files saved to Document file types retain searchable text. For example, when a file is saved as Document file type with PDF format, the resulting PDF file is automatically searchable. (For more information on the Find and Search commands available in Adobe Acrobat, third-party search engines, and the Adobe PDF Filter, refer to http://www.adobe.com/support/techdocs/321627.html.)

Perform the following steps in order to create a Document (in this case, Searchable PDF) file.

	1.
	On the Save As dialog, select "Document Formats" from the File type list.

	2.
	Select "PDF" from the Save as list.

	
	Note: From the Save As dialog, if you select File Type: "Image Formats," then select PDF, you create a non-searchable PDF file. This will cause the content to fixed and un-editable.

	3.
	Click the Options button to show the PDF Save As Options dialog.

	4.
	In the General Tab, ensure "Automatic" is selected in the Version list. Click the Options button to show the PDF Save As Options dialog. For more information on other PDF formatting options, visit the PDF Save As Options page of the help documentation.

	5.
	Click the OK button to save the options. The dialog will close.

	6.
	Click the Save button to save the searchable PDF file.


 XE "Word to .pdf conversion " \* MERGEFORMAT 

 XE "TIFF to PDF " \* MERGEFORMAT 

 XE "TIFF saving options " \* MERGEFORMAT 

 XE "TIFF conversion " \* MERGEFORMAT 

 XE "Text to PDF " \* MERGEFORMAT 

 XE "Saving multi-page files to a single file " \* MERGEFORMAT 

 XE "Saving image files " \* MERGEFORMAT 

 XE "RTF to PDF " \* MERGEFORMAT 

 XE "RTF converter " \* MERGEFORMAT 

 XE "PPT to PDF " \* MERGEFORMAT 

 XE "Powerpoint to PDF " \* MERGEFORMAT 

 XE "PNG files " \* MERGEFORMAT 

 XE "PDF to TIFF " \* MERGEFORMAT 

 XE "PDF to JPG " \* MERGEFORMAT 

 XE "PDF to JPEG " \* MERGEFORMAT 

 XE "pdf printer " \* MERGEFORMAT 

 XE "pdf creator " \* MERGEFORMAT 

 XE "PDF converter " \* MERGEFORMAT 

 XE "Non-searchable PDF files " \* MERGEFORMAT 

 XE "Multi-page files " \* MERGEFORMAT 

 XE "MS DOC file conversion " \* MERGEFORMAT 

 XE "JPEG files " \* MERGEFORMAT 

 XE "Image files " \* MERGEFORMAT 

 XE "image conversion " \* MERGEFORMAT 

 XE "html to Word " \* MERGEFORMAT 

 XE "HTML to DOC " \* MERGEFORMAT 

 XE "How To:Save to an Image File " \* MERGEFORMAT 

 XE "How To " \* MERGEFORMAT 

 XE "GIF files " \* MERGEFORMAT 

 XE "File conversion " \* MERGEFORMAT 

 XE "DRW conversion " \* MERGEFORMAT 

 XE "DOC converter " \* MERGEFORMAT 

 XE "Converting files " \* MERGEFORMAT 

 XE "Combining multi-page files " \* MERGEFORMAT 

 XE "Combine PDF files " \* MERGEFORMAT 

 XE "Combine files " \* MERGEFORMAT 

 XE "BMP files " \* MERGEFORMAT 

 XE "Adobe writer " \* MERGEFORMAT 

 XE "Adobe converter " \* MERGEFORMAT 

 XE ".txt to .pdf " \* MERGEFORMAT 

 XE ".tif to .pdf " \* MERGEFORMAT 

 XE ".rtf to .pdf " \* MERGEFORMAT 

 XE ".ppt to .pdf " \* MERGEFORMAT 

 XE ".pdf converter " \* MERGEFORMAT 

 XE ".html to Word " \* MERGEFORMAT 

 XE ".html to .doc " \* MERGEFORMAT 

 XE ".doc converter " \* MERGEFORMAT How To: Save to an Image File (TIFF, JPEG, GIF, PNG, etc.)

LEADTOOLS ePrint 5 Professional lets you save raster images such as TIFF, JPEG, GIF, PNG, non-searchable PDF, BMP, etc. 

The example below describes how to save an image file to a raster format (in this case, non-searchable PDF).

To save a file as a raster PDF file type:

	1.
	Select the "Image Formats" item from the File type list.

	2.
	Select the "PDF (*.pdf)" item from the Save as list.

	3.
	Click the Options button to show the Raster Images Files Save As Options dialog.

	4.
	Select the desired Color Depth. If you are not certain which to use, select "True Color (24 bit)". 

	 
	Note: Color Depth represents the bits per pixel, which is the number of bits that will be used to store information about a particular pixel in the image. The bits per pixel correlates to how many unique values of color levels are available to describe the pixel. When using 24 bits per pixel, 16.7 million colors are available and this format is least likely to compromise the output quality.

	5.
	Now click the OK button to save the options.

	6.
	Now click the Save button to save raster PDF file.


Note: Multi-page gif files are created as animated gifs and are not viewable in applications that only display static gifs.

 XE "Vector files " \* MERGEFORMAT 

 XE "How To:Save to a Vector File " \* MERGEFORMAT 

 XE "How To " \* MERGEFORMAT 

 XE "Combine files " \* MERGEFORMAT How To: Save to a Vector File (CGM, DXF, SHP, etc.)

The vector file format describes images in terms of mathematical formulas instead of a grid of bit data.

Perform the following steps to save a file in a vector file format.

	1.
	Select the "Vector Formats" item from the File type list.

	2.
	Select one of the vector formats listed in the Save as list (for example, Computer Graphics Metafile (*.cgm)).

	3.
	Click the Save button to save the printed document.


For more information saving specific file formats, please refer to the relevant help section.

 XE "How To:Prepare Fail-Safe Paper Settings " \* MERGEFORMAT 

 XE "How To " \* MERGEFORMAT 

 XE "Changing paper or graphics settings " \* MERGEFORMAT How To: Prepare Fail-Safe Paper Settings

ePrint Paper settings only act as a "fail-safe" in case the originating document does not contain paper information. Most file types have a predefined paper type, so this setting is rarely used. If the host application uses paper settings, the ePrint paper settings will be over-ridden by the application being used to print the file. 

For example, if you print from Microsoft Word to either the ePrint or ePrint Workstation virtual printer, Microsoft Word sends paper size information along with the file. If you wish to select a different paper size, you should do so in Microsoft Word’s Page Setup or Print Properties dialog.

If you are not sure whether your application sends paper size with its print jobs, use the following steps to provide this information using ePrint:

	1.
	Select Start -> Settings -> Printers, then right-click on the LEADTOOLS ePrint 5 Professional icon and select Properties.

	2.
	Click on the General tab of the LEADTOOLS ePrint 5 Professional Properties dialog and then click the Printing Preferences Button.

	3.
	Select the intended size from the Paper Size Option combo box.

	4.
	Click the Add button to open the Custom Paper dialog to create a new paper size.

	
	Type in the name of the new paper size in the Name edit box.

	
	Use the radio buttons in the "Unit to use" section to select the unit of measure. Use 0.1 Inches to set the unit of measure to inches. Use 0.1 mm to set the unit of measure to millimeters. Select the 0.1 Inches radio button.

	
	 

	
	Click the OK button to create the new custom paper size.

	5.
	Click the Edit button to bring up the Custom paper dialog to modify an existing custom paper size.

	6.
	Click the Delete button to delete a custom paper size.

	7.
	Note that only custom paper sizes can be modified or deleted.

	8.
	Select either the Portrait or the Landscape Option radio button from the Orientation Option group box.

	9.
	Click OK on the Paper tab of the LEADTOOLS ePrint 5 Professional Properties dialog.
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When you covert between file types, final file size depends on both paper size and desired resolution. In general, images that will only be displayed on-screen require lower resolution than images intended for use in print. Lower resolution images result in a smaller file size and therefore require less storage space.

	1.
	From the Windows toolbar, select Start -> Settings -> Printers and Faxes, then right-click on the LEADTOOLS ePrint 5 icon and select Printing Preferences.

	2.
	Click on the Graphics tab of the LEADTOOLS ePrint 5 Professional Printing Preferences dialog.

	3.
	Select the desired resolution from the Resolution Option combo box. If you select "Custom", the Custom Resolution group appears to let you type in specific X and Y DPI resolutions. Valid values range from 50 – 1600 for both the X and the Y resolution.

	4.
	Click OK on the Graphics tab of the LEADTOOLS ePrint 5 Professional Properties dialog.


Using LEADTOOLS ePrint

 XE "How Does ePrint Work? " \* MERGEFORMAT How Does ePrint Work?

LEADTOOLS ePrint 5 Professional behaves like a printer installed on your Windows operating system. However, unlike printer drivers, which simply pass information along to the printer for printing on paper, ePrint captures the data stream being "printed" so that you can convert it to almost any document, image or vector format desired.

Once ePrint is installed, it is instantly available to any application that can send a print job, without any additional configuration. LEADTOOLS ePrint 5 Professional comes in two forms: the ePrint 5 printer and the ePrint Workstation printer. Which one you choose to use depends on how much control you want over the documents you produce.

ePrint 5 printer. The ePrint 5 printer takes you directly to format selection screen for quick, efficient, no-hassle document conversion. 

ePrint Workstation printer. The ePrint Workstation printer is available for advanced document manipulation and even more control over the files you convert. 

Either of these printers is accessible at any time in most applications by selecting it from the print dialog.

See Also

How To: Use LEADTOOLS ePrint 5 Workstation for the First Time
What LEADTOOLS ePrint 5 Professional Can Do
ePrint Toolbars
Using Keyboard Shortcuts
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Converting a file using ePrint is done through the print option of any application that can print documents or graphics.

To quickly convert a file using ePrint 5, perform the following steps:

	1.
	Open a document in your preferred application that supports printing and select "File"  "Print".

	2.
	When the "Print" dialog appears select "LEADTOOLS ePrint 5" and click the Print button.

	3.
	The LEADTOOLS ePrint Save As dialog will appear to allow the user to save the printed document.

	4.
	Here, the user may select a file type and format for saving the printed document as well as customize the options available for the selected format.


To create a file with annotations, stationery or any of the other more advanced features of the ePrint 5 Workstation, use the following steps:

	1.
	Open a document in your preferred application that supports printing and select "File"  "Print".

	2.
	When the "Print" dialog appears, select "LEADTOOLS ePrint 5 Workstation" and click the Print button.

	3.
	The LEADTOOLS ePrint 5 Workstation will open with the printed document loaded into the work area as a print job for editing.

	4.
	Refer to the Documentation for the Main Menu of the ePrint Workstation to begin examining how to use this application.


See Also

How To: Save to a Searchable PDF, MS DOC, HTML, etc. File
How To: Save to an Image File (TIFF, JPEG, GIF, PNG, etc.)
How To: Save to a Vector File
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The workspace is the opening screen in ePrint Workstation. This is the area that displays opened files as "print jobs" that can be converted, annotated, or sent to printers or email. There are many options to customize the view of the workspace, including toolbars, a status bar and various windowpanes that can be hidden or displayed for navigating and editing the loaded document. For more information, refer to Customizing The Workspace.

Once a document has been imported as a print job, it can have annotations placed over the document including highlighting, images, shapes, lines, text notation and measurements of items placed in the document.

Annotations are only editable in the ePrint WorkStation at the time the document is created. Once a document has been converted into another format using ePrint, the changes are permanent in the resulting document. A saved file cannot be loaded later into the ePrint workstation for other annotations, nor can annotations be deleted.

See Also

Page Navigation Toolbar
Annotation Tools Toolbar
Annotation Properties Toolbar
Annotation Text Alignment Toolbar
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Customization of the workspace options is primarily accessible through the ePrint Workstation Main Menu under the View option. From this option set, you can access zooming, page view, toolbars and various windowpanes options.

The toolbars are collections of tools grouped by similarity. Toolbars can be turned on and off by checking or unchecking the toolbar options under View > Toolbars. By clicking and dragging the far left side of a toolbar, you can place the toolbar anywhere you like in the application window. When near the top of the workspace, the toolbar will dock itself to the toolbar area. The appearance and behavior of the toolbars may vary slightly depending on your version of windows.

Windowpanes are dialogs that do not interrupt the normal workflow, but allow you to make changes to your documents or view additional information by extending the visible interface of the workspace. Panes can be docked to the sides of the workspace by clicking and dragging the top left of the pane to the left, top or right edge of the workstation. Panes can also be combined by clicking and dragging one pane onto another. (Combined panes will have a tab menu at the bottom for switching views between the selected panes.)

See Also

View Menu
ePrint Toolbars
 XE "Using Forms and Stationery " \* MERGEFORMAT Using Forms and Stationery

Stationery and forms allow you to add a watermark to your documents using either text or images. These options can be placed on all, even, odd or only a custom range of pages within the document as specified by the user.

The stationery option lets you position and customize text that you specify in your document. Some simple applications of this feature include marking a document with the date, revision or department number to prevent confusion with other, similar documents. Stationery text includes options for header, footer and a watermark text.

The form option lets you use images as a watermark in your document. These files can be created from existing pages by selecting the add to forms option in the Thumbnail Context Menu found in the Thumbnail Pane. Examples of Form use would be to place a departmental or company image in the background of a document as well as using a referenced document to provide lines of separation and various other formatting accents.

See also

Form Selection Dialog
Stationery Selection Dialog
Apply To Custom Dialog
 XE "Using Tasks and Task Printers " \* MERGEFORMAT Using Tasks and Task Printers

Tasks and task printers enable batch processing for document conversion, emailing and printing to other windows printers. An ePrint task printer has the added bonus of being directly accessible from the Windows printer folder, thereby making it possible to convert a document to a predefined location and file type, email the file and print it to a physical printer all in one step. Because the task is created as a window printer, all of this is available from any application that supports printing. A task also provides the conversion, printing and email functionality, but tasks are only available from the ePrint Workstation.

Tasks are configured in the Task Wizard and Task Printers are created in the ePrint Task Printer Creation Wizard. You can view which tasks are available to you at any time in the Configure Tasks Dialog. The task printers can be viewed and edited from the ePrint Task Printers Manager.

Graphical User Interface

Windows
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 XE "ePrint Main Window " \* MERGEFORMAT ePrint Main Window

The main display window contains a standard horizontal Windows title bar across the top of the interface. The main window's title bar has a program icon at the far left, followed by: the application name and the name of the active document or image. On the far right there are the standard Windows Minimize, Maximize/Restore, and Close buttons.

The vertical and horizontal scroll bars will appear if the loaded document or image exceeds the viewable area of the workspace.

The items on the taskbar can be used for the following:

[image: image36.png]


Closing ePrint: double-click on the application icon or click the Close button to close the application.

[image: image37.png]


Minimizing: click the Minimize button to make the application window reduce to a button on the windows taskbar. Click ePrint's taskbar button to restore the main display window and bring it to the front of any other running windows programs.

[image: image38.png]


Maximizing: double-click on the title-bar or click the Maximize button.

[image: image39.png]


Restoring: click the Restore button to go from overlapped-window to full-screen (Maximize) and back (Restore).

[image: image40.png]


System Menu, click on the application icon to bring up a standard windows system menu, which allows you to move, resize, and close the window.
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Workspace

The workspace is the display area for opened documents and occupies the largest percentage of the ePrint Workstation window. The workspace is in the center of the screen and will adjust its width to fit between any open toolbars or information panes that may be visible. The workspace will allow you to annotate your loaded documents, but it is not possible to edit the content of the document once it has been imported into ePrint.

Status Bar

The Status Bar is located along the bottom of the ePrint window. It has the following features:

[image: image42.png]


A short description will appear here as your mouse passes over a button or menu item that describes the item’s functionality. This provides a quick reference when learning how to use the ePrint Workstation.

[image: image43.png]


Indicates a service or a task is running. The name of the running task or service will be listed along with an animation to indicate when the ePrint Workstation is processing a request.

See Also

Jobs List Pane
Thumbnail Pane
Getting Started Pane 

How To: Use LEADTOOLS ePrint 5 Workstation for the First Time 

Window Panes
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 XE "Getting Started Pane Window " \* MERGEFORMAT Getting Started Pane

The Getting Started Pane is initially displayed on the right side of the ePrint Main Window workspace.
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The Jobs List Pane displays all print jobs in the current session.
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To display or hide this pane, select View -> Job List View from the Main Menu.

The Jobs List Pane uses rows and columns to display the print jobs to be executed. Each row is divided into two columns and will appear to the right of the ePrint Main Window workspace. The two columns are as follows:

[image: image46.png]


Job Name: displays the job name. When selected, the ePrint Main Window workspace shows the first page of the selected print job. This Job Name column includes the name of the job beside a check box for indicating three possible states for the printed job:

[image: image47.png]


All the pages of the print job will be processed.

[image: image48.png]


Some pages of the print job will not be processed.

[image: image49.png]


None of the pages will be processed.

[image: image50.png]


Pages: displays the total number of pages in the print job.

Only one print job can be selected--the one that is currently displayed. Multiple selections are not possible.

See Also

ePrint Main Window
Getting Started Pane 
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The Thumbnails Pane displays all the printed pages (composed of multiple print jobs) and appears along the left side of the ePrint Main Window workspace.
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Through this pane the user can select the active page in the ePrint Main Window workspace by clicking a thumbnail in the list. A blue border will appear around the active page as an indicator for which thumbnail is currently being viewed in the ePrint Main Window workspace.

The Thumbnails Pane has a context menu with many options that appears by right-clicking a thumbnail in this list. This list includes navigation, cutting, pasting and exclusion options as well as the ability to add form graphics to ePrint using the thumbnail of any page as a template. This list is covered in more detail in the Thumbnail Context Menu.

To display or hide this pane, select View -> Thumbnail View from the Main Menu.

See Also

ePrint Main Window
Clip Art Pane 
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 XE "Stationery Editor Mode Pane Window " \* MERGEFORMAT 

 XE "Stationery " \* MERGEFORMAT 

 XE "headers " \* MERGEFORMAT 

 XE "footers " \* MERGEFORMAT Stationery Editor Mode Pane

Use the Stationery Editor Mode Pane to add new stationery, or modify or delete existing stationery. Stationery is a text-based watermark that will appear underneath the document contents: much like pre-printed stationery in traditional printing applications. Keep in mind that stationery appears underneath the text and images placed in the document. Content in the stationery may be covered by images with a similar background color to the background color of the document (e.g., images with a white background on a white piece of paper will hide stationery behind their white background), in ways that may appear counter-intuitive to the eye. The stationery will not, however, have a marginal overlap from text or the transparent area of an image placed in a document.

The Stationery Editor Mode pane appears along the right side of the ePrint Main Window workspace.
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To display the Stationery Editor Mode Window, from the main menu choose Edit -> Select Stationery. Then select the stationery to be edited from the drop down list box and click Edit. The stationery pane should display.

The following fields are on the Stationery Editor Mode window:

Stationeries Drop-down list box:

Use this option to select stationery for editing and to display it in the document.

Add Button

Click the Add button to open the Add Stationery Dialog dialog to add a new stationery type.

Rename Button

Click the Rename button to open the Rename Stationery Dialog dialog to rename the stationery selected in the Stationeries drop-down list box.

This button is only available if a stationery type is selected in the Stationeries drop-down list box.

Delete Button

Click the Delete button to delete the stationery selected in the Stationeries drop-down list box.

This button is only available if a stationery type is selected in the Stationeries drop-down list box.

Apply To Drop-down list box

Use this option to specify which pages have the selected stationery applied to them. It contains the following options:

[image: image53.png]


All: The stationery will be added to all included pages. The stationery will not be added to the excluded pages.

[image: image54.png]


Odd: The stationery will be added to the odd pages only. The stationery will not be added to the excluded pages.

[image: image55.png]


Even: The stationery will be added to the even pages only. This enumeration does not count pages that have been excluded from the print job. The stationery will not be added to the excluded pages.

[image: image56.png]


First: The stationery will be added to the first included page only. If the first page in the print job has been excluded from the print job, then the first included page will be applicable to have stationery added.

[image: image57.png]


Last: The stationery will be added to the last included page only. If the last page in the print job has been excluded from the print job, then the last included page will be applicable to have stationery added.

[image: image58.png]


Custom: Opens the Apply To Custom dialog box.

This is only available if a stationery type is selected in the Stationeries drop-down list box.

Header Text Edit box

Use this option to add or edit text for the stationery header. Text can be entered manually in the text box or auto text options can be accessed by clicking the Add Auto Text dialog button.

This option is only available if a stationery type is selected in the Stationeries drop-down list box.

Header Font Edit box

Use this option to view and edit the font properties for the stationery header. Click the [image: image59.png]


 expand button to edit the font properties in the font editing dialog. The edit box itself only displays the currently selected font, size and color.

This is only available if a stationery type is selected in the Stationeries drop-down list box.

Header Horizontal Offset Edit box

Use this option to set the horizontal offset value from the left of the page to place the stationery header text. The slider bar can be set from 0% to 100% where 0% is the left of the page and 100% is the right. The header is set to 50% by default to place the header at the center of the page.

This option is only available if a stationery type is selected in the Stationeries drop-down list box.

Header Vertical Offset Edit box

Use this option to set the vertical offset value from the top of the page to place the stationery header text. The slider bar can be set from 0% to 100% where 0% is the top of the page and 100% is the bottom. The header is set to 0% by default to place the header at the top of the page.

This option is only available if a stationery type is selected in the Stationeries drop-down list box.

Footer Text Edit box

Use this option to add or edit text for the stationery Footer. Text can be entered manually in the text box or auto text options can be accessed by clicking the Add Auto Text dialog button.

This option is only available if a stationery type is selected in the Stationeries drop-down list box.

Footer Font Edit box

Use this option to view and edit the font properties for the stationery footer. Click the [image: image60.png]


 expand button to edit the font properties in the font editing dialog. The edit box itself only displays the currently selected font, size and color.

This is only available if a stationery type is selected in the Stationeries drop-down list box.

Footer Horizontal Offset Edit box

Use this option to set the horizontal offset value from the left of the page to place the stationery footer text. The slider bar can be set from 0% to 100% where 0% is the left of the page and 100% is the right. The footer is set to 50% by default to place the footer at the center of the page.
This option is only available if a stationery type is selected in the Stationeries drop-down list box.

Footer Vertical Offset Edit box

Use this option to set the vertical offset value from the top of the page to place the stationery footer text. The slider bar can be set from 0% to 100% where 0% is the top of the page and 100 is the bottom. The header is set to 100% by default to place the footer at the bottom of the page.

This option is only available if a stationery type is selected in the Stationeries drop-down list box.

Watermark Text Edit box

Use this option to add or edit text for the stationery Watermark. Watermarks are different from headers and footers in that they have increased control over positioning, angle, opacity, etc. Text can be entered manually in the text box or auto text options can be accessed by clicking the Add Auto Text dialog button.

This option is only available if a stationery type is selected in the Stationeries drop-down list box.

Watermark Font Edit box

Use this option to view and edit the font properties for the stationery watermark. Click the [image: image61.png]


 expand button to edit the font properties in the font editing dialog. The edit box itself only displays the currently selected font, size and color.

This is only available if a stationery type is selected in the Stationeries drop-down list box.

Watermark Horizontal Offset Edit box

Use this option to set the horizontal offset value from the left of the page to place the stationery Watermark text. The slider bar can be set from 0% to 100% where 0% is the left of the page and 100% is the right. The watermark is set to 50% by default to place the watermark at the center of the page.

This option is only available if a stationery type is selected in the Stationeries drop-down list box.

Watermark Vertical Offset Edit box

Use this option to set the vertical offset value from the top of the page to place the stationery watermark text. The slider bar can be set from 0% to 100% where 0% is the top of the page and 100% is the bottom. The header is set to 50% by default to place the footer at the bottom of the page.

This option is only available if a stationery type is selected in the Stationeries drop-down list box.

Watermark Angle Edit box

Use this option to specify the angle of the watermark text.

This option is only available if a stationery type is selected in the Stationeries drop-down list box.

Watermark Opacity Edit box

Use this option to specify the opacity of the watermark text on the page. 0% will make the watermark text completely transparent and therefore not visible, while an opacity of 100% will display the watermark as solid text in the chosen color.

This option is only available if a stationery type is selected in the Stationeries drop-down list box.

Done Button

Click the Done button to close the stationery pane and save any changes made to the stationeries.

Cancel Button

Click the Cancel button to close the stationery pane and discard all changes.

See Also

Stationery Selection Dialog
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The Clip Art Pane displays stamps or clip art that can be inserted into the active page as an annotation stamp object. This pane appears at the right side of the ePrint Main Window workspace (but you can move it by dragging it to another part of the window.)

To show this pane, select Tools -> Annotation -> Clip Art menu item.
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Use this pane to insert any stamp or clip art to the active page as an annotation stamp object. Stamps or clip art can be inserted four different ways:

[image: image63.png]


By dragging and dropping an item from the pane to the active page.

[image: image64.png]


By double-clicking on any selected stamp or clip art.

[image: image65.png]


By right-clicking on any selected stamp or clip art and choosing Insert from the resulting context menu.

[image: image66.png]


By selecting any stamp or clip art item and then pressing Enter.

See Also

ePrint Main Window
Getting Started Pane 

Jobs List Pane 

Thumbnails Pane 

Menus
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Menu commands can be displayed by either:

[image: image67.png]


Clicking a menu item in the menu bar, or

[image: image68.png]


Holding down the <Alt> key plus while pressing the underlined letter in the menu’s title (e.g., to display the File menu, press <Alt> + <F>).

Menu commands can be selected or executed by:

[image: image69.png]


Clicking the item in the menu, or

[image: image70.png]


Pressing the <Alt> key plus the underlined letter in the menu’s title, then pressing the letter underlined in the menu item (e.g., to select the menu item File > Save, press <Alt> + <F> + <S>).

[image: image71.png]


The <>, and <> keys can be used to highlight a menu command and pressing the Enter key will execute the command.

ePrint has two primary types of menus:

[image: image72.png]


Main Menu
[image: image73.png]


Context Menus
Main Menus
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The commands ePrint uses can be grouped into several categories. The main headings for each of these categories appear in the menu bar just below the title bar at the top of the workspace. Click a menu heading to open the menu and choose a command. Frequently used commands are also displayed on the toolbar(s).
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	Note:
	Menu items that appear in gray either do not apply or are unavailable in the present context. If an item is not available, check the documentation for that particular item to find out why.


The following menus are on the ePrint main menu:

File Menu
Edit Menu
View Menu
Tasks Menu
Tools Menu
Help Menu
 XE "Menus " \* MERGEFORMAT 
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Use the File menu to perform file commands. The File menu is shown in the following figure:
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The following table lists the commands on the File menu and gives a brief description of each command:

	Command
	Description

	New
	Opens the Empty Page dialog, which lets you insert an empty page at the end of the current job.

	Open
	Opens the Open dialog, to select the files to be added to the ePrint workstation. If the file is not an image, it will be printed in the background using the default-associated program and the document will be sent from that application to the Workstation. Keep in mind that ePrint will only receive the information that is delivered when a document is printed. Images are loaded directly into the workstation and do not require the printing method of acquiring the document.

	Close Job(s)
	Closes all the print jobs.

	Save As
	Opens the Save As dialog, which allows you to specify the desired file format you would like to create through ePrint.

	Email
	Saves the included print jobs to the hard disk and sends them to an email recipient.

	Print
	Opens the Print dialog where you can print the selected file to any printer on your system including LEADTOOLS ePrint. 

	Batch Print
	Opens the Batch Print dialog, which redirects printing command of a specific material to one or more printer drivers installed on the system.

	Exit
	Ends your working session and exits ePrint. You may alternatively press <Alt>+<F4>. If there are any unsaved images, a dialog will appear asking if you want to save your work. If you choose cancel, the exiting process is aborted.
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Use the Edit menu to perform edit commands. The Edit menu is shown in the following figure:
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The following table lists the commands on the Edit menu and gives a brief description of each command:

	Command
	Description

	Cut Page
	Cuts the active page to ePrint clipboard.

	Paste Page
	Shows the Paste Page submenu.

	Go To
	Opens the Go To dialog, which moves to a specific page in the print job and makes it the active page.

	Rename Job
	Renames the selected print job in the Jobs List Pane.

	Insert Empty Page
	Shows the Insert Empty Page submenu.

	Delete Print Job
	Deletes the selected print job.

	Include Print Job
	Includes the selected print job.

	Exclude Print Job
	Excludes the selected print job.

	Delete Page
	Deletes the selected page from the print job.

	Include Page
	Includes the selected page from the print job.

	Exclude Page
	Excludes the selected page from the print job.

	Select Stationery
	Opens the Stationery Selection dialog.

	Select Form
	Opens the Form Selection dialog.
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Use the Paste Page sub menu to specify the position of a page being pasted into a print job. The Paste Page sub menu is shown in the following figure:
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The following table lists the commands on the Paste Page sub menu and gives a brief description of each command:

	Command
	Description

	Before Selected Page
	Pastes a copied page before the currently selected page.

	After Selected Page
	Pastes a copied page after the currently selected page.

	Beginning of Selected Job
	Pastes a copied page as the first page in the currently selected print job.

	End of Selected Job
	Pastes a copied page as the last page in the currently selected print job.


 XE "Shortcuts " \* MERGEFORMAT Insert Empty Page Sub Menu

Use the Insert Empty Page sub menu to specify the position of a new, empty page to be added to the print job. The Insert Empty Page sub menu is shown in the following figure:
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The following table lists the commands on the Insert Empty Page sub menu and gives a brief description of each command:

	Command
	Description

	Before Selected Page
	Inserts an empty page before the currently selected page.

	After Selected Page
	Inserts an empty page after the currently selected page.

	Beginning of Selected Job
	Inserts an empty page to be the first page in the currently selected print job.

	End of Selected Job
	Inserts an empty page to be the last page in the currently selected print job.
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Use the View menu to change view settings. The View menu is shown in the following figure:
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The following table lists the commands on the View menu and gives a brief description of each command:

	Command
	Description

	Zoom
	Shows the Zoom submenu.

	Page Mode
	Shows the Page Mode submenu.

	Toolbars
	Shows the Toolbars submenu.

	Getting Started Pane
	Shows or hides the Getting Started Pane.

	Thumbnail Pane
	Shows or hides the Thumbnail Pane.

	Jobs List Pane
	Shows or hides the Jobs List Pane.
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Use the Page Mode sub menu to specify whether to view pages as single pages in the ePrint Main Window workspace or view them continuously.
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The following table lists the commands on the Page Mode sub menu (View -> Page Mode) and gives a brief description of each command:

	Command
	Description

	Single Page Mode
	Displays the pages with one page in the viewing area at a time in the ePrint Main Window workspace.

	Continuous Page Mode
	Views the pages continuously in the ePrint Main Window workspace.
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Use the Toolbars sub menu to show or hide the different toolbars. The Toolbars sub menu is shown in the following figure:
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The following table lists the commands on the Toolbars sub menu (View -> Toolbars) and gives a brief description of each command:

	Command
	Description

	Standard Toolbar
	Shows or hides the Standard Toolbar.

	Page Mode Toolbar
	Shows or hides the Page Mode Toolbar.

	Page Navigation Toolbar
	Shows or hides the Page Navigation Toolbar.

	Zoom Toolbar
	Shows or hides the Zoom Toolbar.

	Annotation Tools Toolbar
	Shows or hides the Annotation Tools Toolbar.

	Annotation Properties Toolbar
	Shows or hides the Annotation Properties Toolbar.

	Annotation Text Alignment Toolbar
	Shows or hides the Annotation Text Alignment Toolbar.
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Use the Zoom sub menu to control the magnification level of the page being viewed. The Zoom sub menu is shown in the following figure:
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The following table lists the commands on the Zoom sub menu (View -> Zoom) and gives a brief description of each command:

	Command
	Description

	Normal
	Switches the magnification to the normal level (100%).

	Fit Page
	Switches the magnification level to fit the whole page to the ePrint Main Window workspace client area.

	Fit Width
	Switches the magnification level to fit the page width to the ePrint Main Window workspace client area.

	200 %
	Sets the magnification level to (200%).

	150 %
	Sets the magnification level to (150%).

	100 %
	Sets the magnification level to (100%).

	75 %
	Sets the magnification level to (75%).

	50 %
	Sets the magnification level to (50%).

	Custom Zoom
	Opens the Custom Zoom dialog, which customizes the magnification level.

	Zoom In
	Increases the magnification level.

	Zoom Out
	Decreases the magnification level.
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Use the Tasks menu to open dialogs to add or configure tasks. The Tasks menu is shown in the following figure:
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The following table lists the commands on the Tasks menu and gives a brief description of each command:

	Command
	Description

	Add New Task
	Opens the Task Wizard, which lets you add a new task to a list of saving, emailing and printing operations stored in the wizard.

	Configure Tasks
	Opens the Configure Tasks dialog, which reconfigures existing tasks.
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 XE "Menus " \* MERGEFORMAT Tools Menu

Use the Tools menu to change general settings and options. The Tools menu is shown in the following figure:
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The following table lists the commands on the Tools menu and gives a brief description of each command:

	Command
	Description

	Task Printers Manager…
	Opens the Task Printers Manager dialog to add or modify task printers. A task printer is an ePrint printer that is configured to perform specific tasks.

	Conflict Resolving Options
	Opens the Conflict Removal dialog.

	Email Options
	Opens the Email Options dialog to configure the email settings.

	Annotation
	Shows the Annotation submenu.

	Options
	Opens the Annotation Options dialog.


 XE "Annotation Sub Menu " \* MERGEFORMAT Annotation Sub Menu

Use the Annotation sub menu to perform annotation-related commands. The Annotation sub menu is shown in the following figure:
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The following table lists the commands on the Annotation sub menu (Tools -> Annotation) and gives a brief description of each command:

	Command
	Description

	Select Annotation Tools
	Displays the Select Annotation Tools submenu.

	Format Annotation Objects
	Opens the Annotation Options dialog to modify the properties of the selected annotation object(s). Any new annotation objects will also have these property settings.

	Clip Art
	Opens the Clip Art Pane to insert clip art into the page.

	Select All
	Selects all annotation objects in the current active page.

	Clear
	Deletes the selected annotation object(s).

	Cut
	Cuts the currently selected annotation object(s).

	Copy
	Copies the currently selected annotation object(s) to the clipboard.

	Paste
	Pastes the annotation object(s) from the clipboard to the active page.

	Undo
	Undoes the last action performed on annotation object(s) on the current active page. 

	Group
	Groups the selected annotation objects.

This command will be enabled if at least two annotation objects are selected.

	Ungroup
	Ungroups the selected annotation object(s).

	Bring to Front
	Brings the selected annotation object(s) to the front of the display order.

	Send to Back
	Sends the selected annotation object(s) to the back of the display order.
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Use the Annotation Tools Sub menu to selects the annotation objects to draw. The Annotation Tools Sub menu is shown in the following figure:
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The following table lists the commands on the Select Annotation Tools sub menu (Tools -> Annotation -> Select Annotation Tools) and gives a brief description of each command:

	Command
	Description

	Select Tool
	Selects the Selection tool for selecting annotations.

	Freehand Tool
	Selects the Freehand tool for freehand drawing.

	Freehand Highlight Tool
	Selects the Freehand Highlight tool for freehand transparency highlighting of the document.

	Highlight Tool
	Selects the Highlight tool for highlighting the document by drawing a transparent rectangular block.

	Line Tool
	Selects the Line tool.

	Rectangle Tool
	Selects the Rectangle tool.

	Ellipse Tool
	Selects the Ellipse tool.

	Pointer Tool
	Selects the Pointer tool.

	Polyline Tool
	Selects the Polyline tool.

	Polygon Tool
	Selects the Polygon tool.

	Curve Tool
	Selects the Curve tool.

	Closed Curved Tool
	Selects the Closed Curved tool.

	Note Tool
	Selects the Note tool.

	Text Tool
	Selects the Text tool.

	Rich Text Tool
	Selects the Rich Text tool.

	Text Pointer Tool
	Selects the Text Pointer tool.

	Ruler Tool
	Selects the Ruler tool.

	Poly Ruler Tool
	Selects the Poly Ruler tool.

	Cross Product Tool
	Selects the Cross Product tool.

	Protractor Tool
	Selects the Protractor tool.
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Use the Help menu to access help for ePrint. The Help menu is shown in the following figure:
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The following table lists the commands on the Help menu and gives a brief description of each command:

	Command
	Description

	ePrint Help
	Starts the LEADTOOLS ePrint 5 Professional help file.

	ePrint Website
	Goes to the LEADTOOLS ePrint 5 Professional web site http://www.eprintdriver.com.

	ePrint Support Forum
	Goes to the LEADTOOLS ePrint 5 Professional support forum site http://support.leadtools.com/SupportPortal/cs/forums/26/ShowForum.aspx.

	Activate Product
	Opens the Activation wizard to extend an evaluation, or to activate a licensed copy.

	About LEADTOOLS ePrint
	Opens the About ePrint dialog.


Context Menus

 XE "Menus " \* MERGEFORMAT 

 XE "Context Menus " \* MERGEFORMAT Context Menus

Context menus contain frequently used commands.

The following context menus are available:

ePrint Main Window Workspace Context Menu
Jobs List Context Menu
Thumbnail Context Menu
Clip Art Context Menu
 XE "Menus:Context Menus " \* MERGEFORMAT 
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 XE "Clip Art Pane window " \* MERGEFORMAT ePrint Main Window Workspace Context Menu

Right-clicking on the ePrint Main Window workspace opens the Page Viewer context menu containing some frequently used commands. This menu is dynamic and the commands available change depending upon what is being done in the workspace. 
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	Command
	Description
	Visible

	Next Page
	Moves to the next page in the ePrint Workstation.
	Always

	Previous Page
	Moves to the previous page in the ePrint Workstation.
	Always

	Paste Annotation
	Pastes the copied annotation object(s) from the clipboard to the active page.
	Only if one or more objects have been copied to the clipboard.

	Annotation Undo
	Undo for annotation objects on current active page.
Note: if the user deactivates (navigates away from) the current page, undo history is cleared, and undo is no longer possible.
	Only if undo history has entries. If undo history is cleared, will not appear.

	Annotation
	Shows the Annotation submenu.
	When right-clicking on an annotation object.

	Insert Bitmap
	Opens the Insert Bitmap dialog so that a bitmap can be selected for insertion into the document.
	Only if no annotation object is selected.

	Insert Stamp
	Opens the Clip Art Pane window so that a stamp or clip art item can be selected for insertion into the document.
	Only if no annotation object is selected.

	Zoom
	Shows the Zoom submenu.
	Always

	Zoom In
	Increases the magnification to the maximum zoom level.
	Always

	Zoom Out
	Decreases the magnification to the minimum zoom level.
	Always

	Print
	Opens the Print dialog for printing the included pages.
	Always

	Help
	Opens the LEADTOOLS ePrint 5 Professional help file to the documentation section discussing the ePrint Main Window.
	Always
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Right-clicking on the Jobs List Pane opens a context menu containing some frequently used commands. Most options are only available when right-clicking on a specific job.
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	Command
	Description

	Close Job List View
	Closes the Jobs List pane.

	Rename Job
	Renames the selected print job in the Jobs List pane window.

	Include Job
	Includes a selected print job to be printed if the job was previously excluded.

	Exclude Job
	Excludes a selected print job from being printed if the job was previously included.

	Job Information…
	Opens the Job Information dialog, which shows information about the currently selected print job.

	Delete Job
	Deletes the currently selected print job.

	Move Job Up
	Moves the selected print job up one level.

	Move Job Down
	Moves the selected print job down one level.

	Save
	Opens the Save As dialog to save the selected print job.

	Email Recipient
	Sends the selected print job as an email attachment to the recipient specified in the Email Options dialog. The Save As dialog will open to specify the name of the file to email before the email can be sent.

	Print
	Opens the Print dialog to print the selected print job.

	Help
	Opens the LEADTOOLS ePrint 5 Professional help file to the documentation section discussing the Jobs List Pane.
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Right-clicking on the Thumbnail Pane opens a context menu containing some frequently used commands.
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	Command
	Description

	Close Thumbnail View
	Closes Thumbnail pane.

	Cut page
	Cut the selected page.

	Paste page
	Shows the Paste Page submenu.

	Insert Empty Page
	Shows the Insert Empty Page submenu.

	Delete Page
	Deletes the currently selected page.

	Include Page
	Includes a selected page into the print job that was previously excluded.

	Exclude Page
	Excludes a selected page from the print job that was previously Included.

	Move Page Up
	Moves the selection one page up.

	Move Page Down
	Moves the selection one page down.

	Go To
	Opens the Go To dialog for moving to a specific page in the print job.

	Save
	Opens the Save As dialog to select a file format and save the selected print job.

	Save Active Page
	Opens the Save As dialog and saves the active page only.

	Email Active Page
	Opens the Save As dialog and saves the active page only for sending as an email attachment using default email client and settings. There must be at least one created email profile for this to work.

	Print
	Opens the Print dialog to print the selected print job.

	Add To Forms
	Adds the selected page to the available form templates in the ePrint Form Selection Dialog.

	Help
	Opens the ePrint help file to the documentation section discussing the Thumbnail Pane.
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Right-clicking on the Clip Art Pane opens a context menu containing some frequently used commands.
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	Command
	Description

	Insert
	Inserts the selected stamp or clip art into the currently active page.

	Help
	Opens the LEADTOOLS ePrint 5 Professional help file and displays the documentation page of the Clip Art Pane.


Toolbars

 XE "ePrint Toolbars " \* MERGEFORMAT ePrint Toolbars

The toolbars contain buttons for common and frequently used commands.

The user can show or hide any toolbar by selecting its check box in the View -> Toolbars menu. Each toolbar can be docked to the top, left side, or bottom of the main window. Toolbars can also be manually positioned anywhere in the workspace window by dragging it to a new position. A toolbar will "snap" to the toolbar area if the toolbar is close enough to the top of the workspace.

A button appears grayed-out if its corresponding command is unavailable. Hovering over any button causes that button's name to pop-up in a small tool tip near the cursor and a short textual description of the button's function is displayed in the status bar located at the bottom of the main window.

The following are the toolbars available in the ePrint:

Standard Toolbar
Page Mode Toolbar
Page Navigation Toolbar
Zoom Toolbar
Annotation Tools Toolbar
Annotation Properties Toolbar
Annotation Text Alignment Toolbar
 XE "Toolbars " \* MERGEFORMAT 

 XE "Standard Toolbar " \* MERGEFORMAT Standard Toolbar
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The Standard Toolbar contains the Insert Empty Page, Add job, Save, Email, Print, Cut, Copy, Paste and Undo buttons.

The following table shows the buttons and their descriptions:

	
	Button
	Description
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	Insert Empty Page
	Shows the Empty Page dialog to insert an empty page at the end of the print job.
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	Add Job
	Shows the Open dialog to add print jobs to ePrint.
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	Save
	Shows the Save As dialog to save the currently loaded print job(s).
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	Email
	Shows the Save As dialog to save currently loaded job(s) and then send it to an email address.

	[image: image97.png]



	Print
	Shows the Print dialog to print the currently loaded print job.
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	Cut
	Cuts the currently selected page to the ePrint clipboard.
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	Paste
	Pastes the page form the ePrint clipboard to the selected location
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	Undo
	Undoes the last action.
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The Page Mode Toolbar contains the Single Page, and Continuous buttons.

The following table shows the buttons and their descriptions:

	 
	Button
	Description
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	Single Page
	Only one page will appear in the ePrint Main Window workspace at a time.
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	Continuous
	Shows the pages in a continuous order in the ePrint Main Window workspace.
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The Page Navigation Toolbar contains the First Page, Previous Page, Current Page, Next Page, Last Page, and Hand Tool buttons.

The following table shows the buttons and their descriptions:

	 
	Button
	Description
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	First Page
	Moves to the first page of the print job.
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	Previous Page
	Moves to the previous page in the print job.
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	Index for Current Page
	Opens a drop-down list containing index page numbers. Select an index number to go to that specific page.
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	Next Page
	Advances to the next page in the print job.
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	Last Page
	Advances to the last page of the print job.
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	Hand Tool
	Advances through the pages using the hand tool.
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The Zoom Toolbar contains the Zoom In, Zoom Value, and Zoom Out buttons.

The following table shows the buttons and their descriptions:

	 
	Button
	Description
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	Zoom In
	Increases the magnification level on the page.
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	Zoom Value
	Controls the magnification level on the page by a specific value.

	[image: image114.png]



	Zoom Out
	Decreases the magnification level on the page.
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The Annotation Tools Toolbar contains the annotation tools buttons.

The following table shows the buttons and their descriptions:

	
	Button
	Description
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	Select Tool
	Sets the Select Tool to be the active annotation tool.
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	Freehand Tool
	Uses the Freehand annotation object to create an annotation line along the mouse’s path as executed by the user.
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	Freehand Highlight Tool
	Uses the Freehand Highlight annotation object to highlight objects in the document along the mouse’s path as executed by the user.
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	Highlight Tool
	Uses the Highlight annotation object to create a rectangular highlighting area.
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	Line Tool
	Uses the Line annotation object to draw straight-line annotations over the document by clicking the beginning and ending points.
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	Rect Tool
	Uses the Rectangle annotation object to draw a rectangle over the document.
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	Ellipse Tool
	Uses the Ellipse annotation object to an ellipse over the document.
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	Pointer Tool
	Uses the Pointer annotation object to draw an arrow over the document by clicking the beginning and ending points.
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	Polyline Tool
	Uses the Polyline annotation object to draw interconnecting lines by clicking the mouse to create the anchor points for the lines.
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	Polygon Tool
	Uses the Polygon annotation object to draw lines that form an enclosed and filled shape. This is done by creating anchor points and connecting the final anchor point to the first by clicking the first point or double clicking the final point.
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	Curve Tool
	Uses the Curve annotation object to draw curve annotations.
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	Closedcurve Tool
	Uses the Closed Curve annotation object to draw curves that form an enclosed and filled shape. This is done by creating anchor points and connecting the final anchor point to the first by clicking the first point or double clicking the final point.
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	Note Tool
	Uses the Note annotation object to create a note overlay annotation for entering text.
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	Text Tool
	Uses the Text annotation object to create an annotation text box for entering text.

	[image: image130.png]



	Rich Text Tool
	Uses the Rich Text annotation object to create an annotation text box for entering rich text.
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	Text Pointer Tool
	Uses the Text annotation object to create an annotation text box for entering text with a pointer to another location in the document.
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	Insert Bitmap
	Shows the Open dialog for adding an image to a page.
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	Insert Stamp
	Shows the Clip Art Pane to add a clip art stamp to a page.
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	Ruler Tool
	Uses the Ruler annotation object to create a line with ruler markings and measurements.
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	Polyruler Tool
	Uses the Polyruler annotation object to draw interconnecting lines with ruler markings and measurements by clicking the mouse to create the anchor points for the lines.
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	CrossProduct Tool
	Uses the Cross Product annotation object to draw a two axis coordinate display with ruler markings.
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	Protractor Tool
	Uses the Protractor annotation object to draw an angle annotation along with the angle’s measured value.
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The Annotation Properties Toolbar allows for adjustments to the annotation objects. All modifications made here adjust currently selected annotations as well as prepare the formatting for subsequently created annotations.

The following table shows the buttons and their descriptions:

	 
	Button
	Description
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	Group
	Groups the selected annotation objects.

This button is only available if at least two annotation objects are selected.
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	UnGroup
	Ungroups the selected annotation object(s).
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	Bring to Front
	Brings the selected annotation object(s) to the front of the Z-index (i.e., annotation layering).
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	Send to Back
	Sends the selected annotation object(s) to back of the Z-index (i.e., annotation layering).
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	Flip
	Flips the selected annotation object(s).
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	Rotate Left
	Rotates the selected annotation object(s) to the left.

This button is not available for the Note annotation object.
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	Rotate Right
	Rotates the selected annotation object(s) to the right.

This button is not available for the Note annotation object.
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	Rotate Tool
	Displays the rotation point allows for the rotation of the annotation object(s).

This button is not available for the Note annotation object.
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	Format Annotation Options
	Shows the Annotation Options dialog to modify the selected annotation object(s) properties. 
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	Fill Color
	Selects the fill color of the selected annotation objects.
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	Line Color
	Selects the line color of the selected annotation objects.
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	Text Color
	Selects the text color of the selected annotation objects.
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The Annotation Text Alignment Toolbar contains the Left, Center, and Right alignments as well as Up, Right, Left and Bottom text direction buttons.

The following table shows the buttons and their descriptions:

	 
	Button
	Description
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	Left Alignment
	Aligns the text to the left.

This button will be enabled if an annotation object(s) is selected that supports text.
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	Center Alignment
	Makes the text center aligned.

This button will be enabled if an annotation object(s) is selected that supports text.
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	Right Alignment
	Aligns the text to the right.

This button will be enabled if an annotation object(s) is selected that supports text.
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	Left Text Direction
	Makes the text direction left.

This button is only available for Note and TextPointer annotation object(s).
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	Up Text Direction
	Makes the text direction up.

This button is only available for Note and TextPointer annotation object(s).
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	Right Text Direction
	Makes the text direction right.

This button is only available for Note and TextPointer annotation object(s).
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	Bottom Text Direction 
	Makes the text direction bottom.

This button is only available for Note and TextPointer annotation object(s).


Shortcuts
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A shortcut provides a faster, more direct way to run a specific command or handle a menu item than using the mouse.

ePrint supports the following shortcuts:

Main Menu Keyboard Shortcuts
Main Window Workspace Shortcuts
Jobs List Pane Shortcuts
Thumbnail Pane Shortcuts
Clip Art Pane Shortcuts
 XE "Main Menu Keyboard Shortcuts " \* MERGEFORMAT Main Menu Keyboard Shortcuts

Open ePrint menus and choose the following commands using these keyboard shortcuts:

	Command
	Keyboard Shortcuts

	 
	 

	File Menu
	Alt + F

	Save As
	Ctrl + S

	Print
	Ctrl + P

	 
	 

	Edit Menu
	Alt + E

	Cut
	Ctrl + X

	Copy
	Ctrl + C

	Paste
	Ctrl + V

	Go To
	Ctrl + G

	 
	 

	View Menu
	Alt + V

	Zoom In
	Ctrl + Num +

	Zoom Out
	Ctrl + Num -

	 
	 

	Tasks Menu
	Alt + A

	 
	 

	Tools Menu
	Alt + T

	Annotation Select All
	Ctrl + A

	Annotation Delete
	Del

	Annotation Cut
	Ctrl + X

	Annotation Copy
	Ctrl + C

	Annotation Paste
	Ctrl + V

	Annotation Undo
	Ctrl + Z

	Help Menu
	Alt + H


 XE "Main Window Workspace Shortcuts " \* MERGEFORMAT Main Window Workspace Shortcuts

Access the ePrint Main Window workspace using these keyboard shortcuts:

	Shortcut
	Description

	Up Arrow ​
	Scrolls up one unit.

	Down Arrow 
	Scrolls down one unit.

	Left Arrow 
	Scrolls left one unit.

	Right Arrow 
	Scrolls right one unit.

	Home
	Moves to the beginning of active page.

	End
	Moves to the end of active page.

	Page Up
	Moves to the previous page.

	Page Down
	Moves to the next page.


	Tab
	Moves to the print job viewer.

	Space Bar
	Scrolls the screen the length of the viewing area.

	Ctrl + Num +
	Zoom In

	Ctrl + Num -
	Zoom Out

	Ctrl + Home
	Moves to the first page.

	Ctrl + End
	Moves to the last page.

	Ctrl + N
	Inserts a new and empty page.

	Ctrl + O
	Shows the Open dialog.

	Ctrl + S
	Shows the Save dialog.

	Ctrl + P
	Shows the Print dialog.

	Ctrl + X
	Cuts a page.

	Ctrl + V
	Pastes a page.

	Ctrl + G
	Shows the Go To dialog.

	Ctrl + M
	Shows the Custom Zoom dialog.

	Ctrl + A
	Selects all annotations in the active page.

	Ctrl + L
	Shows the Stationery Selection dialog.

	Ctrl + F
	Shows the Form Selection dialog.


 XE "Shortcuts " \* MERGEFORMAT 
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The user can access the Jobs List Pane using these keyboard shortcuts:

	Shortcut
	Description

	Up Arrow ​
	Selects the previous print job in the list.

	Down Arrow 
	Selects the next print job in the list.

	Home
	Selects the first print job in the list.

	End
	Selects the last print job in the list.

	Page Up
	Selects the print job 10 units up in the list.

	Page Down
	Selects the print job 10 units down in the list.

	F2
	Renames the currently selected print job in the list.

	CTRL+ Up Arrow ​
	Moves the print Job up in the list.

	CTRL + Down Arrow 
	Moves the print job Down in the list.
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Access the Thumbnail Pane using these keyboard shortcuts:

	Shortcut
	Description

	Up Arrow ​
	Selects the previous page.

	Down Arrow 
	Selects the next page.

	Del
	Deletes the Active page.

	CTRL + Home
	Selects the first page in WorkStation.

	CTRL + End
	Selects the last page in WorkStation.

	Ctrl + Num +
	Zoom In for main view.

	Ctrl + Num -
	Zoom Out for main view.


 XE "Shortcuts " \* MERGEFORMAT 

 XE "Clip Art Pane Shortcuts " \* MERGEFORMAT Clip Art Pane Shortcuts

Access the Clip Art Pane using these keyboard shortcuts:

	Shortcut
	Description

	Up Arrow ​
	Selects the picture above the presently selected picture.

	Down Arrow 
	Selects the picture below the presently selected picture.

	Left Arrow 
	Selects the picture above the presently selected picture.

	Right Arrow 
	Selects the picture below the presently selected picture.

	Enter
	Insert the selected stamp to the active page.


Dialogs

 XE "print to pdf " \* MERGEFORMAT 

 XE "print to file " \* MERGEFORMAT 

 XE "print to almost any file format " \* MERGEFORMAT 

 XE "ePrint Dialogs " \* MERGEFORMAT 

 XE "Dialogs " \* MERGEFORMAT LEADTOOLS ePrint 5 Professional Dialogs

LEADTOOLS ePrint 5 Professional supports the following dialogs:

	Saving Files and Saving Options:

	Save As Dialog
	Save As Dialog (Light Edition)

	Save As Options Dialog
	Raster Images Files Save As Options Dialog

	PDF Save As Options Dialog
	MS Word Save As Options Dialog

	RTF Save As Options Dialog
	HTML Save As Options Dialog

	TXT Save As Options Dialog
	AutoCAD DXF (*.dxf) Save As Options Dialog

	Printing:

	Print Dialog
	Enhanced Printing Options Dialog

	Batch Print Dialog
	

	eMail:

	MAPI Profile Dialog
	Email Options Dialog

	Mail Settings Dialog (Light Edition)
	MAPI Profile Dialog (Light Edition)

	SMTP Email Server Options Wizard
	LEADTOOLS Email Composition Dialog

	Jobs and Tasks:

	Configure Tasks Dialog
	Task Summary Dialog

	ePrint Task Printers Manager Dialog
	ePrint Task Printer Creation Wizard

	ePrint Tasks Progress Dialog
	Job Information Dialog

	Task Wizard
	

	Naming/Renaming Files and Resolving Conflict:

	Naming Options Dialog
	Rename Options Dialog

	Conflict Found Dialog
	Conflict Resolving Options Dialog

	Options, Preferences, and Status:

	LEADTOOLS ePrint 5 Printing Preferences Dialog
	Document Preparing Status Dialog

	Options Dialog
	

	Miscellaneous:

	Stationery Selection Dialog
	Empty Page Dialog

	Go To Dialog
	Custom Zoom Dialog

	Custom Paper Dialog
	Form Selection Dialog

	Apply To Custom Dialog
	Add Auto Text Dialog

	Annotation Options Dialog
	Add Form Dialog

	Thumbnail Options Dialog
	Confirm User/Owner Password Dialog

	About ePrint Dialog
	Add Stationery Dialog

	Rename Form Dialog
	Rename Stationery Dialog


Saving Files and Saving Options

 XE "vector image " \* MERGEFORMAT 

 XE "saving files " \* MERGEFORMAT 

 XE "Save As Dialog " \* MERGEFORMAT 

 XE "raster image " \* MERGEFORMAT 
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 XE "Dialogs " \* MERGEFORMAT Save As Dialog

Use the Save As dialog to save a raster image, vector image, or document files.
For more general descriptions of supported file formats in the Save As dialog, refer to Summary of All Supported File Formats.

To display the Save As dialog, from:
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The main menu, choose File -> Save As... or press the Ctrl+S key.

Or
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The Task Wizard -> Save Options page, click on the Add button by selecting the "I want to save to the following format(s)" check box.

Or
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The ePrint Task Printer Creation Wizard -> Save Options page, click on the Add button by selecting the "I want to save to the following format(s)" check box.
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The following fields are on the Save As dialog:

Save in Drop-down List box:

Use the "Save in" drop-down list box to select the current drive or folder. The contents of this drive or folder will be listed in the space below. Saved files will also be stored in this location.

File Name Edit box:

Use the File Name edit box to enter the name of the file you wish to save.

File type Drop-down List box:

Use the File type drop-down list box to select an output category of Document Formats, Image Formats, or Vector Formats. Choosing a file type will affect the formats listed in the Save As Drop-down List box.

Save As Drop-down List box

Use the Save As drop-down list box to select the file format available for the chosen file type selected in the File type Drop-down List box. If a desired format is unavailable, ensure that the appropriate file type has been selected from the file type drop-down list box.

Save each page as a separate file Check box

Select this box to save each page in a multi-page document as a separate file. This option is only accessible when the selected Document or Image Format supports multiple pages.

Open containing folder after saving Check box

Select this box to open the containing folder after saving.

Save using the document name Check box

Select this check box to automatically use the existing file name as the basis for the main part of the name for the saved file (along with the three letter extension used by the file format). If the file is a multi-page file and each page is being saved as a separate file, each subsequent file will be saved with a number appended to the end of the main part of the name that increases in a series.

This check box is only accessible if the Save As dialog is used from the ePrint Task Printer Creation Wizard.

Save Button

Click the Save button to save the file and close the dialog box.

Cancel Button

Click the Cancel button to close the dialog box, without saving the file.

Options Button

Click the Options button to open the Save As Options dialog for the selected file format.

This button is only accessible for files of Document or Image Formats.

Naming options Button

Click the Naming Options button to display the Naming Options dialog, which will determine the naming options to use when saving multiple files.

This button is accessible only when saving a multiple page file where each page is saved in a separate file.

See Also

Task Wizard
ePrint Task Printer Creation Wizard
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 XE "Dialogs " \* MERGEFORMAT Save As Dialog (Light Edition)

The Save As dialog appears when printing to the LEADTOOLS ePrint 5 printer to give you the ability to save, mail, or route the document being printed. For more general descriptions of supported file formats in the Save As dialog, refer to Summary of All Supported File Formats. The Save As dialog is shown in the following figure:
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The following fields are on the Save As dialog:

Save in Drop-down List box:

Use the "Save in" drop-down list box to select the current drive or folder. The contents of this drive or folder will be listed in the space below. Saved files will also be stored in this location.

File name Edit box:

Use the File Name edit box to enter the name of the file you wish to save.

File type Drop-down List box

Use the File type drop-down list box to select an output category of Document Formats, Image Formats, or Vector Formats. Choosing a file type will affect the formats listed in the Save as Drop-down List box.

Save As Drop-down List box:

Use the Save As drop-down list box to select the file format available for the file type selected in the File type Drop-down List box. If the desired format is unavailable, ensure that the appropriate file type has been selected from the File Type drop-down list box.

Save each page as a separate file Check box

Select this box to save each page in a multi-page document as a separate file. This option is only accessible when the selected document or image format supports multiple pages.

Open containing folder after saving Check box

Select this check box to open the folder containing the file after it has been saved.

Append to queue Check box

Select this check box to have the document added to the ePrint queue when the Save button is clicked. Note that the document will not be saved, printed, or emailed, only added to the ePrint queue.

Route to other system printers Check box

Select this check box to print the pages on system printers.

Send saved files via e-mail Check box

Select this check box to send the saved files via e-mail.

Delete saved files after sending e-mail Check box

Select this check box to automatically delete the saved files after sending them by e-mail.

This option is only accessible if the "Send saved files via e-mail" check box is selected.

Save Button

Click the Save button to save the file and close the dialog box.

Cancel Button

Click the Cancel button to close the dialog box without saving the file.

Options Button

Click the Options button to open the Save As Options dialog for the selected file format.

This button is only accessible for files of Document or Image Formats.

Naming options Button

Click the Naming Options button to open the Naming Options dialog, which specifies how to name the files when saving multiple files.

This button is accessible only when saving a multiple page file where each page is saved to a separate file.

Select printers Button

Click the Select printers button to open the Batch Print dialog to redirect the printing command to one or more of the system’s installed printer drivers.

This option is only accessible if the "Route to other system printers" check box is selected.

Email options Button

Click the Email options button to open the Mail Settings dialog to configure the mail setting.

This option is only accessible if the "Send saved files via e-mail" check box is selected.

See Also

Task Wizard
ePrint Task Printer Creation Wizard
Save As Options Dialogs
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 XE "TXT save options " \* MERGEFORMAT 

 XE "TIFF to PDF " \* MERGEFORMAT 

 XE "TIFF conversion " \* MERGEFORMAT 

 XE "Text to PDF " \* MERGEFORMAT 

 XE "saving options " \* MERGEFORMAT 

 XE "Save As Options Dialog " \* MERGEFORMAT 

 XE "RTF to PDF " \* MERGEFORMAT 

 XE "RTF save options " \* MERGEFORMAT 

 XE "RTF converter " \* MERGEFORMAT 

 XE "raster image save options " \* MERGEFORMAT 

 XE "print to pdf " \* MERGEFORMAT 

 XE "print to file " \* MERGEFORMAT 

 XE "print to almost any file format " \* MERGEFORMAT 

 XE "PPT to PDF " \* MERGEFORMAT 

 XE "Powerpoint to PDF " \* MERGEFORMAT 

 XE "PDF to TIFF " \* MERGEFORMAT 

 XE "PDF to JPG " \* MERGEFORMAT 

 XE "PDF to JPEG " \* MERGEFORMAT 

 XE "pdf printer " \* MERGEFORMAT 

 XE "pdf creator " \* MERGEFORMAT 

 XE "PDF converter " \* MERGEFORMAT 

 XE "MS DOC file conversion " \* MERGEFORMAT 

 XE "image conversion " \* MERGEFORMAT 

 XE "html to Word " \* MERGEFORMAT 

 XE "HTML to DOC " \* MERGEFORMAT 

 XE "File conversion " \* MERGEFORMAT 

 XE "DRW conversion " \* MERGEFORMAT 

 XE "document file save options " \* MERGEFORMAT 

 XE "DOC converter " \* MERGEFORMAT 

 XE "Dialogs " \* MERGEFORMAT 

 XE "Converting files " \* MERGEFORMAT 

 XE "ASCII save options " \* MERGEFORMAT 

 XE "Adobe writer " \* MERGEFORMAT 

 XE "Adobe converter " \* MERGEFORMAT 

 XE ".txt to .pdf " \* MERGEFORMAT 

 XE ".tif to .pdf " \* MERGEFORMAT 

 XE ".rtf to .pdf " \* MERGEFORMAT 

 XE ".ppt to .pdf " \* MERGEFORMAT 

 XE ".pdf converter " \* MERGEFORMAT 

 XE ".html to Word " \* MERGEFORMAT 

 XE ".html to .doc " \* MERGEFORMAT 

 XE ".doc converter " \* MERGEFORMAT Save As Options Dialog

The Save As Options dialog is only available for raster image or document file types.

Save options vary depending on the specific file format selected. (e.g., PDF documents will have different options than .rtf documents.) In addition, the options for a specific file format may change based on changing the values of other options.

To display the Save As Options dialog, from the Save As dialog click the Options button.

The following are the Save As Options dialogs that ePrint supports:

Raster Images Files Save As Options
PDF Save As Options
MS Word Save As Options
RTF Save As Options
HTML Save As Options
TXT Save As Options
AutoCAD DXF (*.dxf) Save As Options Dialog
MS Word Save As Options Dialog

 XE "Word save options " \* MERGEFORMAT 
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 XE "MS Word Save As Options Dialog " \* MERGEFORMAT 

 XE "MS Word File Format " \* MERGEFORMAT 

 XE "DOC File Format " \* MERGEFORMAT 

 XE "Dialogs " \* MERGEFORMAT MS Word Save As Options Dialog

Use this dialog to customize the resulting MS Word document.

The following are the tabs and buttons in the MS Word Save As Options dialog:

General Tab 
URL Detection Tab
Default button:

Click the Default button to set the options in the dialog to the default values.

OK Button

Click the OK button to close the dialog and save the values in the save as options.

Cancel Button

Click the Cancel button to close the dialog and discard the save as options values.

 XE "Word save options " \* MERGEFORMAT 
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 XE "MS Word save options " \* MERGEFORMAT 
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 XE "Dialogs " \* MERGEFORMAT MS Word Save As Options Dialog

Use this dialog to customize the resulting MS Word document.

The following are the tabs and buttons in the MS Word Save As Options dialog:

General Tab 
URL Detection Tab
Default button:

Click the Default button to set the options in the dialog to the default values.

OK Button

Click the OK button to close the dialog and save the values in the save as options.

Cancel Button

Click the Cancel button to close the dialog and discard the save as options values.

 XE "MS Word Save As Options Dialog:MSWordGeneralTab " \* MERGEFORMAT General Tab:

Use the options on this tab to specify general information about the MS Word file.
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The following fields are on the General tab:

Do not save shapes Check box

Select this check box to specify whether to generate documents supporting shapes.

Enable framed text Check box

Select this check box to specify whether to generate documents with framed text.

Enable table detection Check box

Select this check box to determine whether to detect tables and produce them in the generated document.

This option is only available if the Enable framed text check box is not selected.

Title Edit box

Use this option to specify the document title.

Author Edit box

Use this option to specify the document author.

Subject Edit box

Use this option to specify the document subject.

Manager Edit box

Use this option to specify the document manager name.

Company Edit box

Use this option to specify the document company name.

 XE "MS Word Save As Options Dialog:MSWordURLDetectionTab " \* MERGEFORMAT URL Detection Tab:

Use the options on this tab to specify how URLs will be treated and displayed.
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The following fields are on the URL Detection tab:

Enable URL Detection Check box

Select this check box to enable URL Detection. When selected, ePrint will recognize URLs in a document and convert them to working links.

Underline URL Check box

Select this check box to underline the detected URL.

This option is only available if the Enable URL Detection check box is selected.

Custom color Check box

Select this check box to make a URL appear in the selected color from the Colors dialog.

This option is only available if the Enable URL Detection check box is selected.

Color Value Button

Click the Color Value button to open the Color dialog in order to select a custom color for the URLs.

This option is only available if the Enable URL Detection and Custom color check boxes are selected.

PDF Save as Options Dialog

 XE "saving options " \* MERGEFORMAT 

 XE "PDF save options " \* MERGEFORMAT 

 XE "PDF Save As Options Dialog " \* MERGEFORMAT 

 XE "PDF File Format " \* MERGEFORMAT 

 XE "Dialogs " \* MERGEFORMAT 

 XE "Advanced PDF Options Dialog " \* MERGEFORMAT PDF Save As Options Dialog

Use this dialog to customize the resulting PDF document.
The following are the tabs and buttons in the PDF Save As Options dialog:

General Tab
Compression Tab
Enhanced Options Tab
Security Tab
Open Tab
Font Embedding Tab
URL Detection Tab
Default Button

Click the Default button to set the options in the dialog to the default values.

OK Button

Click the OK button to close the dialog and save the currently selected values using the "save as" options.

Cancel Button

Click the Cancel button to close the dialog and discard the save as options values.

 XE "saving options " \* MERGEFORMAT 

 XE "PDF save options " \* MERGEFORMAT 
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 XE "Advanced PDF Options Dialog " \* MERGEFORMAT PDF Save As Options Dialog

Use this dialog to customize the resulting PDF document.
The following are the tabs and buttons in the PDF Save As Options dialog:

General Tab
Compression Tab
Enhanced Options Tab
Security Tab
Open Tab
Font Embedding Tab
URL Detection Tab
Default Button

Click the Default button to set the options in the dialog to the default values.

OK Button

Click the OK button to close the dialog and save the currently selected values using the "save as" options.

Cancel Button

Click the Cancel button to close the dialog and discard the save as options values.

 XE "PDF Save As Options Dialog:PDFGeneralTab " \* MERGEFORMAT General Tab:

Use the options on this tab to specify the PDF version number of the document to be saved. Alternately, you can select Automatic in the Version drop-down list box and ePrint will determine which version to use when saving the PDF file. If you select a specific version of PDF for ePrint to create, ePrint may override this user-specified PDF version numberif you have implemented features only supported by a higher version number.

ePrint supports PDF versions 1.2, 1.3, 1.4 and 1.5. Adobe Acrobat 4 is necessary to view PDF Version 1.3, which supports Unicode. Adobe Acrobat 5 is used for and PDF Version 1.4, which supports enhanced PDF security.

ePrint uses PDF version 1.2 when creating documents unless Unicode or enhanced PDF security support is needed, in which case ePrint uses the lowest version necessary to support the additional features. 

Generally, it is better to produce documents at the lowest version possible, because this enables a larger group of readers to open the resulting document. For instance, if the PDF version is 1.4, Adobe Acrobat 3 and Adobe Acrobat 4 will not be able to open the document, thus restricting a potential reader. On the other hand, since the PDF version 1.2-format does not support all available features, it is preferable to use a newer version. Keep in mind that older versions of the PDF format do not support all available features, so if those features are desired, a newer version of the PDF format is required
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The following fields are on the General tab:

Version Drop-down List box

Use this option to select the version of the PDF file format that ePrint can use for saving the document. Select Automatic to save the document based upon the document contents and the selected features. Note, though, if you have requested a specific version but the features you are using require a higher version, ePrint will automatically override your version and use the lowest version that implements all of the features that you are using.

Title Edit box

Use this option to specify the PDF document title.

Information entered in this field will appear in the General Information dialog box that appears when the user views the created PDF file in Adobe Acrobat.

Subject Edit box

Use this option to specify the PDF document subject.

Information entered in this field will appear in the General Information dialog box that appears when the user views the created PDF file in Adobe Acrobat.

Author Edit box

Use this option to specify the PDF document author.

Information entered in this field will appear in the General Information dialog box that appears when the user views the created PDF file in Adobe Acrobat.

Keywords Edit box

Use this option to specify the PDF document keywords.

Information entered in this field will appear in the General Information dialog box that appears when the user views the created PDF file in Adobe Acrobat.

Do not save shapes Check box

Select this check box to specify whether to generate documents supporting shapes.

Fast web view Check box

Select this check box to specify whether to save the PDF file for Internet use. This option will allow the PDF to load progressively.

 XE "PDF Save As Options Dialog:PDFCompressionTab " \* MERGEFORMAT Compression Tab:

Use the Compression tab to the reduce file size of the created document. The Compression tab has two sections: Document Compression and Image Compression. These compression features operate independently.

Compressing the data streams and text can significantly reduce the document file size. To compress the data streams and text, select the Generate Compressed Documents check box.

In addition to compressing the data streams and text, the images within the document can use JPG compression or have compression disabled.

To use image compression, select the JPG Compressed Images radio button, and then enter a value from 2 through 255 in the Factor (2 – 255) edit box as explained below.
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The following fields are on the Compression tab:

Generate Compressed Documents Check box

Select this check box to determine whether to compress the data streams and text.

Raw / Uncompressed images Radio button

Select this radio button to use images without compressing them. Using this option maintains the best image quality, but the document will have a larger file size.

JPG compressed images Radio button

Select this radio button to compress the images in your document.

When using JPG compression it is possible to indicate whether you prefer images that are higher quality, or images that are more compressed. The higher image quality means less compression, which results in a larger file size. The available range for image quality is from 2 through 255, where 2 is the best quality (largest file size) and 255 is the lowest quality (greatest compression/smallest file size).

Factor ( 2-255 ) Spin box

Use this option to select the compression factor.

This option is only available if the JPG Compressed Images radio button is selected.

 XE "PDF Save As Options Dialog:PDFEnhancedOptionsTab " \* MERGEFORMAT Enhanced Options Tab:

The Bookmarks feature allows for the creation of bookmarks, which can be used to mark parts of a document for quick access. This can be done with documents that have been consistently formatted in outline or chapter form with sections and sub-sections, where each level uses unique font formatting to indicate each section.

ePrint workstation will search the document for all unique fonts (e.g., Ariel 14pt, Arial 8pt bold, Verdana 11pt) and place these fonts in a list with a check box beside each unique font. The document must be constructed with this kind of convention in mind in order for the book-marking feature to work properly. An example using a Microsoft Word document is shown in the following figure:
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In this example the formatting of the document is as follows:

Chapter: Arial17pt Bold

Section: Tahoma 13pt 

Sub Section: Times New Roman 12pt Italic

In the Bookmarks section there are controls for setting bookmarks: a "Levels" edit box, a "Level" combo box, and a Fonts list box.

To set the bookmarks for a document, first set the number of levels of bookmarks that you want by clicking the Levels spin box controls. "Levels" represent the hierarchy of the bookmarks in the resultant bookmark outline. In our example there are three levels to be turned into bookmarks, so select 3 for the number of Levels for the three enumerated fonts being used in this example. After this has been selected, use the Level drop-down list box and individually select the bookmark levels and the corresponding font description being used for the selected level.

In our example, perform the following steps to set the bookmarks:

	1.
	Set the number of Levels to 3.

	2.
	Set the Level field from the Level list-box to Level 1. 

	3.
	Select the check box for the "Arial" Size 17 Bold font in the Font list.

	4.
	Set the Level field from the Level list-box to Level 2.

	5.
	Select the check box for the "Tahoma" Size 13 in the Font list.

	6.
	Set the Level field from the Level list-box to Level 3.

	7.
	Select the check box for the "Times New Roman" Size 12 Italic in the Fonts list.

	8.
	Click OK to close the PDF Options property sheet, and then click OK to close the LEADTOOLS ePrint 5 Properties dialog. ePrint will create a document like that shown in the following figure:
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	Note:
	Font selections should not conflict. Selecting "Times New Roman" 17pt for both level1 and level2 will not work. Each level setting should be unique. 

	Note:
	The maximum number of bookmarks cannot be greater than 10 levels and is limited by the number of unique fonts available in the loaded document. In the example used, it is limited to 3.
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The following fields are on the Enhanced Options tab:

Levels Edit box

Use this option to select the number of bookmark levels for the document being saved.

Level Drop-down List box

Use this option to specify the level which currently being edited.

This option is only available if the value of the Levels edit box is greater than 0.

The number of levels entered in the Levels edit-box affects the values of this field. If the user enters 3, then there will be Level 1, Level 2, and Level 3 to be edited.

Fonts List

The Font list displays five columns:
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Column one indicates whether the font is selected.
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Column two lists the Font-name.
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Column three lists the font-size.
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Column four indicates whether the font is a bold-faced font.
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Column five indicates whether the font is an italic-faced font.

This list displays all of the fonts being used in the document along with the font size and will indicate whether the font is in bold face or italic face.

This option is only available if the value of the Levels edit box is greater than 0.

The contents of the Fonts List is affected by the level selected in the Level drop-down list box.

 XE "PDF Save As Options Dialog:PDFSecurityTab " \* MERGEFORMAT Security Tab:

Use the options on this tab to control the security of a PDF document using RC4 40-bit or RC4 128-bit encryption.
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The following fields are on the Security tab:

Protect Document Check box

Select this check box to enable document protection.

Either the User Password or Owner Password edit boxes must be filled whenever document protection is selected.

Encryption Algorithm Drop-down list box

Use this option to specify the encryption method.

This option allows PDF documents to be protected using RC4 40-bit or RC4 128-bit encryptions.

This option is only available if the Protect Document check box is selected.

User Password Edit box

Use this option to fill a password for opening PDF document.

If a password is entered into this section, the user will be asked to Confirm their password in the dialog that will appear after clicking OK.

This option is only available if the Protect Document check box is selected.

Owner Password Edit box

Use this option to enter a password for the document owners. This password will allow the owner to perform all of the actions listed in the Permissions section, including the right to alter these permissions.

If a password is entered into this section, the user will be asked to Confirm their password in the dialog that will appear after clicking OK.

This option is only available if the Protect Document check box is selected.

Enable copy from document / Text extraction Check box

Use this owner permission option to control whether text can be copied from the document.

This option is only available if the Protect Document check box is selected.

Enable document editing Check box

Use this owner permission option to control whether the document can be edited.

This option is only available if the Protect Document check box is selected.

Enable comments Check box

Use this owner permission option to control whether comments can be added to the document.

This option is only available if the Protect Document check box is selected.

Enable document assembly Check box

Use this owner permission option to control whether pages can be added or removed from the document.

This option is only available if the Protect Document check box is selected and the RC4 128-bit key encryption is selected in the Encryption Algorithm drop-down list box.

Enable printing Check box

Use this owner permission option to control whether the document can be printed.

This option is only available if the Protect Document check box is selected.

Faithful print Check box

Use this owner permission option to control whether the document can be printed in high quality.

This option is only available if the Protect Document check box is selected, the RC4 128-bit key encryption is selected in the Encryption Algorithm drop-down list box and the Enable printing check box is selected.

 XE "PDF Save As Options Dialog:PDFOpenTab " \* MERGEFORMAT Open Tab:

Use the options on this tab to control how the PDF document will look when the user first opens it.
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The following fields are on the Open tab:

Page Mode Drop-down List box

Use this option to select the page mode. The possible values are:

[image: image178.png]


Pages only: Only the pages will be visible when the document opens if this is selected.
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Bookmarks and pages: Both the pages and the Bookmarks tab display when the document opens with this selection.
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Thumbnails and pages: Both standard window controls (scroll bars and so forth) and the thumbnails tab display when the document opens with this selection.
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Full screen: The document opens in full screen mode with this selection.

Page Layout Drop-down List box

Use this option to select the page layout. The possible values are:
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Single: One page is available at a time with scrolling.
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Continuous: One or two pages can be viewed at the same time. The scrolling will be continuous between the pages.
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Continuous facing (odd-left): The pages are organized in pairs with two pages on each row. The odd page is placed on the left.
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Continuous facing (even-left): The pages are organized in pairs with two pages on each row. The even page is placed on the left.

Page Number Edit box

Use this option to specify which page to display when the document first opens.

Magnification Drop-down List box

Use this option to specify the initial magnification level. The possible values are:
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Default: Use the default magnification settings.
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Fit visible: Fit the page content (not the page dimensions) in the Acrobat Reader screen.
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Fit width: Fit the page width in the Acrobat Reader screen while keeping the aspect ratio of the page height intact.
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Fit window: Fit the page in the Acrobat Reader screen while keeping the aspect ratio of the page.
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Custom: Use custom magnification settings.

Custom Magnification Percentage Edit box

Use this option to specify the custom magnification percentage.

This option is only available if the "Custom" value is selected in the Magnification Drop-down list box.

Show toolbar Check box

Select this check box to specify whether to display the Adobe Acrobat Reader toolbar when the reader opens the saved document.

Show menu Check box

Select this check box to specify whether to display the Adobe Acrobat Reader menu when the reader opens the saved document.

Show window control Check box

Select this check box to specify whether to display the Adobe Acrobat Reader scrollbars and navigation aids when the reader opens the saved document.

 XE "PDF Save As Options Dialog:PDFFontEmbeddingTab " \* MERGEFORMAT Font Embedding Tab:

Use the options on this tab to customize font embedding in order to balance the portability of a document with its storage requirements.

A difficult problem facing document authors is portability: using the document on many machines and operating systems without losing either document content or style. For instance, a document is originally written and designed using a special font like CHARLESWORTH. The document looks perfect when displayed on the machine that was used to create it. Yet when trying to display this document on another machine it looks horrible because the font CHARLESWORTH is not installed on the other machine and Adobe Acrobat Reader replaced the font with a different one to compensate. To solve this problem, the PDF format supports font embedding, which means "storing font data inside the file". This way, the document "takes" its fonts anywhere it goes and becomes portable, but this requires more storage. Embedding fonts always makes documents larger since the font data must be stored as well.

	Important Note Concerning Licensed Fonts:
	Some fonts are subject to a license granted by the owner of the font that provides that the font may NOT be embedded or otherwise distributed without a license from the font owner. These fonts will be referred to herein as "Licensed Fonts". Users of ePrint are responsible for obtaining the necessary license from the owner of a Licensed Font if the user wishes to embed the Licensed Font. To determine if a font is a Licensed Font, look at the list of Fonts in the Custom Font Embedding section of the Font Embedding Tab. Licensed Fonts display a locked padlock icon in the License column of the Custom Font Embedding list. Failure to obtain the necessary licenses may expose the user to legal claims by the owners of the Licensed Font. LEAD Technologies, Inc. assumes no responsibility for such claims.
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The following fields are on the Font Embedding tab:

Embed all Fonts Check box

Select this check box to embed all fonts. By selecting this check box, all fonts, including the Licensed Fonts, will be embedded with the document.

Enabled Check box

Select this check box to embed fonts that are not commonly available (with the exception of Licensed Fonts). Common fonts, however, should not be embedded (e.g., Times New Roman is likely to be installed on any available machine, so it is not necessary to embed it). Normally, Book Antique is not likely to be installed on any available machine, so it is better to embed it.

This option is only available if the Embed All Fonts check box is not selected.

Include embedding of Licensed Fonts Check box

Select this check box to embed all Licensed Fonts for those users who have obtained the necessary font licenses for Licensed Fonts.

This option is only available if the Embed All Fonts check box is not selected and the Enabled check box is selected.

Custom Font Embedding List box

Use this option to specify the fonts to be embedded. The list contains three columns:

Selection check box column

License column

Fontname column.

The font names that appear in the list are the names of the fonts that appear in the material being printed. Selecting the check box includes the font in the list of fonts that will be embedded. Licensed Fonts display a locked padlock icon in the License column of the Custom Font Embedding list. Licensed Fonts may NOT be embedded unless the user has a license from the owner of the Licensed Font. For important information on the Licensed Fonts, refer to Licensed Fonts. Fonts can be selected in addition to the Automatic font embedding selections.

This option is only available if the Embed All Fonts check box is not selected.

 XE "PDF Save As Options Dialog:PDFURLDetectionTab " \* MERGEFORMAT URL Detection Tab:

Use the options on this tab to specify how URLs will be treated and displayed.
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The following fields are on the URL Detection tab:

Enable URL Detection Check box

Select this check box to enable URL Detection. When selected, ePrint will recognize URLs in a document and convert them to working links.

Dashed style Check box

Select this check box to make a dashed line appear underneath the URL instead of a solid line.

This option is only available if the Enable URL Detection check box is selected.

Custom color Check box

Select this check box to make a URL appear in the selected color from Colors dialog.

This option is only available if the Enable URL Detection check box is selected.

Color Value Button

Click the Color Value button to open the Color dialog in order to select a custom color for the URLs.

This option is only available if the Enable URL Detection and Custom color check boxes are selected.

HTML Save As Options Dialog

 XE "saving options " \* MERGEFORMAT 

 XE "HTML Save As Options Dialog " \* MERGEFORMAT 

 XE "Dialogs " \* MERGEFORMAT HTML Save As Options Dialog

Use this dialog to specify the save options for HTML files.

The following are the tabs and buttons in the HTML Save As Options dialog:

General Tab
URL Detection Tab
Font Embedding Tab
Default Button

Click the Default button to set the options in the dialog to the default values.

OK Button

Click the OK button to close the dialog and save the currently selected values in the "save as" options.

Cancel Button

Click the Cancel button to close the dialog and discard the save as options values.

 XE "saving options " \* MERGEFORMAT 

 XE "HTML Save As Options Dialog " \* MERGEFORMAT 

 XE "Dialogs " \* MERGEFORMAT HTML Save As Options Dialog

Use this dialog to specify the save options for HTML files.

The following are the tabs and buttons in the HTML Save As Options dialog:

General Tab
URL Detection Tab
Font Embedding Tab
Default Button

Click the Default button to set the options in the dialog to the default values.

OK Button

Click the OK button to close the dialog and save the currently selected values in the "save as" options.

Cancel Button

Click the Cancel button to close the dialog and discard the save as options values.

 XE "HTML Save As Options Dialog:HTML General Tab " \* MERGEFORMAT General Tab:

This tab lets the user specify the page title, and the background color.
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The following fields are on the General tab:

Page title Edit box

Use this option to specify the page title.

Background color Button

Click the Background color button to open the Color dialog and select a custom color for the background.

Compatibility List box

Use this option to specify whether the generated HTML file should be compatible with Internet Explorer 5.0+, Netscape 4.6, 6.0+, or both Internet Explorer and Netscape.

Enable Unicode Check box

Select this check box to determine whether to generate HTML files with UNICODE support.

Do not save shapes Check box

Select this check box to specify whether to generate documents supporting shapes.

 XE "HTML Save As Options Dialog:HTML URL Detection Tab " \* MERGEFORMAT URL Detection Tab:

Use the options on this tab to specify how URLs will be treated and displayed.
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The following fields are on the URL Detection tab:

Enable URL Detection Check box

Select this check box to enable URL Detection. It recognizes URLs in a HTML file and converts them to working links.

Underline URL Check box

Select this check box to underline the detected URL.

This option is only available if the Enable URL Detection check box is selected.

Custom color Check box

Select this check box to make an URL appear in the selected color from the Colors dialog.

This option is only available if the Enable URL Detection check box is selected.

Color Value Button

Click the Color Value button to open the Color dialog in order to select a custom color for the URLs.

This option is only available if the Enable URL Detection and Custom color check boxes are selected.

 XE "HTML Save As Options Dialog:HTML Font Embedding Tab " \* MERGEFORMAT Font Embedding Tab:

Use the options on this tab to customize font embedding in order to balance the portability of the HTML file with its storage requirements.
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The following fields are on the Font Embedding tab:

Embed all Fonts Check box

Select this check box to embed all fonts. By selecting this check box, all fonts including the Licensed Fonts will be embedded with the HTML file.

Enabled Check box

Select this check box to embed fonts that are not commonly available (with the exception of Licensed Fonts). Common fonts, however, do not need to be embedded (e.g., Times New Roman is likely to be installed on any available machine, so it is not necessary to embed it). Normally, Book Antique is not likely to be installed on any available machine, so it is better to embed it.

This option is only available if the Embed All Fonts check box is not selected.

Custom Font Embedding List box

Use this option to specify the fonts to be embedded. The list contains three columns:

Selection check box column

License column

Font-name column.

The font names that appear in the list are the names of the fonts that appear in the material being printed. Selecting the check box includes the font in the list of fonts that will be embedded. Licensed Fonts display a locked padlock icon in the License column of the Custom Font Embedding list. Licensed Fonts may NOT be embedded unless the user has a license from the owner of the Licensed Font. For important information on the Licensed Fonts, please refer to Licensed Fonts. Fonts can be selected in addition to the Automatic font embedding selections.

This option is only available if the Embed All Fonts check box is not selected.

 XE "saving options " \* MERGEFORMAT 

 XE "Raster Images Save As Options Dialog " \* MERGEFORMAT 

 XE "raster image " \* MERGEFORMAT 

 XE "Dialogs " \* MERGEFORMAT Raster Images Files Save As Options Dialog

Use this dialog to specify the save options for a raster image file. Examples of raster images include BMP, TIFF, JPG and GIF files. The options available vary with the file format. (e.g., some image files may support quality factors or thumbnails). In addition, the options for a specific image file may change based on the values of other options (e.g. the color depth value can affect the available compression types).
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The following fields are on the Raster Image Files Save As Options dialog:

Color Depth Drop-down List box:

Use this option to select the color depth for the saved image.

Compression Type Drop-down List box:

Use this option to select compression to be used when generating an image.

This option’s availability relates to the selected image format and the value of the color depth.

Progressive type Drop-down List box:

Use this option to select the progressive value to be used when generating an image.

This option is only available when "Progressive" in the Compression Type drop-down list box has been selected.

Compression Slider:

Use this option to specify the compression of the generated image.

This option is only available if image file supports a compression factor.

The values range from 1 to 100, where 1 uses the least amount of compression (i.e., larger image file size with optimal quality), and 100 uses the highest amount of compression (i.e., smaller image file size and reduced quality).

Use file size compression control Check box:

Select this check box to specify the quality of the generated image.

This option is only available for the JPEG 2000 image format.

If this option is selected, the "File Size" edit box will be accessible.

File Size Edit box:

Use this option to specify desired size of the target file.

This option is only available for the JPEG 2000 image format.

This option is only available if the "Use file size compression" control check box is selected.

Save with Thumbnail Check box

Select this check box to save a thumbnail (stamp) with the image.

This option is only available if the selected image format supports thumbnails (stamps).

If this option is selected, then the Thumbnail Options button will be accessible.

Thumbnail Options Button

Click the Thumbnail Options button to open the Thumbnail Options dialog for the selected file format.

This option is only available if the selected image format supports thumbnails (stamps) and the "Save with Thumbnail" check box is selected.

Default Button

Click the Default button to restore the options in the dialog to their default values.

OK Button

Click the OK button to close the dialog and save the changes to the option settings.

Cancel Button

Click the Cancel button to close the dialog and discard the changes to the option settings.

RTF Save As Options Dialog

 XE "saving options " \* MERGEFORMAT 

 XE "RTF Save As Options Dialog " \* MERGEFORMAT 

 XE "Rich Text Format " \* MERGEFORMAT 

 XE "Dialogs " \* MERGEFORMAT RTF Save As Options Dialog

Use this dialog to customize the resulting RTF file.

The following are the tabs and buttons in the RTF Save As Options dialog:

General Tab
URL Detection Tab
Default Button

Click the Default button to set the options in the dialog to the default values.

OK Button

Click the OK button to close the dialog and save the currently selected values in the "save as" options.

Cancel Button

Click the Cancel button to close the dialog and discard the save as options values.

 XE "saving options " \* MERGEFORMAT 

 XE "RTF Save As Options Dialog " \* MERGEFORMAT 

 XE "Rich Text Format " \* MERGEFORMAT 

 XE "Dialogs " \* MERGEFORMAT RTF Save As Options Dialog

Use this dialog to customize the resulting RTF file.

The following are the tabs and buttons in the RTF Save As Options dialog:

General Tab
URL Detection Tab
Default Button

Click the Default button to set the options in the dialog to the default values.

OK Button

Click the OK button to close the dialog and save the currently selected values in the "save as" options.

Cancel Button

Click the Cancel button to close the dialog and discard the save as options values.

 XE "RTF Save As Options Dialog:GeneralTab " \* MERGEFORMAT General Tab:

Use the options on this tab to specify general information about the RTF file.
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The following fields are on the General tab:

Do not save shapes Check box

Select this check box to specify whether to generate documents supporting shapes.

Enable framed text Check box

Select this check box to specify whether to generate documents with framed text.

Title Edit box

Use this option to specify the document title.

Author Edit box

Use this option to specify the document author.

Subject Edit box

Use this option to specify the document subject.

Manager Edit box

Use this option to specify the document manager name.

Company Edit box

Use this option to specify the document company name.

 XE "RTF Save As Options Dialog:URL Detection Tab " \* MERGEFORMAT URL Detection Tab:

This tab lets the user determine how URLs in the document will be treated and displayed.
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The following fields are on the URL Detection tab:

Enable URL Detection Check box

Select this check box to enable URL Detection. When selected, ePrint will recognize URLs in a document and convert them to working links.

Underline URL Check box

Select this check box to underline the detected URL.

This option is only available if the Enable URL Detection check box is selected.

Custom color Check box

Select this check box to make a URL appear in the selected color from the Colors dialog.

This option is only available if the Enable URL Detection check box is selected.

Color Value Button

Click the Color Value button to open the Color dialog in order to select a custom color for the URLs.

This option is only available if the Enable URL Detection and Custom color check boxes are selected.

 XE "TXT Save As Options Dialog " \* MERGEFORMAT 

 XE "TXT " \* MERGEFORMAT 

 XE "Text file format " \* MERGEFORMAT 

 XE "saving options " \* MERGEFORMAT 

 XE "Dialogs " \* MERGEFORMAT TXT Save As Options Dialog

Use this dialog to specify the text sub-format and enable or disable page numbering.
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The following fields are on the TXT Save As Options dialog:

Enable page numbering Check box

Select this check box to enable page numbering. The generated TXT file will have its pages numbered.

Enable page breaks Check box

Select this check box to enable the use of page breaks.

Text subformat Drop-down list box

Use this option to specify the text sub-format type. Possible values are:
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ASCII. The text subtype is ANSI

[image: image201.png]


Little Endian. The text subtype is Unicode
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Big Endian. The text subtype is Unicode (Big Endian)

Default Button

Click the Default button to set the options in the dialog to the default values.

OK Button

Click the OK button to close the dialog and save the currently selected values.

Cancel Button

Click the Cancel button to close the dialog without saving the currently selected values.

 XE "Dialog " \* MERGEFORMAT 

 XE "AutoCAD DXF (*.dxf) Save As Options Dialog " \* MERGEFORMAT AutoCAD DXF (*.dxf) Save As Options Dialog

Use the Save As Options – AutoCAD DXF dialog to specify the sub-format for the AutoCAD DXF file format.

To display the Save As Options – AutoCAD DXF dialog, from the Save As dialog click on the Options button and make sure the Vector Formats is selected in the File type drop-down list box and AutoCAD DXF is selected in the Save As drop-down list box.
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The following fields are on the Save As Options – AutoCAD DXF dialog:

Sub-Format Drop-down List box:

Use the Sub-Format drop-down list box to specify the sub-format for the AutoCAD DXF. Possible values are:
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R12: Create DXF format (version 12).
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R13: Create DXF format (version 13) that supports raster images.
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Tiff DXF: DXF will be saved in a multi-page TIFF file.

Default Button

Click the Default button to restore the option in the Sub-Format drop-down list box in the dialog, to its default value.

OK Button

Click the OK button to close the dialog and save the changes to the option settings.

Cancel Button

Click the Cancel button to close the dialog and discard the changes to the option settings.

See Also

Save As Dialog
Email

 XE "Email Options Dialog " \* MERGEFORMAT 

 XE "Email Options " \* MERGEFORMAT 

 XE "Email " \* MERGEFORMAT 

 XE "Dialogs " \* MERGEFORMAT 

 XE "Configuring an email account " \* MERGEFORMAT Email Options Dialog

Use the Email Options dialog to configure the default email settings for sending email.

To display the Email Options dialog, from the main menu, choose Tools -> Email Options.
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The following fields are on the Email Options dialog:

SMTP Mail Server Radio button

Select this radio button to use the SMTP server to send your email from LEADTOOLS ePrint 5 Professional.

Default Email Client Radio button

Select this radio button to use the default email client installed on the machine to send emails.

Configure SMTP Server Settings/ Configure MAPI Logon Settings Button

Click this button to configure the SMTP server settings or configure the MAPI logon setting.

If the SMTP Mail Server Radio button has been selected, then this button will be labeled Configure SMTP Server Settings and clicking this button opens the SMTP Email Server Options Wizard.

If the Default Email Client Radio button is selected, then this button will be labeled Configure MAPI Logon Settings and clicking this button opens the MAPI Profile Dialog.

Delete files after sending email Check box

Select this check box to delete the saved files after sending the email.

Warn me if the size of all attachments is more than Check box

Select this check box to be warned if your attachments exceed a size that you specify. If the size of all attachments exceeds this size, a message box will appear to warn you and prompt you about how to proceed.

Warn me if the size of all attachments is more than Edit box

Use this edit box to enter the maximum size of email attachments, in kilobytes.

This option is only available if the Warn me if the size of all attachments is more than Check box is selected.

OK Button

Click the OK button to close the dialog box and save the configuration.

Cancel Button

Click the Cancel button to close the dialog box and discard all changes.

See Also

LEADTOOLS Email Composition Dialog
SMTP Email Server Options Wizard
MAPI Profile Dialog
SMTP Email Server Options Wizard

 XE "Wizards " \* MERGEFORMAT 

 XE "SMTP Settings " \* MERGEFORMAT 

 XE "SMTP Email Server Options Wizard " \* MERGEFORMAT 

 XE "Server Settings " \* MERGEFORMAT 

 XE "Mail Settings " \* MERGEFORMAT 

 XE "Email " \* MERGEFORMAT 

 XE "Configuring an email account " \* MERGEFORMAT SMTP Email Server Options Wizard

Use the SMTP Email Server Options Wizard to configure the SMTP email server settings.

To display the SMTP Email Server Options Wizard, from the Email Options dialog, make sure the Use wizard in configuration check box is selected then click the Configure SMTP Server Settings button.

The following pages and buttons are on the SMTP Email Server Options Wizard:

Welcome Page
Mail General Settings Page
Mail Server Settings Page
Completion Page
< Back Button

Click the < Back button to move to the previous page in the wizard.

Next > Button

Click the Next > button to move to the next page in the wizard.

Finish Button

Click the Finish button to close the wizard, and save the configuration of the task.

This option is only available if the configuration of the SMTP email server is complete.

Cancel Button

Click the Cancel button to close the wizard, and ignore the SMTP email server configuration.

 XE "Wizards " \* MERGEFORMAT 

 XE "SMTP Settings " \* MERGEFORMAT 

 XE "SMTP Email Server Options Wizard " \* MERGEFORMAT 

 XE "Server Settings " \* MERGEFORMAT 

 XE "Mail Settings " \* MERGEFORMAT 

 XE "Email " \* MERGEFORMAT 

 XE "Configuring an email account " \* MERGEFORMAT SMTP Email Server Options Wizard

Use the SMTP Email Server Options Wizard to configure the SMTP email server settings.

To display the SMTP Email Server Options Wizard, from the Email Options dialog, make sure the Use wizard in configuration check box is selected then click the Configure SMTP Server Settings button.

The following pages and buttons are on the SMTP Email Server Options Wizard:

Welcome Page
Mail General Settings Page
Mail Server Settings Page
Completion Page
< Back Button

Click the < Back button to move to the previous page in the wizard.

Next > Button

Click the Next > button to move to the next page in the wizard.

Finish Button

Click the Finish button to close the wizard, and save the configuration of the task.

This option is only available if the configuration of the SMTP email server is complete.

Cancel Button

Click the Cancel button to close the wizard, and ignore the SMTP email server configuration.

 XE "SMTP Email Server Options Wizard:Welcome Page " \* MERGEFORMAT Welcome Page

This page introduces the wizard and describes its contents.
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 XE "SMTP Email Server Options Wizard:General Settings Page " \* MERGEFORMAT Mail General Settings Page

Use this page to configure the general mail settings.
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The following fields are on the Mail General Settings Page:

Name Edit box:

Use this option to enter the name of the email sender. This is the name that will appear in the From field of the email. If it is left empty, the email address will be used. 

Organization Edit box:

Use this option to enter the organization name of the sender.

E-mail address Edit box:

Use this option to enter the sender’s email address. This will appear in the From field of the receiver if the Name is left empty.

The address must be in the form xxx@xxx to be accepted.

Reply address Edit box:

Use this option to enter the sender reply address. Replies to this email will be sent to the address specified here. If it is left empty, the sender’s email address will be used for replying.

The address must be in the form xxx@xxx to be accepted.

Notes:

The Next > button is only available if the E-mail address edit box is filled.

 XE "SMTP Email Server Options Wizard:Server Settings Page " \* MERGEFORMAT Mail Server Settings Page

Use this page to configure the SMTP server settings such as the SMTP mail server name, SMTP port number, server time out, and login information. This page is only available if the Directly through SMTP server radio button is selected in the E-mail Settings page of the wizard. This page is shown in the following figure:
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SMTP Mail Server Edit box:

Use this option to enter the name of the SMTP mail server.

SMTP Port Number Edit box:

Use this option to enter the SMTP mail server port number. Usually it is 25.

Server Timeouts Slider:

Use this option to enter the number of seconds to allow for the server to capture the connection before it times out. Possible values range from 30 to 300 seconds.

Mail server requires authentication Check box

Select this check box to enable sending emails on servers that require authentication through an account name and a password.

Account name Edit box:

Use this option to enter the account name for the authentication information.

This option is only available if the Mail Server Requires Authentication check box is selected.

Password Edit box:

Use this option to fill the password for the authentication information.

This option is only available if the Mail server requires authentication check box is selected.

Notes:

The Next and Finish buttons are only available if the SMTP Mail Server edit box is filled.

 XE "SMTP Email Server Options Wizard:Completion Page " \* MERGEFORMAT Completion Page

Use this page to view the options selected during the configuration of the SMTP Mail Server.
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The following fields are on the Completion Page:

Summary List box

This list box summarizes the settings that have been selected.

 XE "LEADTOOLS Email Composition Dialog " \* MERGEFORMAT 

 XE "Email Composition " \* MERGEFORMAT 

 XE "Email " \* MERGEFORMAT 

 XE "Dialogs " \* MERGEFORMAT LEADTOOLS Email Composition Dialog

The ePrint 5 Workstation can be set up to work with your email system. To do so, the Email Options must first be configured properly. The simplest configuration is to select the Default Email Client radio button in the Email Options dialog. If you do this, then the email composition dialog that appears when you choose File -> Email will be the one the default email client uses.

You can also set up the ePrint 5 Workstation to use a valid SMTP mail account. Do this by selecting the SMTP Mail Server radio button in the Email Options dialog, then clicking the Configure SMTP Server Settings button to open the SMTP Email Server Options Wizard and configuring the email options for a valid SMTP server. After the email options have been set up this way, when you pull down the File menu on the ePrint 5 Workstation and select the Email option, the LEADTOOLS Email Composition dialog appears.) The LEADTOOLS Email Composition dialog is shown in the following figure:
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It is also possible to use the Email Options dialog to set up the ePrint 5 Workstation to use a valid MAPI mail account. If there is no Default MAPI client installed on the system, when the LEADTOOLS Email Composition dialog appears, the To, Cc and Bcc buttons appear as static text instead of buttons. This version is shown in the following figure:
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The following menus are on the LEADTOOLS Email Composition dialog:

File 

Edit

Use the File menu to perform file commands. The File menu is a standard Windows context menu and is shown in the following figure:
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Use the Edit menu to perform edit commands. The Edit menu is a standard Windows context menu and is shown in the following figure:
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The following fields are on the LEADTOOLS Email Composition dialog:

Send Button

Click this button to send the email.

Undo Button

Click this button to undo the last action.

Cut Button

Click this button to cut a specific selection from the document to the clipboard.

Copy Button

Click this button to copy a specific selection to the clipboard.

Paste Button

Click this button to paste from the clipboard.

Attach File Button

Click this button to attach files.

Importance Button

Click this button to open a menu to assign an importance level (High, Medium, or Low) to the message.

To Button:

Click this button to show the default email client’s address book.

This button is only visible if a MAPI email client program is installed on the machine.

Cc Button:

Click this button to show the default email client’s address book.

This button is only visible if a MAPI email client program is installed on the machine.

Bcc Button:

Click this button to show the default email client’s address book.

This button is only visible if a MAPI email client program is installed on the machine.

Subject Edit box:

Use this option to enter email subject.

Message Edit box

Use this option to enter the body of the email message.

Attachments Edit box

Use this option when working with the attachments.

 XE "Mail Settings Dialog (Light Edition) " \* MERGEFORMAT 

 XE "Light Edition " \* MERGEFORMAT 

 XE "Email settings " \* MERGEFORMAT 

 XE "Dialogs " \* MERGEFORMAT Mail Settings Dialog (Light Edition)

Use the Mail Settings dialog to configure the mail settings in the classic mode Save As dialog.

To display the Mail Settings dialog, from the main menu, select File -> Print (or press the <Ctrl> + <P> key combination). The Print dialog will appear. In the Name drop-down list box, select LEADTOOLS ePrint 5 printer and click the OK button. The Save As Dialog (Light Edition) will appear. Make sure the Send Saved Files Via E-Mail check box is selected, and finally, click the Email Options button.
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The following fields are on the Mail Settings dialog:

To button

Click the To button to display the address book of the default email client.

To Edit box

Use this edit box to enter the address(es) of the recipient(s). Separate multiple addresses with semi-colons. At least one valid address should be added.

Cc button

Click the Cc button to display the address book of the default email client.

Cc Edit box

Use this edit box to enter the address(es) of the recipient(s) to receive a copy of the email. Separate multiple addresses with semi-colons. At least one valid address should be added.

Bcc button

Click the Bcc button to display the address book of the default email client.

Bcc Edit box

Use this edit box to enter the address(es) of the recipient(s) to receive a blind copy of the email. Separate multiple addresses with semi-colons. At least one valid address should be added.

Subject Edit box:

Use this edit box to enter the subject of the email.

Message Edit box

Use this edit box to enter the message body with the attached files.

Send using SMTP server Radio button

Select this radio button to send emails via SMTP server.

SMTP Settings Button

Click the SMTP Settings button to open the SMTP Email Server Options Wizard to configure the SMTP server.

This option is only available if the Send Using SMTP Server radio button is selected.

Send using default e-mail program Radio button

Select this radio button to send emails via the default email program.

Profile Button

Click the Profile button to display the MAPI Profile dialog to designate which MAPI Profile is to be used.

This option is only available if the Send Using Default E-Mail Program radio button is selected.

Send e-mail silently Check box

Select this check box to allow user interaction through sending emails.

Warn me if attachments size more than Check box

Select this check box to give a warning if the attachments sizes exceed the limit size filled in the Max Size edit box.

Max Size Edit box

Use this edit box to enter the maximum size allowed to attach files in Kilobytes.

This option is only available if the Warn me if attachments size more than check box is selected.

OK Button

Click the OK button to close the dialog, and save the configuration of the mail setting.

Cancel Button

Click the Cancel button to close the dialog, and discard the configuration of the mail setting.

See Also

MAPI Profile Dialog
SMTP Email Server Options Wizard
 XE "profiles " \* MERGEFORMAT 

 XE "MAPI Profile Dialog " \* MERGEFORMAT 

 XE "Email settings " \* MERGEFORMAT 

 XE "Email " \* MERGEFORMAT 

 XE "Dialogs " \* MERGEFORMAT MAPI Profile Dialog

Use the MAPI Profile Dialog to configure the MAPI Profile settings to use when sending email.

To display the MAPI Profile dialog, from the main menu, select Tools -> Email Options and then with the Default Email Client radio button selected, click the Configure MAPI Login Settings button.
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The following fields are on the MAPI Profile dialog:

Use default profile Check box

Select this check box to determine whether to send email using the default profile, or a specific one.

Profile Edit box:

Use this option to enter the name of the profile to use.

Password Edit box:

Use this option to enter the password of the profile to use.

OK Button

Click the Ok button to close the dialog and save the changes.

Cancel Button

Click the Cancel button to close the dialog and discard all changes.

See Also

Email Options Dialog
 XE "MAPI Profile Dialog (Light Edition) " \* MERGEFORMAT 

 XE "MAPI Profile " \* MERGEFORMAT 

 XE "Light Edition " \* MERGEFORMAT 

 XE "Email settings " \* MERGEFORMAT 

 XE "Dialogs " \* MERGEFORMAT MAPI Profile Dialog (Light Edition)

Use the MAPI Profile dialog to determine the MAPI Profile intended to use when sending email.

To display the MAPI Profile dialog, from the main menu, select File -> Print… or press the <Ctrl> + <P> key combination. The Print dialog will appear. In the Name drop-down list box, select LEADTOOLS ePrint 5 printer and click on the OK button. The Save As Dialog (Light Edition) will appear. Make sure the Send saved files via e-mail check box is selected and click on the Email options button. The Mail Settings Dialog (Light Edition) will appear. Make sure Send using default e-mail program radio button is selected, and finally click on Profile button.
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The following fields are on the MAPI Profile dialog:

Use default profile Check box

Select this check box to determine whether to send email using the default profile, or a specific one.

Profile Edit box

Use this option to enter the name of the profile intended to use.

Password Edit box

Use this option to enter the password of the profile intended to use.

OK Button

Click the Ok button to close the dialog, and save the changes.

Cancel Button

Click the Cancel button to close the dialog, and discard the changes.

See Also

Mail Settings Dialog
Annotation Options

 XE "Dialogs " \* MERGEFORMAT 

 XE "Annotation Options Dialog " \* MERGEFORMAT 

 XE "Annotation Options " \* MERGEFORMAT Annotation Options Dialog

Use the Annotation Options dialog to customize subsequent or currently selected annotations. This dialog will enable all applicable option tabs according to which annotations are selected when the dialog is opened.

To display the Annotation Options dialog from the main menu, you may use one of the following two options:
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Choose Tools -> Annotations -> Format Annotation Object

[image: image220.png]


Right-click over a drawn annotation object, then from the ePrint Main Window Workspace Context Menu, choose Annotations -> Format Annotation Object…

The following are the tabs in the Annotation Options dialog:

Fill Tab
Line Tab
Text Tab
Ruler Tab
Angle Tab

 XE "Dialogs " \* MERGEFORMAT 

 XE "Annotation Options Dialog " \* MERGEFORMAT 

 XE "Annotation Options " \* MERGEFORMAT Annotation Options Dialog

Use the Annotation Options dialog to customize subsequent or currently selected annotations. This dialog will enable all applicable option tabs according to which annotations are selected when the dialog is opened.

To display the Annotation Options dialog from the main menu, you may use one of the following two options:
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Choose Tools -> Annotations -> Format Annotation Object
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Right-click over a drawn annotation object, then from the ePrint Main Window Workspace Context Menu, choose Annotations -> Format Annotation Object…

The following are the tabs in the Annotation Options dialog:

Fill Tab
Line Tab
Text Tab
Ruler Tab
Angle Tab

 XE "Annotation Options Dialog:Annotation Fill Tab " \* MERGEFORMAT Fill Tab

Use the options on this tab to customize the fill properties for subsequent and currently selected annotations.
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The following fields are on the Fill Tab:

Color Drop-down List box:

Use this option to select the fill color for selected annotations shapes that use color fills.

Pattern Drop-down List box:

Use this option to select a fill pattern for selected annotations shapes that use color fills.

Transparency Slider:

Use this option to select the alpha channel value for the fill color or pattern. Possible values are from 0 to 255 where zero is completely transparent and 255 is completely opaque.

Transparency Edit box

This option displays the selected alpha channel value of the fill color or pattern.

 XE "Annotation Options Dialog:Annotation Line Tab " \* MERGEFORMAT Line Tab

Use the options on this tab to customize the properties of subsequent and currently selected line annotations.
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The following fields are on the Line Tab:

Color Drop-down List box:

Use this option to adjust the line color.

Dashed Drop-down List box:

Use this option to adjust the line style.

Weight Edit box:

Use this option to adjust the line thickness.

Weight Highlight Spin box:

Use this option to adjust the width of the highlight line.

 XE "Annotation Options Dialog:Annotation Text Tab " \* MERGEFORMAT Text Tab

Use the options on this tab to customize the text properties for subsequent and currently selected annotations.
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The following fields are on the Text Tab:

Font Drop-down List box:

Use this option to adjust the font to be used.

Size Drop-down List box:

Use this option to adjust the font size.

Color Drop-down List box:

Use this option to adjust the font color.

Show Text Check box

Select this check box to have the text made visible in the text annotations (The text is made visible by default).

Show Border Check box

Select this check box to display a border around the text annotation.

Bold Check box

Select this check box to make the text in the annotation bold.

Italic Check box

Select this check box to set the text to italic in the text annotation.

Strikethrough Check box

Select this check box to set the text to Strikethrough font in the text annotation.

Underline Check box

Select this check box to underline the text in the text annotation.

Left Radio button

Select this radio button to set the text to align to the left side of the text annotation.

Center Radio button

Select this radio button to set the text to align to the center of the text annotation.

Right Radio button

Select this radio button to set the text to align to the right of the text annotation.

0 Radio button

Select this radio button to display the text without rotation.

90 Radio button

Select this radio button to show the text rotated 90 degrees counter-clockwise in the text annotation.

180 Radio button

Select this radio button to show the text rotated 180 degrees counte-clockwise in the text annotation.

270 Radio button

Select this radio button to show the text rotated 270 degrees counte-clockwise in the text annotation.

 XE "Annotation Options Dialog:Annotation Ruler Tab " \* MERGEFORMAT Ruler Tab

Use the options on this tab to customize the ruler properties for subsequent and currently selected annotations.
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The following fields are on the Ruler Tab:

Show Length Check box

Select this check box to show the length of selected ruler annotations in a user specified unit of measurement.

Measurement Units Drop-down list box:

Use this option to select the unit of measurement displayed on the ruler object(s). It contains the following options:
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Inch
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Feet
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Yards
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Micrometers

[image: image231.png]


Millimeters
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Centimeters
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Meters
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Twips
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Points

[image: image236.png]


Pixels

This option is only available if the Show Length check box is selected.

Unit Abbreviation Edit box:

Use this option to change an abbreviation for the specified unit of measurement. Default abbreviations are placed in this section when the unit of measurement is adjusted but remain editable to user preference.

This option is only available if the Show Length check box is selected.

Unit Precision Edit box:

Use this option to adjust the unit precision for selected ruler annotations.

This option is only available if the Show Length check box is selected.

Show Gauge Check box

Select this check box to show the gauge on selected ruler annotations.

Gauge Length Edit box:

Use this option to adjust the height of the gauge marks.

This option is only available if the Show Gauge check box is selected.

Show Tic Mark Check box

Select this check box to show the tic marks (e.g., fractional markings) on selected ruler annotations.

Tic Mark Length Edit box:

Use this option to adjust the height of tic marks.

This option is only available if the Show Tic Mark check box is selected.

 XE "Annotation Options Dialog:Annotation Angel Tab " \* MERGEFORMAT Angle Tab

Use the options on this tab to customize the angle properties.
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The following fields are on the Angle Tab:

Acute Check box

Select this check box to display the inside angle of any protractor object(s).

Measurement Units Drop-down list box

Use this option to select the unit of measure to be used for the protractor object(s). The following values are possible:
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Degrees
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Radians

Unit Abbreviation Edit box:

Use this option to enter the abbreviation for the unit being used in the Measurement Units drop-down list box.

Unit Precision Edit box:

Use this option to enter the precision for the unit of measure being used. This specifies the number of decimal places to be used.

Arc Radius Edit box:

Use this option to specify where along the radius the arc for protractor object(s) is to be drawn.

Printing

 XE "Printing " \* MERGEFORMAT 

 XE "Dialogs " \* MERGEFORMAT 

 XE "Batch Print Dialog " \* MERGEFORMAT Batch Print Dialog

Use the Batch Print dialog to redirect the printing command of specific material to one or more printers' driver installed on the system.

To display the Batch Print dialog, from the main menu, choose File -> Batch Print...
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The following fields are on the Batch Print dialog:

Batch Printers List box

Use this list to display a list of printers that the user can rout the print job to.

Through the list, the user can:
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Select the printer to be used.

[image: image242.png]


Access the printer properties, either using the mouse right click button or double click on the printer name.
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Access the Enhanced Printing Options dialog for the selected printer using the mouse right click button.

OK Button

Click the OK button to start printing over the selected printers.

Cancel Button

Click the Cancel button to close the dialog without printing.

See Also

Print Dialog
Enhanced Printing Options Dialog
ePrint Task Printer Creation Wizard
 XE "Printing " \* MERGEFORMAT 

 XE "Enhanced Printing Options Dialog " \* MERGEFORMAT 

 XE "Enhanced Printing " \* MERGEFORMAT 

 XE "Dialogs " \* MERGEFORMAT Enhanced Printing Options Dialog

Use the Enhanced Printing Options dialog to customize the printed job by setting layout, alignment, gutter control, and margin options. To display the Enhanced Printing Options dialog from the Print dialog, click the Options button.
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The following fields are on the Enhanced Printing Options dialog:

Enhanced Options Check box:

Select or clear the Enhanced Options check box to enable or disable the enhanced printing options.

Layout Drop-down list box

Use the Layout drop-down list box to specify the layout types of the printed job.

It contains the following options:
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Single: Prints one page on each sheet of the paper. This option will modify the print job to include the specified border and margin information.
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Double: Prints two pages per sheet of paper. This option is a paper saving option. It also supports other options such as Gutter, Stationery, etc. This option is good for drafts and emails.

[image: image247.png]


4 X: Prints four pages per sheet of paper. This option is a paper saving option that supports other options. This option can be used with large text documents, providing less paper to be stored or archived. In this option you can change the page ordering which will be explained later.
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8 X: Prints eight pages per sheet of paper. This option is a paper saving option. It allows you to change the page ordering within the sheet of paper. This is a preferred option in presentations.
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16 X: Prints sixteen pages per sheet of paper. This option is a paper saving option. It allows you to change the page ordering within the sheet of paper. This is a preferred option in presentations or in the case of printing to large sheets of paper.
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Booklet: Creates a double-sided book print out.

This option is only available if the Enhanced Options check box is selected.

Repeat Check box

Select the Repeat check box to allow repetition of the same page in each slot of the paper sheet. For example, if the layout is 8 X, each of the 8 slots on the page will contain the selected page.

This option is only available if the Enhanced Options check box is selected and the Layout value is Double, 4x, 8x, or 16x.

Horizontal Radio button

Select the Horizontal radio button to increment the pages in left-to-right row-order as illustrated below in this 8 X layout:

	1
	2
	3
	4

	5
	6
	7
	8


This option is only available if the Enhanced Options check box is selected and the Layout value is 4x, 8x, or 16x.

Vertical Radio button

Select the Vertical radio button to increment the pages in top-to-bottom column-order as illustrated below in this 8 X layout:

	1
	3
	5
	7

	2
	4
	6
	8


This option is only available if the Enhanced Options check box is selected and the Layout value is 4x, 8x, or 16x.

PDF Radio button

Select the PDF radio button to reverse the column (vertical) sequence order.

This option is only available if the Enhanced Options check box is selected and the Layout value is 4x, 8x, 16x, or Double with Portrait orientation.

R-L Radio button

Select the R-L radio button to reverse the ordering of pages from left side to the right side within a page. This option is used when a Middle Eastern or other bi-directional language version of Windows is being used.

This option is only available if the Enhanced Options check box is selected and the Layout value is 4x, 8x, 16x, Booklet, or Double with Landscape orientation.

Borders Drop-down list box:

Use the Borders drop-down list box to indicate whether to draw a border around the pages. It contains the following values:
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Off: Drawing borders is turned off.
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Auto: Drawing borders according to the Ordering settings. This means that if the ordering was set to Vertical, a frame will be drawn around each column of pages in the sheet of paper and the pages will be ordered top to bottom. For example, if the layout is 8 X and the ordering option is down the pages will appear like this:

	1

2
	3

4
	5

6
	7

8


If the layout is 8 X and the ordering option is across, a frame will be drawn around each row:

	1 2 3 4

	5 6 7 8
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On: Drawing borders around each page like the case shown below where the layout is set to 4 X up and the ordering is set to across.

	1
	2

	3
	4


The Auto value will not be available in the Borders Drop-down list box if the Layout Drop-down list box is set to single.

This option is only available if the Enhanced Options check box is selected.

Best Fit Check box

Select this check box to specify whether to the Best Fit option or the stretch option.

If this option is selected, the document will be printed so as to best fit on the page. When this check box is clear, the document will be stretched on the page.

This option is only available if the Enhanced Options check box is selected.

Horizontal Align Group

Use this group of controls to set horizontal alignment.

Left Radio button

Select this radio button to set the document so it uses left alignment.

This option is only available if the Enhanced Options and Best Fit check boxes are selected.

Center Radio button

Select this radio button to set the document so it is centered horizontally.

This option is only available if the Enhanced Options and Best Fit check boxes are selected.

Right Radio button

Select this radio button to set the document so it uses right alignment.

This option is only available if the Enhanced Options and Best Fit check boxes are selected.

Vertical Align Group

Use this group of controls to set vertical alignment.

Top Radio button

Select this radio button to set the document so it uses top alignment.

This option is only available if the Enhanced Options and Best Fit check boxes are selected.

Center Radio button

Select this radio button to set the document so it is centered vertically.

This option is only available if the Enhanced Options and Best Fit check boxes are selected.

Bottom Radio button

Select this radio button to set the document so it uses bottom alignment.

This option is only available if the Enhanced Options and Best Fit check boxes are selected.

Gutter Control Group

Use this group of controls to set up the gutter.

Left Check box

Select this check box to specify a left gutter. This space will be determined by the value of the Gutter Width.

This option is only available if the Enhanced Options check box is selected and the value of Layout Drop-down list box is not Booklet.

Right Check box

Select this check box to specify a right gutter. This space will be determined by the value of the Gutter Width.

This option is only available if the Enhanced Options check box is selected and the value of Layout Drop-down list box is not Booklet.

Top Check box

Select this check box to specify a top gutter. This space will be determined by the value of the Gutter Width.

This option is only available if the Enhanced Options check box is selected and the value of Layout Drop-down list box is not Booklet.

Bottom Check box

Select this check box to specify a bottom gutter. This space will be determined by the value of the Gutter Width.

This option is only available if the Enhanced Options check box is selected and the value of Layout Drop-down list box is not Booklet.

Inside Check box

Select this check box to specify an inside gutter. This space will be determined by the value of the Gutter Width.

This option is only available if the Enhanced Options check box is selected and the value of Layout Drop-down list box is Booklet.

Gutter Width Edit box:

Use this option to specify the width of the gutter. When using the inside gutter, this value determines the width of the gutter for each side of the book.

This option is only available if the Enhanced Options check box is selected and there is at least one gutter selected.

Gutter Width Unit Drop-down list box

Use this option to specify the unit of the gutter width. Possible values are:

Inch

mm (Millimeters)

When changing between Inch and mm, the Gutter Width value will be converted to the new unit.

This option is only available if the Enhanced Options check box is selected and there is at least one gutter selected.

Margin Type Drop-down list box

Use this option to specify the margin type to be used when printing the document. It contains the following options:
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None: No margins will be drawn. This provides maximum printable area inside each page.
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Tiny: Very small margins will be drawn.
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Small: Small margins will be drawn.
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Medium: Medium margins will be drawn. This provides more spacing between pages than the small margins.
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Large: Large margins will be drawn. This provides the largest spacing between pages.
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Printer Default: The printer default margins will be drawn.
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Custom: This will allow you to specify the value of the margins as a percentage of the paper height and width. You can specify a margin value up to 50%.

This option is only available if the Enhanced Options check box is selected.

Margin Value Edit box

Use this option to customize the margin value to be used. Possible values range from 0 – 99.

This option is only available if the Enhanced Options check box is selected and the value of the Margin Type drop down list box is set to Custom.

Preview

This option displays a descriptive preview for the selected document.

Default Button

Click the Default button to set the default values of the Enhanced Printing Options dialog.

OK Button

Click the OK button to save the Enhanced options and close the dialog box.

Cancel Button

Click the Cancel button to close the dialog without using the Enhanced options.

See Also

Print Dialog
 XE "Printing " \* MERGEFORMAT 

 XE "Print Dialog " \* MERGEFORMAT 

 XE "Dialogs " \* MERGEFORMAT Print Dialog

Use the Print dialog to print the all the included pages in a print job.

To display the Print dialog, from the:
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Main menu, select File -> Print… or press the <Ctrl> + <P> key combination.

Or
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ePrint Main Window Workspace Context Menu, select Print.

Or
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Jobs List Context Menu, select Print.
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The following fields are on the Print dialog:

Name Drop-down list box:

Use the Name drop-down list box to select your preferred printer device from the listed devices.

Properties Button:

Click the Properties button to open the printer device customization dialog. This dialog is specific for each printer.

Status

Displays information about the selected printer's status.

Type

Displays information about the selected printer's type.

Where

Displays information about the printer's location.

Comment

Displays a comment if available.

All Radio button

Select this radio button to indicate that all pages are should be printed.

Pages Radio button

Select this radio button to select a specific range of pages to be printed.

This radio button is only available if more than 1 page is available to be printed.

from Edit box:

Use this option to specify the first page index to start printing from.

This radio button is only available if more than 1 page is available to be printed.

to Edit box:

Use this option to specify the last page index to print.

This radio button is only available if more than 1 page is available to be printed.

Number of copies Edit box:

Use this option to specify the number of copies to be printed.

Duplex Drop-down list box:

Use this option to choose the desired duplex printing method. It includes the following options:
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Off: No duplex printing.
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Auto Default: Use the auto duplex option of the printer if the chosen printer supports such an option.
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Auto Long Edge: Flips the paper along the longer side of the sheet.
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Auto Short Edge: Flips the paper along the shorter side of the sheet.
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Manual Page Up: Used where it is a must to reinsert the paper with the printed side face up.
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Manual Page Down: Used where it is a must to reinsert the paper with the printed side face down.

Options Button

Click the Options button to display the Enhanced Printing Options dialog.

OK Button

Click the OK button to print and close the dialog box.

Cancel Button

Click the Cancel button to close the dialog without printing.

See Also

Enhanced Printing Options Dialog
ePrint Main Window Workspace Context Menu
Jobs List Context Menu
LEADTOOLS ePrint 5 Printing Preferences Dialog

 XE "Printing Preferences Dialog " \* MERGEFORMAT 

 XE "Dialogs " \* MERGEFORMAT LEADTOOLS ePrint 5 Printing Preferences Dialog

Use the LEADTOOLS ePrint 5 Printing Preferences dialog to reconfigure the ePrint Document Properties to let you specify the paper size and margins. To display the LEADTOOLS ePrint 5 Printing Preferences dialog, from the Printers and Faxes folder in the Control Panel, right-click on LEADTOOLS ePrint 5 and select Printing Preferences. The following figure shows the Printing Preferences dialog:
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The following buttons are on the LEADTOOLS ePrint 5 Printing Preferences dialog:

Restore Defaults Button

Click the Restore Defaults button to restore the default values for the variables on each of the Paper and Graphics pages. Press the Alt+R key.

OK Button

Click the OK button to close the dialog and save the changes to the LEADTOOLS ePrint 5 Printing Preferences settings.

Cancel Button

Click the Cancel button to close the dialog and discard the changes to the LEADTOOLS ePrint 5 Printing Preferences settings.

Apply Button

This button is not used: it is always disabled.

Help Button

Click the Help button to display the LEADTOOLS ePrint 5 Professional Help file on the associated page for this dialog.

The following tabs and dialog are accessible from the LEADTOOLS ePrint 5 Printing Preferences dialog:

Paper tab
Graphics tab
About tab
Custom Paper Dialog
 XE "Printing Preferences Dialog " \* MERGEFORMAT 

 XE "Dialogs " \* MERGEFORMAT LEADTOOLS ePrint 5 Printing Preferences Dialog

Use the LEADTOOLS ePrint 5 Printing Preferences dialog to reconfigure the ePrint Document Properties to let you specify the paper size and margins. To display the LEADTOOLS ePrint 5 Printing Preferences dialog, from the Printers and Faxes folder in the Control Panel, right-click on LEADTOOLS ePrint 5 and select Printing Preferences. The following figure shows the Printing Preferences dialog:
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The following buttons are on the LEADTOOLS ePrint 5 Printing Preferences dialog:

Restore Defaults Button

Click the Restore Defaults button to restore the default values for the variables on each of the Paper and Graphics pages. Press the Alt+R key.

OK Button

Click the OK button to close the dialog and save the changes to the LEADTOOLS ePrint 5 Printing Preferences settings.

Cancel Button

Click the Cancel button to close the dialog and discard the changes to the LEADTOOLS ePrint 5 Printing Preferences settings.

Apply Button

This button is not used: it is always disabled.

Help Button

Click the Help button to display the LEADTOOLS ePrint 5 Professional Help file on the associated page for this dialog.

The following tabs and dialog are accessible from the LEADTOOLS ePrint 5 Printing Preferences dialog:

Paper tab
Graphics tab
About tab
Custom Paper Dialog
 XE "Printing Preferences Dialog:Custom Paper Dialog " \* MERGEFORMAT Custom Paper Dialog

Clicking the Add button on the LEADTOOLS ePrint 5 Printing Preferences dialog opens the Custom Paper dialog. A new custom paper size can be used for future printing jobs until it is deleted by clicking the Delete button. Click the Edit button to modify the settings for a specific custom size. Note that only the custom sizes can be deleted or modified. The Custom Paper dialog is shown in the following figure:
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Name Edit box:

Use the Name edit box to type in the name of the new paper size.

0.1 Inches Radio button

Select the 0.1 Inches radio button to set the unit of measurement to inches. 

0.1 mm Radio button

Select the 0.1 mm radio button to set the unit of measurement to millimeters.

Width Edit box

Use the Width edit box to set the width of the new size. Valid values range from 50 – 32767 when using millimeters and from 1 -1290 when using inches. The default values are 50 and 1, respectively.

Length Edit box

Use the Width edit box to set the length of the new size. Valid values range from 50 – 32767 when using millimeters and from 1 -1290 when using inches. The default values are 50 and 1, respectively.

Default Button

Click the Default button to set the options in the dialog to the default values.

OK Button

Click the OK button to close the dialog box and add the new paper.

Cancel Button

Click the Cancel button to close the dialog box without adding the new paper.

 XE "Printing Preferences Dialog:Paper Tab " \* MERGEFORMAT Paper Tab

With LEADTOOLS ePrint 5 Professional it is possible to change the paper settings before redirecting a print command to save an item to a file, to send an email, or to print to one or more printers. When LEADTOOLS ePrint 5 Professional is used and a print command is sent from a program, the image that was sent to the "printer" is prepared, based on the values set on the Paper tab of the LEADTOOLS ePrint 5 Printing Preferences Properties dialog. The Paper tab is shown in the following figure:
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The following fields are on the Paper Page:

Paper Size Drop-down list box

Use this option to select the size of the paper the user is going to print on. The default is Letter.

Add Button

Click the Add button to open the Custom Paper Dialog to add a new custom paper size that the user can define its dimensions and name.

Edit Button

Click the Edit button to enable the user to edit any user-defined paper sizes (only user-defined paper sizes can be edited).

This option is only available if a user-defined paper size was selected in the Paper Size Drop-down list box. 

Delete Button 

Click the Delete button to delete the user-defined paper size. 

This option is only available if a user-defined paper size was selected in the Paper Size Drop-down list box. 

Portrait Radio button

Click this radio button to set the printing orientation for the page to Portrait.

Landscape Radio button

Click this radio button to set the printing orientation for the page to Landscape.

Emulate Printer Drop-down list box

Use this option to set the margins to the default margins used by the printer selected in this list.

For step-by-step directions for preparing paper settings, refer to How To Prepare Paper Settings.

 XE "Printing Preferences Dialog:Graphics Tab " \* MERGEFORMAT 

 XE "print to pdf " \* MERGEFORMAT 

 XE "print to file " \* MERGEFORMAT 

 XE "print to almost any file format " \* MERGEFORMAT Graphics Tab

With LEADTOOLS ePrint 5 Professional it is possible to change the graphics settings before redirecting a print command to save to a file, to send an email, or to print to one or more printers. When LEADTOOLS ePrint 5 Professional is used and a print command is sent from a program, the information that was sent to the "printer" is prepared, based on the values set on the Graphics tab of the LEADTOOLS ePrint 5 Printing Preferences Properties dialog. The following figure shows the Graphics tab:
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You can add a custom resolution by selecting "custom" from the combo box. The image below shows the Graphics tab with custom options.
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The following fields are on the Graphics tab:

Resolution Drop-down list box:

Use this option to select the resolution. Possible values are:
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Draft (96 DPI): Printer Resolution is 96 DPI.
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Low (150 DPI): Printer Resolution is 150 DPI.
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Medium (300 DPI): Printer Resolution is 300 DPI.
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High (600 DPI): Printer Resolution is 600 DPI.
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Custom: Selecting "Custom" shows the X and Y resolution controls so that the user can specify the preferred resolution. Possible values range from 50 to 1600 DPI. The default value is 50.

For step-by-step directions for manipulating graphics settings, refer to How To Prepare Graphics Settings.

 XE "Printing Preferences Dialog:About Tab " \* MERGEFORMAT About Tab

This page displays the product name, company name, product ID and version, and build numbers. For more information, refer to the About ePrint Dialog.

 XE "Printing Preferences Dialog:Paper Tab " \* MERGEFORMAT Paper Tab

With LEADTOOLS ePrint 5 Professional it is possible to change the paper settings before redirecting a print command to save an item to a file, to send an email, or to print to one or more printers. When LEADTOOLS ePrint 5 Professional is used and a print command is sent from a program, the image that was sent to the "printer" is prepared, based on the values set on the Paper tab of the LEADTOOLS ePrint 5 Printing Preferences Properties dialog. The Paper tab is shown in the following figure:
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The following fields are on the Paper Page:

Paper Size Drop-down list box

Use this option to select the size of the paper the user is going to print on. The default is Letter.

Add Button

Click the Add button to open the Custom Paper Dialog to add a new custom paper size that the user can define its dimensions and name.

Edit Button

Click the Edit button to enable the user to edit any user-defined paper sizes (only user-defined paper sizes can be edited).

This option is only available if a user-defined paper size was selected in the Paper Size Drop-down list box. 

Delete Button 

Click the Delete button to delete the user-defined paper size. 

This option is only available if a user-defined paper size was selected in the Paper Size Drop-down list box. 

Portrait Radio button

Click this radio button to set the printing orientation for the page to Portrait.

Landscape Radio button

Click this radio button to set the printing orientation for the page to Landscape.

Emulate Printer Drop-down list box

Use this option to set the margins to the default margins used by the printer selected in this list.

For step-by-step directions for preparing paper settings, refer to How To Prepare Paper Settings.

ePrint Task Printer Creation Wizard

 XE "Wizards " \* MERGEFORMAT 

 XE "print to pdf " \* MERGEFORMAT 

 XE "print to file " \* MERGEFORMAT 

 XE "print to almost any file format " \* MERGEFORMAT 

 XE "ePrint Task Printer Creation Wizard " \* MERGEFORMAT ePrint Task Printer Creation Wizard

Use the ePrint Task Printer Creation Wizard to create and update an ePrint Task printer for multi-function purposes. Once a Task printer has been created, it is installed to your system’s Printers folder as a Windows printer by ePrint and it will be available to any application that supports printing.

An ePrint Task printer can perform one or more of the following tasks:
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Save files to one or more file formats. The wizard allows you to select the file formats and set up name / rename options.
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Send emails, including the saved files as attachments (only one file can be sent in an email). This option requires that the file be saved prior to emailing.
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Print files to one or more printers. This option does not depend on whether the file is being saved. Jobs may be printed to multiple printers without saving to a file.

The wizard can be saved and closed by clicking the Finish button any time the wizard has all the information necessary to complete the selected tasks. If the Task printer has been assigned to save a file, and the file name and format have been set, then the wizard can be saved and closed. If the Task printer has been assigned to email a file, not only must the file be saved, but also the mail options must be configured as well.

To display the ePrint Task Printer Creation Wizard, from the main menu, choose Tools -> Create Task printer, or from the ePrint Task Printers Configuration Dialog click the Add or Edit buttons.

The following pages are in the ePrint Task Printer Creation Wizard:

Welcome Page
Printer Name Page
Save Options Page
E-mail Settings Page
MAPI Profile Page
Mail General Settings Page
Mail Server Settings Page
Mail Message Page
Batch Print Page
Document Options (Paper) Page
Document Options (Printer Resolution) Page
Options Page

Completion Page
< Back

Click the < Back button to move to the previous page in the wizard.

Next >

Click the Next > button to move to the next page in the wizard.

Finish

Click the Finish button to close the wizard and save the configuration of the task.

This option is only available if the configuration of the task is completed.

Cancel

Click the Cancel button to close the wizard, and discard the task configuration.

 XE "Wizards " \* MERGEFORMAT 

 XE "print to pdf " \* MERGEFORMAT 

 XE "print to file " \* MERGEFORMAT 

 XE "print to almost any file format " \* MERGEFORMAT 

 XE "ePrint Task Printer Creation Wizard " \* MERGEFORMAT ePrint Task Printer Creation Wizard

Use the ePrint Task Printer Creation Wizard to create and update an ePrint Task printer for multi-function purposes. Once a Task printer has been created, it is installed to your system’s Printers folder as a Windows printer by ePrint and it will be available to any application that supports printing.

An ePrint Task printer can perform one or more of the following tasks:
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Save files to one or more file formats. The wizard allows you to select the file formats and set up name / rename options.
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Send emails, including the saved files as attachments (only one file can be sent in an email). This option requires that the file be saved prior to emailing.
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Print files to one or more printers. This option does not depend on whether the file is being saved. Jobs may be printed to multiple printers without saving to a file.

The wizard can be saved and closed by clicking the Finish button any time the wizard has all the information necessary to complete the selected tasks. If the Task printer has been assigned to save a file, and the file name and format have been set, then the wizard can be saved and closed. If the Task printer has been assigned to email a file, not only must the file be saved, but also the mail options must be configured as well.

To display the ePrint Task Printer Creation Wizard, from the main menu, choose Tools -> Create Task printer, or from the ePrint Task Printers Configuration Dialog click the Add or Edit buttons.

The following pages are in the ePrint Task Printer Creation Wizard:

Welcome Page
Printer Name Page
Save Options Page
E-mail Settings Page
MAPI Profile Page
Mail General Settings Page
Mail Server Settings Page
Mail Message Page
Batch Print Page
Document Options (Paper) Page
Document Options (Printer Resolution) Page
Options Page

Completion Page
< Back

Click the < Back button to move to the previous page in the wizard.

Next >

Click the Next > button to move to the next page in the wizard.

Finish

Click the Finish button to close the wizard and save the configuration of the task.

This option is only available if the configuration of the task is completed.

Cancel

Click the Cancel button to close the wizard, and discard the task configuration.

 XE "ePrint Task Printer Creation Wizard:Welcome Page " \* MERGEFORMAT Welcome Page

This is the starting page of the Wizard. This page introduces the wizard and describes how it can be used to create task printers that can save, email, and print generated files.
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 XE "ePrint Task Printer Creation Wizard:Printer Name Page " \* MERGEFORMAT Printer Name Page

This page lets you specify the printer’s name and description.
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The following fields are on the Printer Name Page:

Printer Name Edit box

Use this option to enter the printer name.

Description Edit box

Use this option to enter the printer description.

Notes:

The Next > button is enabled when the Printer Name edit box is filled.

 XE "ePrint Task Printer Creation Wizard:Creation Wizard Save Options Page " \* MERGEFORMAT Save Options Page

Use this page to manage which file formats are to be saved, including what needs to be done to handle file name conflicts.
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The following fields are on the Save Options Page:

I want to save to the following format(s) Check box:

Select this check box to enable the save function.

Save Formats list box:

This option shows all the files to be saved by the printer task. The file name, format, compression level, color depth, and path of the file are displayed here.

	Note:
	Not all file formats use compression or color depth.


This option is only available if The I Want To Save To The Following Format(s) check box is selected.

Add Button

Click the Add button to open the Save As dialog to add files in the Save Formats list box for saving when the task printer is executed.

This option is only available if the I Want To Save To The Following Format(s) check box is selected.

The Save As Options Dialog that will appear will include a check box "Save Using the Document Name". Use this check box to use the job name as a file name for saving.

Modify Button

Click the Modify button to open the Save As dialog to edit the settings for the currently selected file in the Save Formats list box.

This option is only available if the I want to save to the following format(s) check box is selected and the Save Formats list box has at least one selected file.

Remove Button

Click the Remove button to remove the currently selected file in the Save Formats list box.

This option is only available if the I want to save to the following format(s) check box is selected and the Save Formats list box has at least one selected file.

Overwrite Radio button

Use the Overwrite Radio button to overwrite an existing file when the executing task printer attempts to save a file with the same name.

This option is only available if the I Want To Save To The Following Format(s) check box is selected and the Save Formats list box has at least one selected file.

Rename Radio button

Use the Rename Radio button to rename a file being saved by the executing task printer when naming conflict occurs with a file that has already been saved.

This option is only available if the I Want To Save To The Following Format(s) check box is selected and the Save Formats list box has at least one selected file.

Rename Options Button

Use the Rename Options button to open the Rename Options dialog and to specify how naming conflicts should be resolved.

This option is only available if the I Want To Save To The Following Format(s) check box is selected and the Rename radio button is selected.

Notes:

The Next > button is only available if the I Want To Save To The Following Format(s) check box is selected and at least one file is being added to the Save Formats list box.

 XE "ePrint Task Printer Creation Wizard:eMail Settings Page " \* MERGEFORMAT E-mail Settings Page

This page lets the user configure the email settings for the task printer to use when emailing a file as an attachment.

One or more files must be saved to enable the email option, however only one output file may be selected to send via mail. The chosen file may be sent by SMTP directly through ePrint or through the default email client, depending on the user’s preference.
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The following fields are on the E-mail Settings Page:

I want to send the generated file(s) as email attachment(s) Check box

Select this check box to automatically send one of the saved files as an attachment to an email. There must be at least one file saved by the task in order to use this option.

I would like to use the following file format from the save list Drop-down list box:

Use this option to select a file to attach to the email.

This is only available if the I Want To Send The Generated File(S) As Email Attachment(s) check box is selected.

Using default email program Radio button

Use this option to send the files using the default mail program.

	Note:
	IF this option is selected, clicking the Next > button will move to the MAPI Profile Page in the wizard.


This option is only available if the I Want To Send The Generated File(S) As Email Attachment(s) check box is selected.

Directly through SMTP server Radio button

Use this option to send the files using the SMTP server.

	Note:
	By selecting this option, clicking the Next > button will move to the Mail General Settings Page in the wizard.


This option is only available if the I Want To Send The Generated File(S) As Email Attachment(s) check box is selected.

Send email silently Check box

If this option is selected, ePrint will not prompt the user to edit the email after it has been generated and the email will be sent automatically. If this option is unselected, the user will be prompted for interaction with the generated email and attachment after it has been created. The user will be responsible for the sending and editing of this email.

This option is only available if the I Want To Send The Generated File(S) As Email Attachment(s) check box is selected.

Warn me if attachments size more than Check box

Select this check box to warn the user if the attached file size exceeds the limit size used in the Max Size edit box.

This option is only available if the I want to send the generated file(s) as email attachment(s) check box is selected and the Warn me if attachments size more than xxx KB check box is also selected.

Clear files after sending email Check box

Select this check box to determine whether to delete the saved files after sending email. If this option is selected, the files that you select to be sent by email will be deleted immediately after sending the email.

This option is only available if the I Want To Send The Generated File(S) As Email Attachment(s) check box is selected.

Notes:

The Next > button will move to the Batch Print Page, if the I Want To Send The Generated File(S) As Email Attachment(s) check box is not selected.

 XE "ePrint Task Printer Creation Wizard:MAPI Profile Page " \* MERGEFORMAT MAPI Profile Page

This page lets you select the MAPI Profile to be used in sending emails. The Use Default Profile check box is selected by default, since typically you will want to use the default email program and the default profile. 

This page is only available if the Using Default Email Program radio button in the E-mail Settings Page of the wizard is selected.
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The following fields are on the MAPI Profile Page:

Use default profile Check box

Select this check box to use the default MAPI profile in sending emails.

Profile Edit box

Use this option to enter the MAPI profile name.

This option is only available if the Use Default Profile check box is not selected.

Password Edit box

Use this option to enter the MAPI profile password.

This option is only available if the Use Default Profile check box is not selected.

 XE "ePrint Task Printer Creation Wizard:Mail General Settings Page " \* MERGEFORMAT Mail General Settings Page

This page allows the user to configure the mail general settings.

This page is only available if the Directly Through SMTP Server radio button is selected in the E-mail Settings Page of the wizard.
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The following fields are on the Mail General Settings Page:

Name Edit box:

Use this option to enter the name of the email sender. This is the name that will appear in the From field of the email. If it is left empty, the email address will be used.

Organization Edit box:

Use this option to enter the organization name of the sender.

E-mail address Edit box:

Use this option to enter the sender’s email address. This will appear in the From field of the receiver if the Name is left empty.

The address must be in the form xxx@xxx to be accepted.

Reply address Edit box:

Use this option to enter the reply address for the sender. Replies to this email will be sent to this address. If it is left empty, the sender’s email address will be used for replies.

The address must be in the form xxx@xxx to be accepted.

 XE "ePrint Task Printer Creation Wizard:Mail Server Settings Page " \* MERGEFORMAT Mail Server Settings Page

This page allows SMTP server settings such as the SMTP mail server name, SMTP port number, server time out, and login information to be set.

This page is only available if the Directly through SMTP server radio button is selected in the E-mail Settings Page of the wizard.
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The following fields are on the Mail Server Settings Page:

SMTP Mail Server Edit box:

Use this option to enter the name of the SMTP mail server.

SMTP Port Number Edit box:

Use this option to enter the SMTP mail server port number. Usually it is 25.

Server Timeouts Slider

Use this option to enter the number of seconds for the server to capture the connection. Possible values are range from 30 to 300 seconds.

Mail server requires authentication Check box

Select this check box to enable sending emails on servers that require authentication through an account name and a password.

Account name Edit box:

Use this option to enter the account name for the authentication information. This option is only available if the Mail Server Requires Authentication check box is selected.

Password Edit box:

Use this option to fill the password for the authentication information. This option is only available if the Mail Server Requires Authentication check box is selected.

 XE "ePrint Task Printer Creation Wizard:Mail Message Page " \* MERGEFORMAT Mail Message Page

This page allows you to configure the mail general settings.

This page is only available if the Directly through SMTP server radio button is selected in the E-mail Settings Page of the wizard.
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The following fields are on the Mail Message Page:

To Button

Click the To button to display the address book of the default email client.

To Edit box

Use this option to enter the address(es) of the recipient(s). Email addresses can be added by placing a semi-colon between the addresses (e.g., user1@xxxdomain.com; user2@xxxdomain.com ).

Cc Button

Click the Cc button to display the address book of the default email client.

Cc Edit box

Use this option to enter the address(es) of the email recipient(s). Email addresses can be added by placing a semi-colon between the addresses (e.g., user1@xxxdomain.com; user2@xxxdomain.com ).

Bcc Button

Click the Bcc button to display the address book of the default email client.

Bcc Edit box

Use this option to enter the address(es) to receive a blind copy of the email. Email addresses can be added by placing a semi-colon between the addresses (e.g., user1@xxxdomain.com; user2@xxxdomain.com ).

Subject Edit box:

Use this option to enter the subject of the email.

Message Edit box

Use this option to enter the message body of the email to accompany the attached file.

Notes:

The Next > button is only available if the To edit box has at least one recipient.

 XE "ePrint Task Printer Creation Wizard:Batch Print Page " \* MERGEFORMAT Batch Print Page

Use this page to have the document print the generated file to one or more printer drivers installed on the system (including physical hardware printers or additional ePrint task printers for additional processing).
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The following fields are on the Batch Print Page:

Batch Printers List box

This list displays the printers on your system which are accessible to ePrint.

Through the list, the user can:
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Select the printer(s) to be used.
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Access a printer’s properties by right-clicking the mouse or double clicking on the printer name.
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Access the Enhanced Printing Options dialog for the selected printer by right-clicking the printer’s name and selecting Enhanced Options.

Refresh Button

Click this button to refresh the batch printers list box.

 XE "ePrint Task Printer Creation Wizard:Paper Options Page " \* MERGEFORMAT Document Options (Paper) Page

First, an important note about paper settings made in ePrint. In most circumstances, the ePrint paper settings will be over-ridden by the application being used to print a document (e.g., A Microsoft Word document will have its data sent to the printer using Microsoft Word to "print" the document without user intervention). The ePrint settings only act as a "fail-safe" in case the originating document does not contain paper information. Most document types will have a predefined paper type, so this setting is rarely used in practice.

This page allows the user to configure the paper dimensions, paper orientation, and paper margins for printing documents.
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The following fields are on the Document Options Page:

Paper Type Drop-down List box

Use this option to select the paper type to use in printing.

If a custom paper is selected the Edit and Delete buttons will be enabled; otherwise they will be disabled. Paper dimensions will change if a different paper type is selected.

Add Button

Click the Add button to open the Custom Paper dialog, to customize a new paper with specific dimensions to be added to the Paper Type drop-down list box and used in printing.

Edit Button

Click the Edit button to open the Custom Paper dialog, to customize dimensions of the selected paper in the Paper Type drop-down list box.

This option is only available if the newly customized paper was added successfully.

Delete Button

Click the Delete button to delete the selected customized paper in the Paper Type drop-down list box.

This option is only available if the newly customized paper was added successfully.

Portrait Radio button

Use the Portrait Radio button to set the paper orientation to portrait.

Landscape Radio button

Use the Portrait Radio button to set the paper orientation to landscape.

Emulate Printer Drop-down List box

Use this option to select one of the printers installed to the system to copy its margins values to be used when creating the Task printer.

 XE "ePrint Task Printer Creation Wizard:Printer Resolution Page " \* MERGEFORMAT Document Options (Printer Resolution) Page

Use this page to configure the printer resolution of the Task printer.

[image: image302.png]B ePrint Task Printer Wizard

Document Options

Specily the defaut resolution for the ePiin Task Piinter

Resoluton

st

‘Custom Resolton

600

(50-1600) D1

(50-1600) D1





The following fields are on the Printer Resolution Page:

Resolution Drop-down List box

Use this option to select one of the predefined resolutions to be used when creating the Task printer.

Select the Custom value specify a customized resolution to be used.

X Edit box

Use this option to specify the X resolution of the Task printer. X resolution and Y resolution should be the same. (This is the pixels/inch resolution).

The value of this option is reflected to the value of Y edit box.

Possible values range between 50 and 1600.

This option is only available if the Custom value was selected in the Resolution drop-down list box.

Y Edit box

Use this option to specify the Y resolution of the Task printer. X resolution and Y resolution should be the same. (This is the pixels/inch resolution).

The value of this option is reflected to the value of X edit box.

Possible values range between 50 and 1600.

This option is only available if the Custom value was selected in the Resolution drop-down list box.

 XE "ePrint Task Printer Creation Wizard:Creation Wizard Save Options Page " \* MERGEFORMAT Save Options Page

Use this page to manage which file formats are to be saved, including what needs to be done to handle file name conflicts.
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The following fields are on the Save Options Page:

I want to save to the following format(s) Check box:

Select this check box to enable the save function.

Save Formats list box:

This option shows all the files to be saved by the printer task. The file name, format, compression level, color depth, and path of the file are displayed here.

	Note:
	Not all file formats use compression or color depth.


This option is only available if The I Want To Save To The Following Format(s) check box is selected.

Add Button

Click the Add button to open the Save As dialog to add files in the Save Formats list box for saving when the task printer is executed.

This option is only available if the I Want To Save To The Following Format(s) check box is selected.

The Save As Options Dialog that will appear will include a check box "Save Using the Document Name". Use this check box to use the job name as a file name for saving.

Modify Button

Click the Modify button to open the Save As dialog to edit the settings for the currently selected file in the Save Formats list box.

This option is only available if the I want to save to the following format(s) check box is selected and the Save Formats list box has at least one selected file.

Remove Button

Click the Remove button to remove the currently selected file in the Save Formats list box.

This option is only available if the I want to save to the following format(s) check box is selected and the Save Formats list box has at least one selected file.

Overwrite Radio button

Use the Overwrite Radio button to overwrite an existing file when the executing task printer attempts to save a file with the same name.

This option is only available if the I Want To Save To The Following Format(s) check box is selected and the Save Formats list box has at least one selected file.

Rename Radio button

Use the Rename Radio button to rename a file being saved by the executing task printer when naming conflict occurs with a file that has already been saved.

This option is only available if the I Want To Save To The Following Format(s) check box is selected and the Save Formats list box has at least one selected file.

Rename Options Button

Use the Rename Options button to open the Rename Options dialog and to specify how naming conflicts should be resolved.

This option is only available if the I Want To Save To The Following Format(s) check box is selected and the Rename radio button is selected.

Notes:

The Next > button is only available if the I Want To Save To The Following Format(s) check box is selected and at least one file is being added to the Save Formats list box.

 XE "ePrint Task Printer Creation Wizard:Completion Page " \* MERGEFORMAT Completion Page

This page lists the actions to be performed by the task being edited.
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The following fields are on the Completion Page:

To Do Edit box:

This option lists the actions that will be completed by the task.

 XE "ePrint Task Printers Manager Dialog " \* MERGEFORMAT 

 XE "Dialogs " \* MERGEFORMAT ePrint Task Printers Manager Dialog

Use the ePrint Task Printers Manager Dialog to list all Task printers and add, delete, or edit them from the list. A "Task Printer" is a simulated printer that you may print to from any application that allows you to print. The Task Printer will automatically perform a series of steps on a print job that can be specified from the Task Printers Manager.
To display the ePrint Task Printers Manager Dialog, from the main menu of the LEADTOOLS ePrint 5 Workstation, choose Tools -> Task Printers Manager. You can also open the ePrint Task Printers Manager by selecting it from the Start menu.
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The following fields are on the ePrint Task Printers Manager Dialog:

Task Printers List

The Task Printers List displays all of the Task printers installed on the system.

Add Button

Click the Add button to open the ePrint Task Printer Creation Wizard to add a new printer.

Delete Button

Click the Delete button to delete the currently selected Task printer in the Task Printers list.

Edit Button

Click the Edit button to open the ePrint Task Printer Creation Wizard to edit the currently selected Task printer in the Task Printers list.

Close Button

Click the Close button to close the dialog, and save the configuration of the Task printer.

See Also

ePrint Task Printer Creation Wizard
Other Jobs and Tasks

Task Wizard

 XE "Wizards " \* MERGEFORMAT 

 XE "Tasks " \* MERGEFORMAT 

 XE "Task Wizard " \* MERGEFORMAT Task Wizard

Use the Task Wizard to create or update tasks for performing multiple functions through executing a single task.

Tasks may include one or more of the following kinds of actions:

Saving files in a one or more user specified file formats.

Sending email(s) and including the file(s) being saved as attachments.

Printing files to one or more printers with or without saving the files.

You can finish configuring the task any time the selected features used by a task have all the necessary information entered (e.g., files to be saved will need to have all of the information necessary to save them, or files to be emailed will need to have the email program configured, the email message prepared, as well as all of the information necessary to save them.).

To display the Task Wizard, from the:

[image: image306.png]


main menu, choose Tasks -> Add New Task...
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from the Configure Tasks dialog, click the Add button or select a specific task from the tasks list and click the Configure button.

from the Do Task Summary dialog, click the Edit Task button.

The following are the pages and buttons in the Task Wizard:

Welcome Page
Task Name Page
Save Options Page
E-mail Settings Page
MAPI Profile Page
Mail General Settings Page
Mail Server Settings Page
Mail Message Page
Batch Print Page
Completion Page
< Back Button

Click the < Back button to move to the previous page in the wizard.

Next > Button

Click the Next > button to move to the next page in the wizard.

Finish Button

Click the Finish button to close the wizard and save the configuration of the task.

This option is only available if the configuration of the task is completed.

Cancel Button

Click the Cancel button to close the wizard, and discard the task configuration.

 XE "Wizards " \* MERGEFORMAT 

 XE "Tasks " \* MERGEFORMAT 

 XE "Task Wizard " \* MERGEFORMAT Task Wizard

Use the Task Wizard to create or update tasks for performing multiple functions through executing a single task.

Tasks may include one or more of the following kinds of actions:

Saving files in a one or more user specified file formats.

Sending email(s) and including the file(s) being saved as attachments.

Printing files to one or more printers with or without saving the files.

You can finish configuring the task any time the selected features used by a task have all the necessary information entered (e.g., files to be saved will need to have all of the information necessary to save them, or files to be emailed will need to have the email program configured, the email message prepared, as well as all of the information necessary to save them.).

To display the Task Wizard, from the:

[image: image308.png]


main menu, choose Tasks -> Add New Task...
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from the Configure Tasks dialog, click the Add button or select a specific task from the tasks list and click the Configure button.

from the Do Task Summary dialog, click the Edit Task button.

The following are the pages and buttons in the Task Wizard:

Welcome Page
Task Name Page
Save Options Page
E-mail Settings Page
MAPI Profile Page
Mail General Settings Page
Mail Server Settings Page
Mail Message Page
Batch Print Page
Completion Page
< Back Button

Click the < Back button to move to the previous page in the wizard.

Next > Button

Click the Next > button to move to the next page in the wizard.

Finish Button

Click the Finish button to close the wizard and save the configuration of the task.

This option is only available if the configuration of the task is completed.

Cancel Button

Click the Cancel button to close the wizard, and discard the task configuration.

 XE "Task Wizard:Welcome Page " \* MERGEFORMAT Welcome Page

This page introduces the wizard and describes what the wizard can do, such as set up a task to save, mail and print generated files.
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 XE "Task Wizard:Task Name Page " \* MERGEFORMAT Task Name Page

This page lets the user specify the task name and description.
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The following fields are on the Task Name Page:

Task Name Edit box

Use this option to enter the task name.

Description Edit box

Use this option to enter the task description.

Notes:

The Next > button is enabled when the Task Name edit box is filled.

 XE "Task Wizard:Save Options Page " \* MERGEFORMAT Save Options Page

In this page, the user adds, modifies and removes multiple file formats to be saved.

The saving function can also be configured to overwrite or rename files when duplicate file names are encountered.
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The following fields are on the Save Options Page:

I want to save to the following format(s) Check box:

Use this option to enable the save function.

Save Formats List box

This option shows all the files to be saved by the task. The file name, format, compression level, color depth, and path of the file are displayed here.

	Note:
	Not all file formats use compression or color depth.


This option is only available if the I Want To Save To The Following Format(s) check box is selected.

Add Button

Click the Add button to show the Save As dialog to add files in the Save Formats list box for saving when the task is executed.

This option is only available if the I Want To Save To The Following Format(s) check box is selected.

Modify Button

Click the Modify button to open the Save As dialog to edit the settings for the currently selected file in the Save Formats list box.

This option is only available if the I Want To Save To The Following Format(s) check box is selected and the Save Formats list box has at least one selected file.

Remove Button

Click the Remove button to remove the currently selected file in the Save Formats list box.

This option is only available if the I Want To Save To The Following Format(s) check box is selected and the Save Formats list box has at least one selected file.

Overwrite Radio button

Use the Overwrite Radio button to overwrite an existing file when the executing tasks attempts to save a file with the same name.

This option is only available if the I Want To Save To The Following Format(s) check box is selected and the Save Formats list box has at least one selected file.

Rename Radio button

Use the Rename Radio button to rename a file being saved by the executing task when naming conflict occurs with a file that has already been saved.

This option is only available if the I Want To Save To The Following Format(s) check box is selected and the Save Formats list box has at least one selected file.

Renaming Options Button

Click the Renaming Options button to open the Rename Options dialog to specify how naming conflicts should be resolved.

This option is only available if the I Want To Save To The Following Format(s) check box is selected and the Rename radio button is selected.

Notes:

The Next > button is only available if the I Want To Save To The Following Format(s) check box is selected and at least one file is being added to the Save Formats list box.

 XE "Task Wizard:eMail Settings Page " \* MERGEFORMAT E-mail Settings Page

This page lets the user configure the email settings for a task that will email a file as an attachment.

One or more files must be saved to enable the email option; however, only one output file can be selected to send via email. The chosen file may be sent by SMTP directly through ePrint or through the default email client, depending on the user’s preference.
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The following fields are on the E-mail Settings Page:

I want to send the generated file(s) as email attachment(s) Check box

Select this check box to automatically send one of the saved files as an attachment to an email. There must be at least one file saved by the task in order to use this option.

I would like to use the following file format from the saved list Drop-down list box:

Use this option to select a file to attach to the email.

This is only available if the I Want To Send The Generated File(s) As Email Attachment(s) check box is selected

Using default email program Radio button

Use this option to send the files using the default mail program.

	Note:
	IF this option is selected, clicking the Next > button will move to the MAPI Profile Page in the wizard.


This option is only available if the I Want To Send The Generated File(s) As Email Attachment(s) check box is selected

Directly through SMTP server Radio button

Use this option to send the files using the SMTP server.

	Note:
	By selecting this option, clicking the Next > button will move to the Mail General Settings Page in the wizard.


This option is only available if the I Want To Send The Generated File(s) As Email Attachment(s) check box is selected.

Send email silently Check box

If this option is selected, ePrint will not prompt the user to edit the email after it has been generated and the email will be sent automatically. If this option is unselected, the user will be prompted for interaction after the email has been created with the included file attachment.

This option is only available if the I Want To Send The Generated File(s) As Email Attachment(s) check box is selected.

Warn me if attachments size more than Check box

Select this check box to warn the user if the attached file size exceeds the limit size used in the Max Size edit box.

This option is only available if the I want to send the generated file(s) as email attachment(s) check box is selected and the Warn me if attachments size more than xxx KB check box is also selected.

Delete files after sending email Check box

Select this check box to determine whether to delete the saved files after sending email. If this option is selected, the files that you select to be sent by email will be deleted immediately after sending the email.

This option is only available if the I Want To Send The Generated File(s) As Email Attachment(s) check box is selected.

Notes:

The Next > button will move to the Batch Print Page, if the I want to send the generated file(s) as email attachment(s) check box is not selected.

 XE "Task Wizard:MAPI Profile Page " \* MERGEFORMAT MAPI Profile Page

This page lets the user to select the MAPI Profile to be used in sending emails (i.e., The Use default profile check box can simplify the email process by sending the email from the default profile on the default mail client.)

This page is only available if the user has selected the Using default email program Radio button in the E-mail Settings Page of the wizard.
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The following fields are on the MAPI Profile Page:

Use default profile Check box

Select this check box to use the default MAPI profile in sending emails.

Profile Edit box

Use this option to enter the MAPI profile name.

This option is only available if the Use default profile check box is not selected.

Password Edit box

Use this option to enter the MAPI profile password.

This option is only available if the Use default profile check box is not selected.

 XE "Task Wizard:General Settings Page " \* MERGEFORMAT Mail General Settings Page

Use this page to configure general mail settings.

This page is only available if the Directly Through SMTP Server radio button is selected in the E-mail Settings Page of the wizard.
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The following fields are on the Mail General Settings Page:

Name Edit box:

Use this option to enter the name of the individual sending the email. This is the name that will appear in the From: field of the email. If it is left empty, the email address will be used.

Organization Edit box:

Use this option to enter the name of the organization the sender represents.

E-mail address Edit box:

Use this option to enter the sender’s email address. This will appear in the From field of the receiver if the Name is left empty.

The address must be in the form xxx@xxx to be accepted. This is a required field.

Reply address Edit box:

Use this option to enter the reply address. Replies to this email will be sent to the address specified here. If it is left empty, the sender’s email address will be used for replying.

The address must be in the form xxx@xxx to be accepted.

 XE "Task Wizard:Mail Server Settings Page " \* MERGEFORMAT Mail Server Settings Page

Use this page to configure the SMTP server settings such as the SMTP mail server name, SMTP port number, server time out, and login information.

This page is only available if the user has selected the Directly Through SMTP Server radio button in the E-mail Settings Page of the wizard.
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The following fields are on the Mail Server Settings Page:

SMTP Mail Server Edit box:

Use this option to enter the name of the SMTP mail server.

SMTP Port Number Edit box:

Use this option to enter the SMTP mail server port number. Usually it is 25.

Server Timeouts Slider

Use this option to enter the number of seconds for the server to capture the connection. Possible values are range from 30 to 300 seconds.

Mail server requires authentication Check box

Select this check box to enable sending emails on servers that require authentication through an account name and a password.

Account name Edit box:

Use this option to enter the account name for the authentication information.

This option is only available if the Mail Server Requires Authentication check box is selected.

Password Edit box:

Use this option to fill the password for the authentication information.

This option is only available if the Mail Server Requires Authentication check box is selected.

 XE "Task Wizard:Mail Message Page " \* MERGEFORMAT Mail Message Page

This page allows the user to create an email to be sent.

This page is only available if the user has selected the Send email silently check box in the E-mail Settings Page of the wizard.
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The following fields are on the Mail Message Page:

To Button

Click the To button to display the address book of the default email client.

To Edit box

Use this option to enter the address(es) of the recipient(s).

Email addresses can be added by placing a semi-colon between the addresses (e.g., user1@xxxdomain.com ; user2@xxxdomain.com ).

Cc Button

Click the Cc button to display the address book of the default email client.

Cc Edit box

Use this option to enter the address(es) of the email recipient(s).

Email addresses can be added by placing a semi-colon between the addresses (e.g., user1@xxxdomain.com ; user2@xxxdomain.com ).

Bcc Button

Click the Bcc button to display the address book of the default email client.

Bcc Edit box

Use this option to enter the address(es) to receive a blind copy of the email.

Email addresses can be added by placing a semi-colon between the addresses (e.g., user1@xxxdomain.com ; user2@xxxdomain.com ).

Subject Edit box:

Use this option to enter the subject of the email.

Message Edit box

Use this option to enter the message body of the email that will accompany the attached file.

Notes:

The Next > button is only available if the To edit box has at least one recipient.

 XE "Task Wizard:Batch Print Page " \* MERGEFORMAT Batch Print Page

This page allows the user to have the document print the generated file to one or more printer drivers installed on the system including physical hardware printers or additional ePrint task printers for additional processing.
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The following fields are on the Batch Print Page:

Batch Printers List box:

This list displays the available printers on your system which are accessible to ePrint.

Through the list, the user can:
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Select the printer(s) to be used. 
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Access the printer properties by clicking the right mouse button or double clicking on the printer name.

[image: image321.png]


Access the Enhanced Printing Options dialog for the selected printer by right clicking the printer name and selecting Enhanced Options.

Refresh Button

Click this button to refresh the Batch Printers list box.

 XE "Task Wizard:Completion Page " \* MERGEFORMAT Completion Page

This page lists the actions to be performed by the task being edited.
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The following fields are on the Completion Page:

To Do Edit box:

This option lists the actions that will be completed by the task.

 XE "Tasks " \* MERGEFORMAT 

 XE "Dialogs " \* MERGEFORMAT 

 XE "Configure Tasks Dialog " \* MERGEFORMAT Configure Tasks Dialog

Use the Configure Tasks dialog to make adjustments to existing tasks, add new tasks, remove tasks, rearrange their order or execute a task. Tasks are defined in the Task Wizard help documentation. 

This dialog is only available if the ePrint workstation has at least one task configured.

To display the Configure Tasks dialog, from the main menu, choose Tasks -> Configure Tasks…
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The following fields are on the Configure Tasks dialog:

Tasks List:

This list views the currently existing tasks in the ePrint workstation.

U Button

Click the U button ("up") to move the selected task up one position in the task listing.
This option is only available if a task is selected which is not the first (or only) task in the list.

D Button

Click the D button ("down") to move the selected task down one position in the task listing.
This option is only available if a task is selected which is not the last (or only) task in the list.

Configure Button

Click the Configure button to display the Task Wizard dialog. This dialog will reconfigure the options of the task currently selected in the list.

This option is only available if the user has selected a task in the Tasks list.

Run Button

Click the Run button to execute the currently selected task on the included jobs and pages in the workstation.

This option is only available if the user has selected a task in the Tasks list.

Remove Button

Click the Remove button to remove the currently selected task from the Tasks list.

This option is only available if the user has selected a task in the Tasks list.

Add Button

Click the Add button to open the Task Wizard dialog to create and configure a new task. Once the new task is created, it will be added to the Tasks list.

OK Button

Click the OK button to close the dialog and save the configuration of the task.

Cancel Button

Click the Cancel button to close the dialog and discards the configuration of the task.

See Also

Task Wizard Dialog
 XE "Tasks " \* MERGEFORMAT 

 XE "Task Summary Dialog " \* MERGEFORMAT 

 XE "Dialogs " \* MERGEFORMAT Task Summary Dialog

Use the Task Summary dialog for quick access to executing, summarizing and editing a task specification.

To display the Task Summary dialog, from the main menu, choose Tasks and select a task from the list of user-created tasks at the bottom of the menu.
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The following fields are on the Task Summary dialog:

Task Name:

Shows the name of the task.

Description:

Shows the description of the task.

Summary:

Shows the summary of the task.

Run Button

Click the Run button to execute the task.

Edit Button

Click the Edit button to display the Task Wizard dialog. This dialog will reconfigure the options of the task.

Cancel Button

Click the Cancel button to close the dialog without executing the task.

 XE "Tasks " \* MERGEFORMAT 

 XE "ePrint Tasks Progress Dialog " \* MERGEFORMAT 

 XE "Dialogs " \* MERGEFORMAT ePrint Tasks Progress Dialog

This dialog appears to show the status and the result of the running task.

To display the ePrint Tasks Progress dialog:
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from the Task Summary dialog, click the Task button.

Or
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from the Configure Tasks dialog, click the Run button.

Or
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Double click on the running icon at the status bar.
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The following fields are on the ePrint Tasks Progress dialog:

Running Task

Shows the name of the currently running task.

Progress Bar

Shows the progress of the currently running task.

Don't show this dialog during running the service/task Check box

Select this check box to hide this dialog when running tasks in the future.

Cancel All Button

Click the Cancel All button to stop executing the running tasks and its subtasks.

This option will only work when a task or subtask is either running, not finished, not already being canceled or has not been stopped by an error.

<< Details / Details >> Button

Click this << Details / Details >> button to hide or show the detailed status of the run tasks.

This button toggles the visibility of the Tasks and Results tabs.

Tasks Tab

The Tasks tab displays the Name and Progress columns. The progress column shows the status of all tasks such as the percentage of its completion or whether the job is Done, Canceled, or has produced an Error.

Results Tab

The Results tab displays the result messages of a task as it is running.

Cancel Task Button

Click the Cancel Task button to stop executing the currently running task.

This option is only available if the task in a state of execution.

Keep Visible toggle Button

Click the Keep Visible toggle button to control the visibility of this dialog. This setting is also controlled by the Keep Status Dialog Visible check box on the Options dialog (Tools -> Options). When the Keep Status Dialog Visible check box on the Options dialog is selected, the toggle button on the Status Dialog looks like [image: image329.png]


, and clicking it means that the Status Dialog will close after tasks have finished executing unless the task encountered errors. When the Keep Status Dialog Visible check box on the Options dialog is cleared, the toggle button on the Status Dialog looks like [image: image330.png]


, and clicking it means that the Status Dialog will remain visible after tasks have finished executing regardless of whether errors were encountered.

See Also

Options Dialog 

 XE "Job Information Dialog " \* MERGEFORMAT 

 XE "Dialogs " \* MERGEFORMAT Job Information Dialog

Use the Job Information dialog to show information about the currently selected job.

To display the Job Information dialog, open the Jobs List Window Pane , right click a job listing to display the Jobs List Context Menu and select the Job Information option…
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The following fields are on the Job Information dialog:

Job ID:

Shows the job ID.

Total Pages:

Shows the total number of pages in the selected job.

Job Index:

Shows the job index in the Jobs List view.
Job Name:

Shows the job name.

Submitted Time:

Shows the time the job was submitted.

Close Button

Click the Close button to close the dialog.

Naming/Renaming Files and Resolving Conflict

 XE "Naming or renaming multiple file options " \* MERGEFORMAT 

 XE "Naming Options Dialog " \* MERGEFORMAT 

 XE "Dialogs " \* MERGEFORMAT Naming Options Dialog

Use the Naming Options dialog to specify how to name the files when pages are saved to separate files. To display the Naming Options dialog, from the Save As dialog, click the Naming Options button. This option is only available if the "Save each page as a separate file" check box is selected.
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The following fields are on the Naming Options dialog:

Template Edit box:

Use this edit box to enter the template for the naming convention to be used for the target files. You can enter text or select tags from the predefined list in the Tag drop-down list box. You can use any combination of text and tags you wish. The default Template is "<SRC><NUM>".

Tag Drop-down list box:

Use this drop-down list box to select the type of tag to be used and configure it for use in the Template edit box. The following types of tags are possible:
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<NUM>: Includes a numeric counter in the file name. The counter location, size, and behavior are dependent on the tag location and settings.
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<ALPHA>: Includes an alphabetical counter in the file name. The counter location, size, and behavior are dependent on the tag location and settings.
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<ALPHANUM>: Includes a counter of mixed alphabetical and numeric symbols in the file name. The counter location, size, and behavior are dependent on the tag location and settings.
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<DATE>: Includes the date when the naming template is applied in the file naming, where the date format, and location are dependent on the tag location and settings.

[image: image337.png]


<TIME>: Includes the time when the naming template is applied in the file name. The time format and location are dependent on the tag location and settings.
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<SRC>: Includes the source file name in the file name. The source file name is the name of the file as provided by the printing application and not necessarily the name of the printed file as it is stored on the hard drive. The location and the character’s upper and lower cases are dependent on the tag location and settings.

The default tag is "NUM>". The same tag can be applied more than once to the target file name. Additionally, characters that do not match any tag in the target file name can be inserted.

Mask Check box:

Select this check box to enable the Mask option group and to apply a mask.

A mask is used to position placeholder or "padding" characters in a filename counter to maintain consistency in the way the file is named. By default this option is not selected and single digit numbers or letters will increment to double-character numbers and letters, etc. By enabling masking, this will place "padding" characters in front of the counter to increase the quantity of characters to a user specified length. 

Unmasked numbers and letters increment in the normal fashion (e.g., 1, 2, …9, 10, 11 or a, b, c… y, z, aa, ab, ac) while a counter masked to three characters would increment as follows: 001, 002, …009, 010, 011, etc. Care must be taken to ensure that a masking length is set high enough to ensure the naming consistency of all pages to be printed, (e.g., a masking count of 2 will result in the following output: 01,02…99, 10, 10, 10. This will defeat the integrity of the mask because 99 requires only two characters and 100 requires three which is not allowed by the mask size.)

By default no mask will be used and the counter will only use the minimum number of characters to represent the counter. Any character acceptable for use in a file name (with some exceptions) can be used as well, such as underscores and dashes (e.g., a padding mask of "____" will pad "BG" to "__BG".

This option is only available if the Tags drop-down list box contains a <NUM>, <ALPHA>, or <ALPHANUM> tag. The default is to have the check box unselected.

Digits Count Edit box:

Use this option to set the number of padding digits to be used. The default is 1. This option is only available if the Tags drop-down list box contains a <NUM> tag and the Mask check box is selected.

Characters Count Spin box:

Use this option to set the number of padding characters to be used.

This option is only available if the Tags drop-down list box contains a <NUM>, <ALPHA>, or <ALPHANUM> tag and the Mask check box is selected. 

Padding Characters Edit box:

Use this option to create the mask. The count of the characters available is limited to the value filled in the Character Count edit box.

This option is only available if the Tags drop-down list box contains a <ALPHA>, or <ALPHANUM> tag and the Mask check box is selected.

Increment by Spin box:

Use this option to set the incrementation value for the counter tag. Possible values range from 0 to 1000. The default value is 1 (e.g., A mask with 3 padding digits "999" incremented by 5, would increment as: 990, 995, 910).

This option is only available if the Tags drop-down list box contains a <NUM>, <ALPHA>, or <ALPHANUM> tag and the Mask check box is selected.

Starting position Spin box:

Use this option to set the initial value to start counting. The default is 1. Possible values are range from 0 to 1000. The default value is 0.

This option is only available if the Tags drop-down list box contains a <NUM>, <ALPHA>, or <ALPHANUM> tag and the Mask check box is selected.

Alphabetical Range Start Value Edit box:

Use this option to set the character to begin counting from (e.g., if a start character of "p" is selected with a mask size of "aa", the mask would increment ap, aq, ar, as).

This option is only available if the Tags drop-down list box contains an <ALPHA>, or <ALPHANUM> tag and the Mask check box is selected.

Alphabetical Range End Value Edit box:

Use this option to set the end character to be used in counting loops. Placing lower value letter in the "To" text box will not reverse the incrementation (e.g., z, y, x). Alphabetical incrementation will always proceed in the normal fashion.

This option is only available if the Tags drop-down list box contains an <ALPHA>, or <ALPHANUM> tag and the Mask check box is selected.

Numerical Range Start Value Edit box:

Use this option to set the start numerical digit to be used in counting loops.

This option is only available if the Tags drop-down list box contains an <ALPHANUM> tag and the Mask check box is selected.

Numerical Range End Value Edit box:

Use this option to set the end numerical digit to be used in counting loops. Reversing the digit order where the start digit is higher than the finish digit will not reverse the incrementation.

This option is only available if the Tags drop-down list box contains an <ALPHANUM> tag and the Mask check box is selected.

Upper Case Check box:

Select this check box to use upper case characters when naming files.

This option is only available if the Tags drop-down list box contains an <ALPHA> or <ALPHANUM> tag and the Mask check box is selected.

Type Drop-down list box:

Use this option to set the date or time notation style.

If the value of the Tags drop-down list box is set to edit the <DATE> tag, this drop-down list box will contain the following options:
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Long: Days and the months are listed without abbreviation.
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Short: Days and months names are abbreviated.

If the value of the Tags drop-down list box is set to edit the <TIME> tag, this drop-down list box will contain the following options:
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Long 24: The time is displayed in 24 hour notation with seconds included.
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Short 24: The time is displayed in 24 hour notation without the seconds displayed.
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Long 12: The time is displayed in 12 hour notation with seconds included.
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Short 12: The time is displayed 12 hour notation without the seconds displayed.

This option is only available if the value of the Tags drop-down list box is <DATE> or <TIME>.

Case Drop-down list box:

Use this option to determine if the target file name should be in upper or lower case letters. It contains the following options:
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Keep as is: Target file name will have the source file name with no changes to upper/lower case letters.

[image: image346.png]


UPPER: All letters in the target file name will be changed to upper case.
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lower: All letters in the target file name will be changed to lower case.
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TOGGLE: All letters in the target file name will be inverted (i.e., all upper case letters will be changed to lower case and all lower case letters will be changed to upper case.)

This option is only available if the value of the Tags drop-down list box is <SRC>.

Samples list box:

This area displays a sample list of file names, as they would be saved by the naming options. This area will only preview the tags listed in the Template drop-down list box in their current configuration.

Default

Click the Default button to set the dialog options to the default values.

OK Button

Click the Ok button to close the dialog and save the naming options template and tag settings.

Cancel Button

Click the Cancel button to close the dialog and discard all changes.

See Also

Save As Dialog
 XE "Rename Options Dialog " \* MERGEFORMAT 

 XE "Naming or renaming multiple file options " \* MERGEFORMAT 

 XE "Dialogs " \* MERGEFORMAT Rename Options Dialog

Use the Rename Options dialog to rename output files so they will not write over existing files.

To display the Rename Options dialog, from the:
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Task Wizard, in the Save Options page, select the "Rename" radio button and click the Renaming Options button.
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ePrint Task Printer Creation Wizard, in the Save Options page, select the "Rename" radio button and click the Renaming Options button.
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The following fields are on the Rename Options dialog:

Set as Prefix Radio button

Select this radio button to place the tags at the beginning of the file name.

Set as Suffix Radio button

Select this radio button to place the tags at the end of the file name.

Tag Drop-down list box:

Use this option to select a tag to configure it for use. Select from the following tags:
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<NUM>: Includes a numeric counter in the file name. The counter location, size, and behavior are dependent on the tag location and settings.
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<ALPHA>: Includes an alphabetical counter in the file name. The counter location, size, and behavior are dependent on the tag location and settings.
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<ALPHANUM>: Includes a counter of mixed alphabetical and numeric symbols in the file name. The counter location, size, and behavior are dependent on the tag location and settings.

Mask Check box

Select this check box to enable access to the mask option group and to apply a mask.

A Mask is used to position placeholder or "padding" characters in a filename counter to maintain consistency in the way the file is named. By default this option is not selected and single digit numbers or letters will increment to double-character numbers and letters, etc. By enabling masking, this will place "padding" characters in front of the counter to increase the quantity of characters to a user specified length. 

Unmasked numbers and letters increment in the normal fashion (e.g., 1, 2, …9, 10, 11 or a, b, c… y, z, aa, ab, ac) while a counter masked to three characters would increment as follows: 001, 002, …009, 010, 011, etc. Care must be taken to ensure that a masking length is set high enough to ensure the naming consistency of all pages to be printed, (e.g., a masking count of 2 will result in the following output: 01,02…99, 10, 10, 10. This will defeat the integrity of the mask because 99 requires only two characters and 100 requires three which is not allowed by the mask size.)

By default no mask will be used and the counter will only use the minimum number of characters to represent the counter. Any character acceptable for use in a file name (with some exceptions) can be used as well, such as underscores and dashes (e.g., a padding mask of "____" will pad "BG" to "__BG".

Digits Count Edit box:

Use this option to set the number of padding digits to be used.
This option is only available if the Tags drop-down list box contains a <NUM> tag and the Mask check box is selected.

Character Count Edit box:

Use this option to set the number of padding characters to be used.

This option is only available if the Mask check box is selected.

Padding Characters Edit box:

Use this option to create the mask. The count of the characters available is limited to the value filled in the Character Count edit box.

This option is only available if the Mask check box is selected.
Increment by Edit box:

Use this option to set the incrementation value for the counter tag. Possible values range from 0 to 1000. The default value is 1 (e.g., A mask with 3 padding digits "999" incremented by 5, would increment as: 990, 995, 910)

This option is only available if the Mask check box is selected.

Starting position Edit box:

Use this option to set the initial value to start counting. Possible values are range from 0 to 1000. The default value is 0.

This option is only available if the Tags drop-down list box contains a <NUM>, <ALPHA>, or <ALPHANUM> tag and the Mask check box is selected.

Alphabetical Range Start Value Edit box:

Use this option to set the starting character value (e.g., if a start character of "p" is selected with a mask size of "aa", the mask would increment ap, aq, ar, as).

This option is only available if the Mask check box is selected.

Alphabetical Range End Value Edit box:

Use this option to set the ending character value to be used in counting loops. Placing a lower value letter in the "To" text box will not reverse the incrementation (e.g., z, y, x). Alphabetical incrementation will always proceed from the lower value to the higher value.

This option is only available if the Mask check box is selected.

Numerical Range Start Value Edit box:

Use this option to set the starting numerical digit to be used in counting loops.

This option is only available if the Tags drop-down list box contains an <ALPHANUM> tag and the Mask check box is selected.

Numerical Range End Value Edit box:

Use this option to set the ending numerical digit to be used in counting loops. Reversing the digit order where the starting digit is higher than the ending digit will not reverse the incrementation.

This option is only available if the Tags drop-down list box contains an <ALPHANUM> tag and the Mask check box is selected.

Upper Case Check box

Select this check box to use upper case characters in the file naming convention.

This option is only available if the Tags drop-down list box contains a <ALPHA>, or <ALPHANUM> tag and the Mask check box is selected.

Sample List box:

This area displays a sample list of file names, as they would be saved by the naming options. This area will only preview the tags listed in the Template drop-down list box in their current configuration.

Default Button

Click the Default button to set the dialog options to the default values.

OK Button

Click the OK button to close the dialog, and save the current file-renaming configuration.

Cancel Button

Click the Cancel button to close the dialog, and discard all changes.

See Also

Task Wizard
ePrint Task Printer Creation Wizard
 XE "Dialogs " \* MERGEFORMAT 

 XE "Conflict Found Dialog " \* MERGEFORMAT Conflict Found Dialog

Use the Conflict Found dialog to set what action to take when a page is being saved and a naming conflict occurs. The Conflict Found dialog appears when a file is being saved and another file with the same name is found to exist at that current location.
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The following fields are on the Conflict Found dialog:

Append Button

Click this button to append the files to be saved to the currently existing file. This button is only available if the file format supports multi-page files.

Overwrite Button

Click this button to overwrite the existing file with the newer file being saved.

Cancel Button

Click the Cancel button to close the dialog box without saving the file.

 XE "Dialogs " \* MERGEFORMAT 

 XE "Conflict Removal Dialog " \* MERGEFORMAT Conflict Resolving Options Dialog

Use the Conflict Resolving Options dialog to set the policy for saving a file when a file with an identical name currently exists (e.g., A file with the name "fourth-Quarter-review.PDF" is being saved to a folder where there is already a file titled "fourth-Quarter-review.PDF").

To display the Conflict Resolving Options dialog, from the main menu, choose Tools -> Conflict Resolving Options.
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The following fields are on the Conflict Resolving Options dialog:

Action Drop-down list box:

Use this option to select the action to deal with the conflict. Possible values are:
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Ask: This option is only available if the dialog appeared from the Tools menu. This option prompts the user when a conflict appears.
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Overwrite: The application overwrites the existing file with the new file.
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Rename: This selection enables renaming options for the file which can be specified by clicking the Options button.
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Skip: The application skips saving the conflicting file and keeps the existing one.

Options Button:

Click this button to open the Rename Options dialog to specify what rename options to use to resolve the conflict.

This button is only available if the Action drop-down list box is set to Rename.

OK Button

Click the OK button to close the dialog box and saves the conflict resolving options.

Cancel Button

Click the Cancel button to close the dialog box and discard all changes.

See Also

Rename Options
Other Options, Preferences, and Status

 XE "Options Dialog " \* MERGEFORMAT 

 XE "Dialogs " \* MERGEFORMAT Options Dialog

Use the Options dialog to configure some general options for the workstation. To display the Options dialog, choose Tools -> Options from the Main Menu.
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The following fields are on the Options dialog:

Show Warning Message when Delete Job Check box

Select this check box to display a warning message whenever a print job is deleted.

Show Warning Message when Delete Page Check box

Select this check box to display a warning message whenever a page is deleted.

Show Warning Message when Move Page from Job to another Job Check box

Select this check box to display a warning message when moving pages among the print jobs.

Show E-mail result message Check box

Select this check box to display an E-mail result message whenever sending email. The message indicates whether the email was sent successfully or whether it failed.

Show Status Dialog Check box

Select this check box to display the Status dialog whenever running a task.

Show Status Dialog Details Check box

Select this check box to display the Status dialog whenever running a task. The Status dialog provides details about the tasks, their progress, and any errors that occur.

Keep Status dialog Visible Check box

Select this check box to keep the Status Dialog active after the task has ended.

Default Button

Click the Default button to restore the default options. All the check boxes will be selected.

OK Button

Click the OK button to close the dialog and save the changes to the Options settings.

Cancel Button

Click the Cancel button to close the dialog and discard the changes to the Options settings.

 XE "Document Preparing Status Dialog " \* MERGEFORMAT 

 XE "Dialogs " \* MERGEFORMAT Document Preparing Status Dialog

The Document Preparing Status dialog appears whenever a multi-page file is opened. It counts the number of pages that have been received (that are being opened).

To cancel the opening of the multi-page file, press the Esc key.
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Miscellaneous

 XE "Dialogs " \* MERGEFORMAT 

 XE "About ePrint Dialog " \* MERGEFORMAT About ePrint Dialog

Use the About ePrint dialog to show the product name, version number copyright information, and Product ID.

To display the About ePrint dialog, from the main menu, choose Help -> About ePrint.

 XE "Dialogs " \* MERGEFORMAT 

 XE "Add Auto Text Dialog " \* MERGEFORMAT Add Auto Text Dialog

Use the Add Auto Text dialog to add automatic text that is used frequently to a stationery type.

The text is automatically generated depending on which variables are used, such as page number, date or time, etc. This eliminates the need to specify individual headers, footers, or watermarks for each page.

To display the Add Auto Text dialog, from the Stationery Editor Mode pane, choose the expand button [image: image364.png]


 for the Text field of the Header, Footer, or Watermark sections.
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The following fields are on the Add Auto Text dialog:

Auto Text Edit box

Use this edit box to create the template for the body of the automatic text to be inserted into the stationery. You can include tags like Job Name, Job Data, Job Time, etc. anywhere in the body of the auto text.

Job Date Button

Click the Job Date button to include a tag that prints the date in the Auto Text edit box.

Job Time Button

Click the Job Time button to include a tag that prints the time of printing in the Auto Text edit box.

Page Number Button

Click the Page Number button to include a tag that prints the page number in the Auto Text edit box.

The page number will be changed for each page.

Job Name Button

Click the Job Name button to include a tag that prints the job name in the Auto Text edit box.

User Name Button

Click the User Name button to include a tag that prints the user name in the Auto Text edit box.

Computer Button

Click the Computer button to include a tag that prints the computer name in the Auto Text edit box.

OK Button

Click the OK button to close the dialog and add the auto text to the stationery.

Cancel Button

Click the Cancel button to close the dialog without adding the auto text to the stationery.

 XE "Forms " \* MERGEFORMAT 

 XE "Dialogs " \* MERGEFORMAT 

 XE "Add Form Dialog " \* MERGEFORMAT Add Form Dialog

Use the Add Form dialog to enter the name of a form being added to the Forms list. To display the Add Form dialog, load a document containing the page that will be converted into a form into the LEADTOOLS ePrint 5 workstation. After the document has loaded, open the Thumbnail Pane and right-click the thumbnail of the page to be converted to a form. In the context menu that appears, select the Add to Forms option, which opens the Add Form dialog. The Add Form dialog is shown in the following figure:
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The following fields are on the Add Form dialog:

Name of the new form Edit box:

Use this edit box to enter the name for the new form.

OK Button

Click the OK button to close the dialog and save the changes.

Cancel Button

Click the Cancel button to close the dialog and discard all changes.

See Also

Stationery Editor Mode Pane
Form Selection Dialog
 XE "Stationery " \* MERGEFORMAT 

 XE "Dialogs " \* MERGEFORMAT 

 XE "Add Stationery Dialog " \* MERGEFORMAT Add Stationery Dialog

Use the Add Stationery dialog to add a new stationery type to the Stationery listing. To display the Add Stationery dialog, from the Stationery Editor Mode pane, click the Add button. The Add Stationery dialog is shown in the following figure:
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The following fields are on the Add Stationery dialog:

New name for the Stationery Edit box:

Use this edit box to enter the name for the new stationery type.

OK Button

Click the OK button to close the dialog and save the changes.

Cancel Button

Click the Cancel button to close the dialog and discard all changes.

See Also

Stationery Editor Mode Pane
 XE "Stationery " \* MERGEFORMAT 

 XE "Form " \* MERGEFORMAT 

 XE "Dialogs " \* MERGEFORMAT 

 XE "Apply To Custom Dialog " \* MERGEFORMAT Apply To Custom Dialog

Use the Apply To Custom dialog to specify which pages will have a form or stationery type applied to them.

To display the Apply To Custom dialog, from the:
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Stationery Editor Mode pane, choose Custom in the Apply To drop down list box.
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Stationery Selection dialog, choose Custom in the Apply To drop down list box.
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Form Selection dialog, choose Custom in the Apply To drop down list box.
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The following fields are on the Apply To Custom dialog:

Apply to Radio button

Select the Apply To radio button to apply a stationery type or form to the specified pages.

Exclude from Radio button

Select the Exclude From radio button to apply a stationery type or form to all pages except the pages listed for exclusion.

Custom Pages Numbers Edit box

Use this edit box to list the specific page numbers to be used by the Apply To and the Exclude From radio buttons. If multiple pages are to be listed, separate the numbers by commas (e.g. 1,3,7, 18, 63).

OK Button

Click the OK button to close the dialog and apply the selected stationery type or form.

Cancel Button

Click the Cancel button to close the dialog and discard all changes.

See Also

Stationery Editor Mode Pane
Stationery Selection Dialog
Form Selection Dialog
 XE "Dialogs " \* MERGEFORMAT 

 XE "Confirm User/Owner Password Dialog " \* MERGEFORMAT Confirm User/Owner Password Dialog

Use the Confirm User/Owner Password dialog to verify the owner and user password for the PDF documents if the passwords have been assigned. Only passwords that have been entered will be prompted for confirmation. The passwords must match the entries from the PDF Save As Options Dialog -> Security Tab.

To display the Confirm User/Owner Password dialog from the PDF Save As Options Dialog -> Security Tab, click the OK button with the Protect Document check box selected and a password entered in either or both of the User Password and Owner Password textboxes. This dialog will appear once for each password and that has been entered.
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The following fields are on the Confirm User/Owner Password dialog:

Password Edit box

Use this option to enter the owner or the user password for confirmation.

OK Button

Click the OK button to close the dialog box.

ePrint will attempt to match the password with the password(s) entered in the PDF Save As Options Dialog -> Security Tab. If the confirmation password matches, the PDF Options dialog closes and saves the changes. If the confirmation does not match, the user will be prompted with an error message.

Cancel Button

Use the Cancel button to close the dialog box and the passwords will not be confirmed.

See Also

PDF Save As Options Dialog
 XE "Dialogs " \* MERGEFORMAT 

 XE "Custom Paper Dialog " \* MERGEFORMAT Custom Paper Dialog

Use the Custom Paper dialog to customize the dimensions of new user-defined papers.

To display the Custom Paper dialog, from the ePrint Task Printer Creation Wizard -> Paper Options Page, click on Add or Edit button.
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The following fields are on the Custom Paper dialog:

Paper Name Edit box

Use this option to enter the name of the new paper.

Paper Width Edit box

Use this option to enter the paper width.

Paper Length Edit box

Use this option to enter the paper height.

Dimensions in inches Radio button

Select this radio button to measure the paper width and height in inches.

Dimensions in millimeters Radio button

Select this radio button to measure the paper width and height in millimeters.

Default Button

Click the Default button to set the options in the dialog to the default values.

OK Button

Click the OK button to close the dialog box and add the new paper.

Cancel Button

Click the Cancel button to close the dialog box without adding the new paper.

See Also

ePrint Task Printer Creation Wizard
 XE "Zooming " \* MERGEFORMAT 

 XE "Dialogs " \* MERGEFORMAT 

 XE "Custom Zoom Dialog " \* MERGEFORMAT Custom Zoom Dialog

Use the Custom Zoom dialog to specify the zoom value.

To display the Custom Zoom dialog, from the main menu, choose View -> Zoom -> Custom Zoom…
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The following fields are on the Custom Zoom dialog:

Custom Zoom Radio button

Select this radio button to display the Custom Zoom edit box to specify the magnification for the documents being viewed.

Custom Zoom Edit box

Enter the amount of zoom, in percentage, in this edit box to adjust the magnification to a custom size. Possible values range from 10 through 500.

This option is only available if the Custom Zoom radio button is selected.

Fit To Page Width Radio button

Select this radio button to fit the selected page width to the workstation display.

Fit To Whole Page Radio button

Select this radio button to fit the entire selected page to the workstation display.

Normal - 100% Radio button

Select this radio button to set the zoom factor as 100% for all pages.

200% Radio button

Select this radio button to set the zoom factor as 200% for all pages.

150% Radio button

Select this radio button to set the zoom factor as 150% for all pages.

75% Radio button

Select this radio button to set the zoom factor as 75% for all pages.

50% Radio button

Select this radio button to set the zoom factor as 50% for all pages.

OK Button

Click the OK button to close the dialog and adjust the zoom value.

Close Button

Click the Close button to close the dialog without changing the zoom value.

 XE "Empty Page " \* MERGEFORMAT 

 XE "Dialogs " \* MERGEFORMAT Empty Page Dialog

Use the Empty Page dialog to add an empty page.

To display the Empty Page dialog from the main menu, choose File -> New.
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The following fields are on the Empty Page dialog:

Width Edit box

Use this option to determine the width of the empty page. Dimensions unit can be determined using the Dimensions drop-down list box.

Height Edit box

Use this option to determine the height of the empty page. Dimensions unit can be determined using the Dimensions drop-down list box.

Dimensions in Drop-down list box

Use this option to determine the dimensions unit of measurement. It contains the following options:

Inch

mm (millimeters)

pixel

XResolution Edit box

Use this option to determine the X resolution of the empty page. X resolution and Y resolution should be the same. (This is the pixels inch resolution).

The value of this option is reflected to the value of YResolution edit box.

YResolution Edit box

Use this option to determine the Y resolution of the empty page. X resolution and Y resolution should be the same. (This is the pixels/inch resolution).

The value of this option is reflected to the value of XResolution edit box.

OK Button

Click the OK button to close the dialog and create an empty page with the specified dimensions and resolutions.

Cancel Button

Click the Cancel button to close the dialog and cancel creating an empty page.

 XE "Form Selection Dialog " \* MERGEFORMAT 

 XE "Form " \* MERGEFORMAT 

 XE "Dialogs " \* MERGEFORMAT Form Selection Dialog

Use the Form Selection dialog to select a form to apply for the workstation jobs and pages.

To display the Form Selection dialog, from the main menu, choose Edit-> Select Form. A form in ePrint, is an image (EMF) based watermark simulation and will appear behind the document contents much like pre-printed stationery or forms in traditional printing applications. Keep in mind that forms appear behind text and images placed in the document. Content in the form may be covered by images with a similar background color to the background color of the document (e.g., images with a white background on a white piece of paper will hide form behind their white background), in ways that may appear counter-intuitive to the eye. The form will not, however, have a marginal overlap from text or the transparent area of an image placed in a document.
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The following fields are on the Form Selection dialog:

Form Name Drop-down list box

Use this option to select the form to be applied.

Only one form can be applied to the overall printing job.

Apply To Drop-down list box:

Use this option to specify which pages to apply the form image. It contains the following options:
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All: This option applies the form to all pages.
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Odd: This option applies the form to the odd pages only.
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Even: This option applies the form to even pages only.
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First: This option applies the form to the first page only.
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Last: This option applies form the form to the last page only.
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Custom: Opens the Apply To Custom dialog box.

This option is only available if a form is selected in the Form Name drop-down list box.

Rename Button

Click the Rename button to open the Rename Form Dialog dialog to rename a specific form.

This option is only available if a form is selected in the Form Name drop-down list box.

Delete Button

Click the Delete button to delete a specific form.

This option is only available if a form is selected in the Form Name drop-down list box.

Preview

This option displays the form.

OK Button

Click the OK button to close the dialog and save the changes. This will apply the form selection to your document on the specified pages.

Cancel Button

Click the Cancel button to close the dialog and discard all changes.

 XE "Go To Dialog " \* MERGEFORMAT 

 XE "Dialogs " \* MERGEFORMAT Go To Dialog

Use the Go To dialog to move to a specific page in document or to a specific position in a job.

To display the Go To dialog, from the main menu, choose Edit -> Go To… or press the Ctrl+G key.
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The following fields are on the Go To dialog:

Page Number Radio button

Select this radio button to make the Page Number edit box accessible for browsing the document by page number.

Page Number Edit box

Use this option to enter the page number to display.

This option is only available if the Page Number radio button is selected.

Beginning of current Print Job Radio button

Select this radio button to move to the beginning of current print job.

End of current Print Job Radio button

Select this radio button to move to the end of current print job.

First Page Radio button

Select this radio button to move to the first page in the current loaded document.

Last Page Radio button

Select this radio button to move to the last page in current loaded document.

Go To Button

Click the Go To button to move to the selected page and make it the current active page.

Close Button

Click the Close button to close the dialog without any movement.

 XE "Rename Form Dialog " \* MERGEFORMAT 

 XE "Forms " \* MERGEFORMAT 

 XE "Dialogs " \* MERGEFORMAT Rename Form Dialog

Use the Rename Form dialog to rename forms. To display the Rename Form dialog, from the Form Selection dialog select a form from the list and click Rename. The Rename Form dialog is shown in the following figure:
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The following fields are on the Rename Form dialog:

New name of the form Edit box:

Use this edit box to enter the new name for the form being renamed.

OK Button

Click the OK button to close the dialog and save the changes.

Cancel Button

Click the Cancel button to close the dialog, and discard all changes.

See Also

Stationery Editor Mode Pane
Form Selection Dialog
 XE "Stationery " \* MERGEFORMAT 

 XE "Rename Stationery Dialog " \* MERGEFORMAT 

 XE "Dialogs " \* MERGEFORMAT Rename Stationery Dialog

Use the Rename Stationery dialog to rename a stationery type. To display the Rename Stationery dialog, from the Stationery Editor Mode pane, select a stationery type from the Stationeries drop-down list box and click Rename. The Rename Stationery dialog is shown in the following figure:
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The following fields are on the Rename Stationery dialog:

New name for the stationery Edit box:

Use this edit box to enter the new name for the stationery being renamed.

OK Button

Click the OK button to close the dialog and save the changes.

Cancel Button

Click the Cancel button to close the dialog and discard all changes.

See Also

Stationery Editor Mode Pane
 XE "Stationery Selection Dialog " \* MERGEFORMAT 

 XE "Stationery " \* MERGEFORMAT 

 XE "Dialogs " \* MERGEFORMAT Stationery Selection Dialog

Use the Stationery Selection dialog to insert a specific stationery already added and/or modified using the stationery editing mode. Stationery is a text based watermark simulation and will appear behind the document contents much like pre-printed stationery in traditional printing applications. Keep in mind that stationery appears behind text and images placed in the document. Content in the stationery may be covered by images with a similar background color to the background color of the document (e.g., images with a white background on a white piece of paper will hide stationery behind their white background), in ways that may appear counter-intuitive to the eye. The stationery will not, however, have a marginal overlap from text or the transparent area of an image placed in a document.

To display the Stationery Selection dialog from the main menu, choose Edi> Set -lect Stationery. 
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The following fields are on the Stationery Selection dialog:

Stationery Name Drop-down list box

Shows the name of the pending stationery to be applied and displayed in the preview section. The list contains the following options:
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None: Selects nothing or removes the currently selected stationery.
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Draft: Sets the stationery to mark documents with a "Draft" watermark.
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New: Opens the Add Stationery Dialog dialog to add a new stationery name.

Stationery that has been added will also appear in this list by name.

Apply To Drop-down list box:

Use this option to choose which pages will have the stationery applied. It contains the following options:
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All: The stationery will be added to all included pages. The stationery will not be added to the excluded pages.
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Odd: The stationery will be added to the odd pages only. The stationery will not be added to the excluded pages.
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Even: The stationery will be added to the even pages only. This enumeration does not count pages that have been excluded from the print job. The stationery will not be added to the excluded pages.
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First: The stationery will be added to the first included page only. If the first page in the print job has been excluded from the print job, then the first included page will be applicable to have stationery added.
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Last: The stationery will be added to the last included page only. If the last page in the print job has been excluded from the print job, then the last included page will be applicable to have stationery added.
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Custom…: Opens the Apply To Custom dialog box.

Edit Button

Click this button to open the Stationery Editing Mode pane to edit the currently selected stationery.

Preview

This option displays the stationery.

OK Button

Click the OK button to save the selection to LEADTOOLS ePrint 5 Workstation. This will either create a new stationery or replace the previously selected stationery.

Cancel Button

Click the Cancel button to close the dialog and discard the selection.

See Also

Stationery Editing Mode Pane
 XE "Thumbnails " \* MERGEFORMAT 

 XE "Thumbnail Options Dialog " \* MERGEFORMAT 

 XE "Dialogs " \* MERGEFORMAT Thumbnail Options Dialog

Use the Thumbnail Options dialog to set the specifications for thumbnails saved with images.

To display the Thumbnail Options dialog, from the Raster Images Files Save As Options Dialog, click the Thumbnail Options button. This button is only available if the image format supports thumbnails and the Save with Thumbnail check box is selected.
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The following fields are on the Thumbnail Options dialog:

8-bit Radio button

Select this radio button to save a thumbnail with 8-bit color depth.

24-bit Radio button

Select this radio button to save a thumbnail with 24-bit color depth.

Thumbnail Width Edit box

Use this option to enter the width of the thumbnail you want to save in pixels.

Thumbnail Height Edit box

Use this option to enter the height of the thumbnail you want to save in pixels.

Default Button

Click the Default button to restore the options in the dialog to their default values.

OK Button

Click the OK button to close the dialog box and save the thumbnail options.

Cancel Button

Click the Cancel button to close the dialog box and discard all changes.

See Also

Raster Images Files Save As Options Dialog
File Formats

 XE "True color " \* MERGEFORMAT 

 XE "Summary of All Supported Image File Formats " \* MERGEFORMAT 

 XE "Raster image formats " \* MERGEFORMAT 

 XE "High color " \* MERGEFORMAT 

 XE "Grayscale " \* MERGEFORMAT 

 XE "Formats " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT 

 XE "Black and white images " \* MERGEFORMAT 

 XE "Bitonal images " \* MERGEFORMAT 

 XE "8-bit images " \* MERGEFORMAT 

 XE "4-bit images " \* MERGEFORMAT 

 XE "32K color images " \* MERGEFORMAT 

 XE "32-bit images " \* MERGEFORMAT 

 XE "256-color images " \* MERGEFORMAT 

 XE "24-bit images " \* MERGEFORMAT 

 XE "2-color images " \* MERGEFORMAT 

 XE "16M color images " \* MERGEFORMAT 

 XE "16-color images " \* MERGEFORMAT 

 XE "16-bit images " \* MERGEFORMAT 

 XE "1-bit images " \* MERGEFORMAT Summary of All Supported Image File Formats

Raster - Colored and Grayscale

BMP Formats
CAL – CALS Raster Format
Cineon Format (CIN)
DICOM Format (DIC)
Dr. Halo (CUT)
Encapsulated PostScript (EPS)
Exif Formats (TIFF and JPG)
FITS (FIT)
Flic Animation (FLC)
Compuserve GIF
Interchange File Formats (IFF)
JBIG Format (JBG)
JPEG and LEAD Compressed (JPG, J2K, JP2, CMP, and CMW)
Kodak Formats (FPX) 
Macintosh Pict Format (PCT)
Microsoft Windows Clipboard (CLP)
Paint Shop Pro Formats (PSP)
PCX Formats (PCX and DCX)
PhotoShop 3.0 Format (PSD)
Portable Bitmap Utilities (PBM)
Portable Document Format (PDF)
Portable Network Graphics Format (PNG)
Scitex Continuous Tone Format
Silicon Graphics Image Format (SGI)
SUN Raster Format (RAS)
TIFF Without LZW Compression
Truevision TARGA Format (TGA)
WordPerfect Format (WPG)
X WindowDump (XWD)
XPicMap (XPM)
Raster - Bitonal (1-Bit)

Intergraph Format (ITG)
Image Object Content Architecture Format (IOCA/MODCA)
LEAD 1-Bit Format (CMP)
Miscellaneous 1-Bit Formats (MAC, IMG, and MSP)
TIFF CCITT and Other FAX Formats
SMP Format (SMP)
Wireless Bitmap Format (WBMP)
XBitMap Format (XBM)
Vector

Computer Graphics Metafile (CGM)
DRaWing (DRW)
Drawing Interchange Format (DXF)
DWF Format (DWF)
ESRI Shape Format (SHP)
Gerber Format (GBR)
Vector Dump Format
PLT (PLT)
Printer Command Language Format (PCL)
Scalable Vector Graphics Format (SVG)
Windows Metafile Formats (WMF and EMF)
WordPerfect Format (VWPG)
Document

Portable Document Format (PDF) 

Microsoft Word 97 Format (DOC)
Rich Text Format (RTF)
Hyper Text Markup Language (HTML)
ASCII Text format
 XE "TIFF File Formats " \* MERGEFORMAT 

 XE "PDF File Format " \* MERGEFORMAT 

 XE "PCX " \* MERGEFORMAT 

 XE "Multipage File Formats " \* MERGEFORMAT 

 XE "MPT " \* MERGEFORMAT 

 XE "MODCA " \* MERGEFORMAT 

 XE "IOCA " \* MERGEFORMAT 

 XE "IFF " \* MERGEFORMAT 

 XE "GIF " \* MERGEFORMAT 

 XE "FLC " \* MERGEFORMAT 

 XE "DICOM " \* MERGEFORMAT 

 XE "DCX " \* MERGEFORMAT 

 XE "CALS " \* MERGEFORMAT 

 XE "Animated Gif " \* MERGEFORMAT Multipage File Formats

LEADTOOLS ePrint 5 Professional supports the following file formats, which support multipage files. These formats are:

FlashPix
FLC
GIF
IOCA/MODCA
PDF
Tiff(MPT)
Raster

 XE "Windows Bitmap " \* MERGEFORMAT 

 XE "OS/2 format " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT 

 XE "BMP " \* MERGEFORMAT BMP Formats

LEADTOOLS ePrint 5 Professional saves the following BMP formats:
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Windows Bitmap (BMP). This is a file format created by Microsoft. Some BMP images are compressed with an RLE-type compression.
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OS/2 Bitmap (OS/2 BMP). These are files created on an OS/2 operating system. LEADTOOLS ePrint 5 Professional supports both 1.x and 2.x formats.

 XE "Kodak file format " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT 

 XE "Cineon format " \* MERGEFORMAT 

 XE "CIN " \* MERGEFORMAT Cineon Format (CIN)

KODAK Cineon Format (CIN) files are raster format files created by Kodak and supported by XnView and PixEdit. They are designed to better represent film imagery in a digital format. Cineon files store data in a 10-bit logarithmic scale. Therefore, each color component has a range of 0 to 1023. LEADTOOLS ePrint 5 Professional supports version 4.5 of this format.

The default extension used by this format is: CIN.

 XE "File formats " \* MERGEFORMAT 

 XE "DICOM Format " \* MERGEFORMAT DICOM Format (DIC)

DICOM (DIC) files are commonly used in medical images. LEADTOOLS ePrint 5 Professional saves DICOM files in the LEADTOOLS ePrint 5 Professional -supported bits-per-pixel. DICOM files can contain many comment fields of various types. You can save DICOM files as 8, 12, or 16-bit grayscale, 8-bit palletized color, or 24-bit RGB color (8 bits per plane).

Related Formats:

EXIF - Exif Formats
JPG - JPEG Compressed
TIFF - Tagged Image File Format.

 XE "File formats " \* MERGEFORMAT 

 XE "CUT " \* MERGEFORMAT Dr Halo (CUT)

Dr. Halo files are device-independent images. The image is stored in one file (.CUT) and the palette is stored in a separate file (PAL). If the image has no corresponding .PAL file, it is considered a grayscale image.

For CUT files, you can save the following bits per pixel: 8.

 XE "PostScript " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT 

 XE "EPS " \* MERGEFORMAT 

 XE "Encapsulated PostScript format " \* MERGEFORMAT Encapsulated PostScript (EPS)

PostScript Raster (Encapsulated PostScript). These files are used primarily on PostScript printers. These printers usually offer more variety of fonts and higher resolution than standard laser printers. EPS files will work on any PostScript compatible printer and any end-user application that supports placement of EPS files in its work space.

The image that you save to an EPS file is always a PostScript raster image.

You can save only an 8-bits PostScript raster image, which is grayscale.

Related Formats:

PCL - Printer Command Language Format
PDF - Portable Document Format
PLT - PLT / HPGL Format
 XE "TIFF File Formats " \* MERGEFORMAT 

 XE "JPG " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT 

 XE "Exif " \* MERGEFORMAT Exif Formats (TIFF and JPG)

Exif is a standard for image files created with digital cameras and other input devices. The standard is set by the Japan Electronic Industry Development Association, and formally it is called the Digital Still Camera Image File Format Standard.
Exif files contain either uncompressed TIFF images or compressed JPEG images. In addition, these files can contain many comment fields of various types.

LEADTOOLS ePrint 5 Professional saves the following Exif formats:
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TIFF. This is a tag-based file format designed to promote universal interchanges of digital image data. You can save any image size.
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JPG. This is the JPEG format with YUV 4:2:2 sampling. You can save any image size.

An Exif JPG file can also contain a stamp (thumbnail) image, which is a small copy of the main image. The stamp size has been restricted to 160x120x24. That limitation has been imposed in order to conform with the ExifR98 interoperability rules imposed by Japanese digital camera manufacturers. 

If you are working with uncompressed (TIFF) Exif files, the stamp size is (width x height x 24 bpp), with no limitations on width and height.

Related Formats:

JPG - JPEG Compressed
TIFF - Tagged Image File Format
 XE "Flexible Image Transport System " \* MERGEFORMAT 

 XE "FITS " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT FITS Format (FIT)

FITS, the Flexible Image Transport System, is the standard astron data format endorsed by NASA and the IAU. It is a raster format designed to store scientific data sets, which consist of multi-dimensional arrays and 2-dimensional tables. The FITS format was developed by NASA and is supported by XnView and fv Desktop Manager. The default extensions used by this format are: FIT, FTS and FITS.

The file format supports multi-page files.

 XE "Flic Animation " \* MERGEFORMAT 

 XE "FLC " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT Flic Animation (FLC)

The Flic file is an animation file created by Auto-desk. This file supports image data but not audio data.

The frames of this file can be of 8bpp image data. The maximum number of frames is 4000.

The FLC file supports up to 64k X 64k images with 256 colors per image.

LEADTOOLS ePrint 5 Professional supports saving multi-page files in this format.

Related Formats:

GIF - Compuserve GIF Format.

 XE "TIFF LZW file format " \* MERGEFORMAT 

 XE "multi-pages file " \* MERGEFORMAT 

 XE "Graphics Interchange Format " \* MERGEFORMAT 

 XE "GIF " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT Compuserve GIF
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GIF. This is the Graphics Interchange Format created by CompuServe for storing and exchanging color raster images.

These files are LZW compressed.

Related Formats:

FLC - Flic Animation Format
PNG - Portable Network Graphics Format.

 XE "Interchange Format " \* MERGEFORMAT 

 XE "IFF " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT Interchange File Format (IFF)

IFF (Amiga Interchange) is a general-purpose data storage format (raster), developed by Electronic Arts, Inc. and Commodore-Amiga, Inc. that can associate and store multiple types of data. It is used by ACD FotoCanvas Lite 2.0 and XnView applications.

IFF saves RLE, and non-compressed images. IFF CAT supports multi-page files.

The default extension for this format is: IFF.

 XE "JBIG " \* MERGEFORMAT 

 XE "JBG " \* MERGEFORMAT 

 XE "Interchange Format " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT JBIG Format (JBG)

JBIG (JBG) is an industry standard lossless compressed file format for bi-tonal (black and white), grayscale and color images. LEAD’s JBIG support is comprehensive and handles the various flavors and bits per pixel as defined by the specification including progressive, where you can store and send multiple representations of images at different resolutions without any extra storage overhead. In order to achieve highest compression ratios available by the JBIG format, LEADTOOLS ePrint 5 Professional also takes full advantage of all the functional blocks of this robust standard including the Adaptive Arithmetic Encoder, the Adaptive Template Block, the Typical Prediction Block, the Resolution Reduction Block, and the Deterministic Prediction Block. Saving images in a JBIG format results in smaller image files sizes when compared to other industry standard compressed formats such as CCITT G3 or G4. 

 XE "LEAD Wavelet CMW files " \* MERGEFORMAT 

 XE "LEAD format " \* MERGEFORMAT 

 XE "JTIF " \* MERGEFORMAT 

 XE "JPG " \* MERGEFORMAT 

 XE "JPEG compression " \* MERGEFORMAT 

 XE "JPEG and LEAD Compressed " \* MERGEFORMAT 

 XE "JPEG 2000 " \* MERGEFORMAT 

 XE "JPEG " \* MERGEFORMAT 

 XE "JP2 " \* MERGEFORMAT 

 XE "JFIF " \* MERGEFORMAT 

 XE "J2K " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT 

 XE "CMW " \* MERGEFORMAT 

 XE "CMP " \* MERGEFORMAT JPEG and LEAD Compressed (JPG, J2K, JP2, CMP, and CMW)

LEADTOOLS ePrint 5 Professional saves the following LEAD and JPEG compressed formats:
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LEAD. This is the LEAD CMP compressed format for grayscale and color images. This format results in smaller files and better image quality than industry-standard formats. In addition, LEAD also supports CMW files, which use Wavelet CMP compression in 8, 12, and 16-bit grayscale and 24-bit color.
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Progressive LEAD. This is a LEAD format that is useful for transmitting images, because the first part of the file contains the full dimensions of the image. In this format you can save 8 or 24 bits per pixel, where 8 is for grayscale and 24 is for color.
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Lossy JFIF. This is the JPEG File Interchange Format. LEADTOOLS ePrint 5 Professional supports YUV 4:4:4, 4:2:2, and 4:1:1 color spacing, and YUV 4:0:0 for grayscale.
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Lossless JFIF. This is the JPEG File Interchange Format. LEADTOOLS ePrint 5 Professional supports 8, 12, and 16-bit grayscale and 24-bit color spacing. Please note that not all applications support Lossless JPEG. Before saving a file using Lossless JPEG, make sure your reader supports it.

Both JPEG 4:4:4 and Lossless JPEG will be recognized when getting file information.
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Progressive JPEG. This is a JFIF format that is useful for transmitting images, because the first part of the file contains the full dimensions of the image. LEADTOOLS ePrint 5 Professional supports YUV 4:4:4, 4:2:2, and 4:1:1 color spacing, and YUV 4:0:0 for grayscale.
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Lossy JTIF. This is the JPEG Tagged Interchange Format. LEADTOOLS ePrint 5 Professional supports YUV 4:4:4, 4:2:2, and 4:1:1 color spacing, and YUV 4:0:0 for grayscale.
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Lossless JTIF. This is the JPEG Tagged Interchange Format. LEADTOOLS ePrint 5 Professional supports 8, 12, and 16-bit grayscale and 24-bit color spacing. Please note that not all applications support Lossless JPEG. Before saving a file using Lossless JPEG, make sure your reader supports it.

Both TIFF JPEG 4:4:4 and Lossless JPEG will be recognized when getting file information.
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J2K – Lossy or Lossless. This is a JPEG 2000 Format. LEADTOOLS ePrint 5 Professional can save 8 - 16-bit grayscale and 24, 27, 30, 33, 36, 39, 42, 45 and 48--bit color images. The J2K format contains only a stream of image data
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JP2 – Lossy or Lossless. This is a JPEG 2000 Format. LEADTOOLS ePrint 5 Professional can save 8 - 16-bit grayscale and 24, 27, 30, 33, 36, 39, 42, 45 and 48--bit color images. The JP2 format contains a stream of image data, plus extra data about the organization and contents of the file.

[image: image411.png]


TIF J2K – Lossy or Lossless. This is a Tagged Image File with JPEG 2000 Compression. This file format contains only a stream of image data. LEADTOOLS ePrint 5 Professional supports 8, 12, and 16-bit grayscale and 24-bit color spacing.

Related Formats:

EXIF - Exif Formats
FPX - Kodak Format
TIFF - Tagged Image File Format.

 XE "multi-pages file " \* MERGEFORMAT 

 XE "Kodak " \* MERGEFORMAT 

 XE "FPX " \* MERGEFORMAT 

 XE "FlashPix " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT Kodak Formats (FPX)

LEADTOOLS ePrint 5 Professional supports the following Kodak formats:
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FlashPix (FPX). The FlashPix file format was developed through the combined efforts of Eastman Kodak Company, Microsoft Corporation, Hewlett-Packard Company, and Live Picture Inc. It combines the best features of existing formats with object orientation to make the use of digital color images easier. 

The format of a FlashPix file is based on compound object storage, which allows storage of various kinds of data. A FlashPix file may consist of several "pages" where each "page" has storage for a source image, non-image data in the form of comments, transform data, and a stamp or thumbnail. Each image is stored as an entire multi-resolution hierarchy where each resolution in the hierarchy differs from the next highest resolution by a factor of 2 in the x dimension and in the y dimension. Non-image data are treated as comments in FlashPix file format. Comments are used to store information pertaining to the image, not actual pixel data. This information may include image title, image subject, camera manufacturer, scan software version number, and so forth. In addition to the image itself, FlashPix files store transform information. This data indicates transformations which may be performed on the source image. By storing the transforms, the source image may be stored in its original state and transformed, using the stored transforms, at your discretion. A stamp, or thumbnail, provides a small bitmap representation of a FlashPix image. 

Related Formats:

EXIF - Exif Formats
 XE "PCT " \* MERGEFORMAT 

 XE "Macintosh Pict Format " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT Macintosh Pict Format (PCT)

Macintosh Pict (PCT) files are produced using Macintosh QuickDraw, and are used in desktop publishing and imaging applications.

When PCT files are rasterized, they are 24 BPP.

The following table indicates which objects LEADTOOLS ePrint 5 Professional can save:

	Object:
	Save:

	Arc
	Supported

	Background
	Supported

	Ellipse
	Not Supported

	Foreground
	Supported

	Lines
	Supported

	Point
	Supported

	Polygons
	Not Supported

	Rectangle
	Not Supported

	Text
	Supported


Related Formats: 

CGM - Computer Graphics Metafile, DRW - Micrografx Designer DRaWing, DWF - DWF Format, DXF - Drawing Interchange Format, EMF - Windows Metafile Formats, GBR - Gerber Format, PCL - Printer Command Language Format, PDF - Portable Document Format, PLT - PLT / HPGL Format, SHP - ESRI Shape Format, SVG - Scalable Vector Graphics Format, VEC - Vector Dump Format, WPG - WordPerfect Vector Format, WMF - Windows Metafile Formats
 XE "Microsoft Windows Clipboard " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT 

 XE "CLP " \* MERGEFORMAT Microsoft Windows Clipboard (CLP)

CLP stands for Microsoft Windows Clipboard. This file format is used to store the contents of the clipboard to disk. The clipboard is an area of memory shared by the Windows operating system, and it is a simple mechanism for exchanging data between applications.

 XE "PSP " \* MERGEFORMAT 

 XE "Paint Shop Pro Format " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT Paint Shop Pro Format (PSP)

PSP is a raster format created by JASC Software. It supports uncompressed, RLE compressed, LZ77 compressed, and JPEG compressed files (including Lossless JPEG). LEADTOOLS ePrint 5 Professional supports all these compression types. LEADTOOLS ePrint 5 Professional supports versions 5, 6 and 7 of this format. Version 7 supports the Vector Shapes layer, which LEADTOOLS ePrint 5 Professional views as raster.

For PSP files, you can save the following bits per pixel: 1 (gray), 4 (gray), 8 (gray or color), 24 (color). With this compression type only (uncompressed, RLE compressed, and JPEG compressed files (including Lossless JPEG).

The default extension used by this format is: PSP.

This file format does support layers.

 XE "PCX " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT 

 XE "DCX " \* MERGEFORMAT PCX Formats (PCX and DCX)

LEADTOOLS ePrint 5 Professional saves the following PCX formats:
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PCX. This is a file format created by ZSoft. This format compresses its image data with the RLE type compression.
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DCX. This is a multi-page PCX format that enables a file to contain more than one image. It is handled the same as a regular PCX file, except for the multi-page feature.

For PCX and DCX files, you can save the following bits per pixel: 1, 4, 8, 24.

 XE "PSD " \* MERGEFORMAT 

 XE "PhotoShop 3.0 Format " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT PhotoShop 3.0 Format (PSD)

Photoshop 3.0 (PSD) is the format produced by the Adobe Photoshop graphics editor.

LEADTOOLS ePrint 5 Professional supports RLE Compression for this file format.

You can also save layers to this file with the following bits per pixel: 8 (GrayScale), 24, and 32.

 XE "Portable Bitmap Utilities " \* MERGEFORMAT 

 XE "PBM " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT Portable Bitmap Utilities (PBM)

The Portable Bitmap Utilities consists of Portable Greymap Utilities (PGM), Portable Pixmap Utilities (PPM), and Portable Anymap Utilities (PNM). Their source is the UNIX environment.

Related Formats:

BMP - Windows Bitmap Formats.

 XE "Portable Document Format " \* MERGEFORMAT 

 XE "PDF File Format " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT Portable Document Format (PDF)

Portable Document Format (PDF). PDF was developed by the Adobe Corporation to allow the exchange and viewing of electronic documents easily and reliably, independent of the environment in which they were created. This format lets you compress large documents to a size small enough to download very quickly. It is also becoming a powerful format for reproducing documents over the web.

PDF file can contain raster or document format.

Special notes for the PDF Raster Format

LEADTOOLS ePrint 5 Professional supports versions 1.2, 1.3 and 1.4 of this format. LEADTOOLS ePrint 5 Professional also supports saving multi-page files in this format.

This filter can save PDF files that are JPEG, LZW, CCITT G1 1D, CCITT G3 2D, or CCITT G4 compressed, or uncompressed. In addition, this filter supports JBIG2 compressed PDF files. 

(Note that not all flavors of JBIG2 decompression are supported.)

Related Formats:

PCL - Printer Command Language Format
PLT - PLT / HPGL Format
 XE "Portable Network Graphics Format " \* MERGEFORMAT 

 XE "PNG " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT Portable Network Graphics Format (PNG)

PNG (Portable Network Graphics) is a replacement for the GIF format. It is a full-featured (non-LZW) compressed format intended for widespread use without legal restraints.

You can save the following bits per pixel: 1, 4, 8, 24, 32.

Related Formats:

GIF - Compuserve GIF Format
JPG - JPEG Compressed.

 XE "SCT " \* MERGEFORMAT 

 XE "Scitex Continuous Tone Format " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT Scitex Continuous Tone Format (SCT)

The Scitex Continuous Tone file format was developed by Scitex and is used for high-end image processing. The SCT/CT files are used primarily to store CMY and CMYK color space for the image. For saving the SCT file format, LEADTOOLS ePrint 5 Professional saves it as CMY instead of CMYK. This maintains the image quality, since the conversion from RGB to CMYK will result in some loss of data.

The default extensions used by this format are: SCT and CT.

 XE "Silicon Graphics Image Format " \* MERGEFORMAT 

 XE "SGI " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT Silicon Graphics Image Format (SGI)

The SGI file format was developed at Silicon Graphics, and is used for black and white, gray-scale and color images. LEADTOOLS ePrint 5 Professional supports both uncompressed SGI and RLE compressed SGI.

 XE "SUN Raster Format " \* MERGEFORMAT 

 XE "RAS " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT SUN Raster Format (RAS)

SUN Raster (RAS) is a format native to Sun UNIX platforms.

 XE "TIFF File Formats " \* MERGEFORMAT 

 XE "Tagged Image File Format " \* MERGEFORMAT 

 XE "multi-pages file " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT Tagged Image File Format (TIFF)

TIFF is a tag-based file format designed to promote universal interchanges of digital image data. Because TIFF files do not have a single way to store image data, there are many versions of TIFF. LEADTOOLS ePrint 5 Professional supports the most common TIFF formats. The usual file extension is TIFF for single-image files, and MPT for multi-page files (which can contain many images). TIFF files can contain many comment fields of various types.

LEADTOOLS ePrint 5 Professional also supports the ability to save a vector image as a DXF within a TIFF.

LEADTOOLS ePrint 5 Professional supports saving multi-page files in this format.

LEADTOOLS ePrint 5 Professional can save TIFF files that use RGB, CMYK, or YCbCr color space. LEADTOOLS ePrint 5 Professional can also save files with PackBits compression.

LEADTOOLS ePrint 5 Professional can also save files with Lossless JPEG compression for 8, 12, and 16-bit grayscale and 24-bit color spacing.

You can save 12- bits grayscale.

You can save 16- bits grayscale.

Related Formats:

CMP - LEAD Compressed
CMP - LEAD 1-Bit Format
EXIF - Exif Formats
JPG - JPEG Compressed
JP2 - JPEG 2000 Compressed
TIFX - Xerox Internet Fax File Format.

 XE "Truevision TARGA Format " \* MERGEFORMAT 

 XE "TGA " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT Truevision TARGA Format (TGA)

Truevision TGA (TARGA) is a file format created by Truevision Inc. LEADTOOLS ePrint 5 Professional supports all uncompressed and RLE compressed TGA file formats.

 XE "WPG " \* MERGEFORMAT 

 XE "WordPerfect Graphics Format " \* MERGEFORMAT 

 XE "VWPG " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT WordPerfect Graphics Format (WPG and VWPG)

The WordPerfect (WPG) format can contain vectored or raster images. LEADTOOLS ePrint 5 Professional handles both the raster images and the vector images.

Special notes for the Vector Images:

VWPG (Vector Word Perfect Graphics) is a vector format created by COREL. There are two versions (version1 and version2) of the VWPG file format. Each has its own format and specifications. LEADTOOLS ePrint 5 Professional supports only version2 of this format. This file format is supported by COREL DRAW 8.0.

The default extension used by this format is: WPG.

This file format does support layers and embedded raster objects, but not grouping.

LEADTOOLS ePrint 5 Professional can save the following objects: Line, Polyline, Rect, Polygon, Ellipse, Circle, Arc, Elliptical arc, Pie, Chord, Text, Polydraw, Polybezier, and Image.

When vector WPG files are rasterized, they are 24 BPP.

Related Formats: 

CGM - Computer Graphics Metafile, DRW - Micrografx Designer DRaWing, DWF - DWF Format, DXF - Drawing Interchange Format, EMF - Windows Metafile Formats, GBR - Gerber Format, PCL - Printer Command Language Format, PCT - Macintosh Pict Format, PDF - Portable Document Format, PLT - PLT / HPGL Format, SHP - ESRI Shape Format, SVG - Scalable Vector Graphics Format, VEC - Vector Dump Format, WMF - Windows Metafile Formats
 XE "XWD " \* MERGEFORMAT 

 XE "X Window Dump " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT X Window Dump (XWD)

XWD stands for X Window dump. This file format is used to store and restore screen window images. Two versions of this file exist, the X10 window dump and the X11 window dump. These versions differ slightly in the format of the data (i.e. headers and bits per pixel).

The version X10 XWD file cannot have more than 8 BPP image data.

 XE "XPM " \* MERGEFORMAT 

 XE "XPicMap Format " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT XPicMap Format (XPM)

XPM files are used to store X Window PixMap information to disk. They are capable of storing black-and-white, grayscale, and color images. XPM stores image data in the form of ASCII text formatted as a standard C character string array.

Bitonal (1-bit)

 XE "ITG " \* MERGEFORMAT 

 XE "IntergraphRLE " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT IntergraphRLE (ITG)

Intergraph is a monochrome bitmap format developed by Intergraph. LEADTOOLS ePrint 5 Professional supports the RLE and CIT versions of this file format.

The default extensions used by this format are: ITG and CIT.

This file format does not support stamps or Lossless JPEG compression. For this file format, LEADTOOLS ePrint 5 Professional supports CCITT G4 and RLE compression. 

Currently LEADTOOLS ePrint 5 Professional saves the ITG and CIT format.

 XE "MODCA " \* MERGEFORMAT 

 XE "IOCA " \* MERGEFORMAT 

 XE "Image Object Content Architecture Format " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT Image Object Content Architecture Format (IOCA/MODCA)

The Image Object Content Architecture format was developed by IBM. This architecture provides a consistent way to represent images, including conventions and directions for processing and interchanging image information. LEADTOOLS ePrint 5 Professional supports single and multi-page files in a MO:DCA wrapper with embedded 1-bit CCITT, Group 3 or Group 4 images, IBM MMR and uncompressed IOCA. LEADTOOLS ePrint 5 Professional also supports IOCA files without the MO:DCA wrapper. LEADTOOLS ePrint 5 Professional saves all these formats.

The default extension used by this format is: ICA.

This file format does not support stamps or Lossless JPEG compression, but it does support multi-page files. For this file format, LEADTOOLS ePrint 5 Professional supports CCITT, G3(1D, 2D), CCIT G4, and IBM MMR compression. LEADTOOLS ePrint 5 Professional does not support RL4, and Color Compression used by OS/2.

LEADTOOLS ePrint 5 Professional supports saving multi-page files in this format.

 

Related Formats: CAL - CALS Raster Format, FAX - Raw Fax Format, TIFF - Tagged Image File Format, CCITT
 XE "LEAD 1-Bit Format " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT 

 XE "CMP " \* MERGEFORMAT LEAD 1-Bit Format (CMP)

LEAD 1BIT is a proprietary 1-bit LEAD compressed format that has better compression and performance than CCITT G4.

 

Related Formats: FAX - Raw Fax Format, TIFF - Tagged Image File Format, CCITT.

 XE "MSP " \* MERGEFORMAT 

 XE "Microsoft Paint " \* MERGEFORMAT 

 XE "MacPaint " \* MERGEFORMAT 

 XE "MAC " \* MERGEFORMAT 

 XE "IMG " \* MERGEFORMAT 

 XE "GEM Image " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT Miscellaneous 1-Bit Formats (MAC, IMG, and MSP)

LEADTOOLS ePrint 5 Professional supports writing of the following 1-bit formats:
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MacPaint (MAC). These Macintosh Paint files are commonly used for monochrome clip art.
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GEM Image (IMG). These files are native to the Graphical Environment Manager developed by Digital Research.
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Microsoft Paint (MSP). These files from early versions of Windows are used for black-and-white drawings and clip art.

 XE "WinFax " \* MERGEFORMAT 

 XE "TIFF File Formats " \* MERGEFORMAT 

 XE "multi-pages file " \* MERGEFORMAT 

 XE "IOCA " \* MERGEFORMAT 

 XE "ICA " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT 

 XE "FAX transmission " \* MERGEFORMAT 

 XE "FAX Group 4 " \* MERGEFORMAT 

 XE "FAX Group 3 " \* MERGEFORMAT 

 XE "FAX " \* MERGEFORMAT 

 XE "CCITT Group 4 " \* MERGEFORMAT 

 XE "CCITT Group 3 2D " \* MERGEFORMAT 

 XE "CCITT Group 3 1D " \* MERGEFORMAT 

 XE "CCITT " \* MERGEFORMAT 

 XE "AWD " \* MERGEFORMAT TIFF CCITT and Other FAX Formats

LEADTOOLS ePrint 5 Professional supports writing of the following 1-bit formats that is commonly used in FAX transmissions:

TIFF
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TIFF CCITT. These are compressed TIFF files that are commonly used for FAX transmission and document imaging.
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TIFF CCITT Group 3. These are TIFF CCITT files in a format that is more advanced and more compressed than TIFF CCITT. LEADTOOLS ePrint 5 Professional supports both 1-dimension and 2-dimension variations of this format.
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TIFF CCITT Group 4. These are TIFF CCITT files in a format that is more advanced and more compressed than TIFF CCITT Group 3.

For more information refer to TIFF - Tagged Image File Format.

CALS
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CALS Raster (Type 1, 2, 3, and 4). These are CCITT Group 4 CALS raster files. CALS is a United States government standard. CALS3 are multi-page files.

IOCA
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IOCA (ICA). This is the Image Object Content Architecture developed by IBM. LEADTOOLS ePrint 5 Professional supports these files in an MO:DCA wrapper with embedded 1-bit CCITT Group 3 or Group 4 images. LEADTOOLS ePrint 5 Professional also supports IOCA files without an MO:DCA wrapper.

For more information refer to Image Object Content Architecture Format (IOCA/MODCA).

WinFax
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WinFax Group 3. This is a FAX format created by Delrina for Group 3 support.
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WinFax Group 4. This is a FAX format created by Delrina for Group 4 support.

Raw FAX
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FAX Group 3. This is a raw FAX format (without a header) for Group 3 support. LEADTOOLS ePrint 5 Professional supports both 1-dimension and 2-dimension variations of this format.
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FAX Group 4. This is a raw FAX format (without a header) for Group 4 support.

Related Formats: TIFF - Tagged Image File Format.

Microsoft Fax
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AWD. This is a Microsoft FAX format.

TIFF-FX
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TIFF-FX. These are Internet Fax files developed and used by Xerox. This format supports several types of compression, which allows the user or developer to use the compression that best suits his or her needs. In addition, this file format can be extended as the need arises. The following modes are supported:
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Minimal Black and White: This mode uses binary MH compression (T.4).
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Extended Black and White: This mode uses binary MH, MR and MMR compression (T.4 and T.6).
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Lossless JBIG Black and White: This mode uses JBIG compression (T.85, T.82).

[image: image432.png]


Lossy Color and Grayscale: This mode uses JPEG compression (T.42, T.81).
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Lossless Color and Grayscale: This mode uses JBIG compression (T.43, T.82).

The default extensions used by this format is: TIFX, TIFF.

This file format does support multi-page files.

 

Related Formats: TIFF - Tagged Image File Format.

 XE "SMP " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT SMP Format (SMP)

The SMP file contains a 1-bit raster bitmap. It may be uncompressed, compressed using CCITT Group 3 or compressed using CCITT Group 4. LEADTOOLS ePrint 5 Professional supports saving for all these types.

The default extension is .SMP.

This format was created by Xionics and is used in PixEdit for Techsoft.

 XE "Wireless Bitmap Format " \* MERGEFORMAT 

 XE "WBMP " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT Wireless Bitmap Format (WBMP)

The Wireless Bitmap file format is a 1-bit format used to send graphical information to a variety of handsets. It is terminal independent and describes only graphical information.

 XE "XBM " \* MERGEFORMAT 

 XE "XBitMap " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT XBitMap (XBM)

XBM is a monochrome bitmap format in which data is stored as a C language data array. It is primarily used for the storage of cursor and icon bitmaps, for use in the X graphical user interface.

 

Related Formats: BMP - Windows Bitmap Formats.

Vector

 XE "File formats " \* MERGEFORMAT 

 XE "Computer Graphics Metafile " \* MERGEFORMAT 

 XE "CGM " \* MERGEFORMAT Computer Graphics Metafile (CGM)

Computer Graphics Metafile is a format used for the exchange of vector and bitmap data. This file format is supported by Autovue and Corel. LEADTOOLS ePrint 5 Professional supports versions 1, 2, 3 and 4 of CGM, as well as the Binary data-encoding format of CGM. 

The following table indicates which objects LEADTOOLS ePrint 5 Professional can save:

	Object:
	Save:

	Circle
	Not Supported

	Circular Arc Center
	Not Supported

	Ellipse
	Supported

	Elliptical Arc
	Not Supported

	Font
	Supported

	Lines
	Supported

	PolyBezier
	Not Supported

	Polygons
	Supported

	Polyline
	Supported

	Rectangle
	Supported

	Text
	Supported


This file format does not support layers.
When CGM files are rasterized, they are 24 BPP.

 

Related Formats: DRW - Micrografx Designer DRaWing, DWF - DWF Format, DXF - Drawing Interchange Format, EMF - Windows Metafile Formats, GBR - Gerber Format, PCL - Printer Command Language Format, PCT - Macintosh Pict Format, PDF - Portable Document Format, PLT - PLT / HPGL Format, SHP - ESRI Shape Format, SVG - Scalable Vector Graphics Format, VEC - Vector Dump Format, WPG - WordPerfect Vector Format, WMF - Windows Metafile Formats
 XE "File formats " \* MERGEFORMAT 

 XE "DRW File Format " \* MERGEFORMAT DRaWing (DRW)

DRW (DRaWing) is a native format used in the popular Micrografx Designer CAD/CAM/CAE application for the Windows operating system. 

LEADTOOLS ePrint 5 Professional supports versions 1, 2, 3, 4 and 5 of the DRW file format.

When DRW files are rasterized, they are 24 BPP. 

The following table indicates which objects LEADTOOLS ePrint 5 Professional can save:

	Object:
	Save:

	Arc
	Not Supported

	Lines
	Supported

	Pie
	Not Supported

	Point
	Supported

	PolyDraw
	Supported

	Polygons
	Supported

	Polyline
	Supported

	Raster
	Not Supported

	Text
	Supported


 

Related Formats: CGM - Computer Graphics Metafile, DWF - DWF Format, DXF - Drawing Interchange Format, EMF - Windows Metafile Formats, GBR - Gerber Format, PCL - Printer Command Language Format, PCT - Macintosh Pict Format, PDF - Portable Document Format, PLT - PLT / HPGL Format, SHP - ESRI Shape Format, SVG - Scalable Vector Graphics Format, VEC - Vector Dump Format, WPG - WordPerfect Vector Format, WMF - Windows Metafile Formats
 XE "File formats " \* MERGEFORMAT 

 XE "DXF " \* MERGEFORMAT Drawing Interchange Format (DXF)

DXF (Drawing Interchange Format) was first introduced by AutoDesk AutoCAD, and is one of the most widely used CAD/CAM/CAE applications in the world. DXF is very popular and is supported by most 3D formats on PC platforms.

A DXF file is an ASCII file containing 2D and 3D components representing a drawing. Those components are known as Entities. The DXF file can represent almost any CAD drawing using those entities, and can connect a group of entities together (such as windows, doors, etc.) and use them later in the file. The DXF file has seen many changes through the years, from version 2.6 to the latest release version 14. However, the latest release of AutoCAD still manages to open files created with any of the earlier versions. 

LEADTOOLS ePrint 5 Professional supports all current variations of the DXF format (versions 2.6, 9, 10, 11, 12, 13, 14).

Users can save a DXF file to any of file formats supported by LEADTOOLS ePrint 5 Professional. 

When DXF files are rasterized, they are 24 BPP. 

The following table indicates which objects LEADTOOLS ePrint 5 Professional can save:

	Object:
	Save:

	Arc
	Supported

	Attdef
	Not Supported

	Attrib
	Not Supported

	Circle
	Supported

	Clone
	Supported

	Ellipse
	Supported

	Elliptical Arc
	Not Supported

	Insert
	Not Supported

	Leader
	Not Supported

	Lines
	Supported

	Mtext
	Supported

	Polygons
	Supported

	PolyLine
	Supported

	Raster
	Not Supported

	Solid
	Not Supported

	Spline
	Not Supported

	Text
	Supported

	Tolerance
	Not Supported

	Vertex
	Supported

	WpolyLine
	Not Supported

	3Dface
	Not Supported


 

Related Formats: CGM - Computer Graphics Metafile, DRW - Micrografx Designer DRaWing, DWF - DWF Format, EMF - Windows Metafile Formats, GBR - Gerber Format, PCL - Printer Command Language Format, PCT - Macintosh Pict Format, PDF - Portable Document Format, PLT - PLT / HPGL Format, SHP - ESRI Shape Format, SVG - Scalable Vector Graphics Format, VEC - Vector Dump Format, WPG - WordPerfect Vector Format, WMF - Windows Metafile Formats
 XE "File formats " \* MERGEFORMAT 

 XE "DWF " \* MERGEFORMAT DWF Format (DWF)

DWF is a binary file format used by AutoDesk AutoCAD for storing DWG files on the World Wide 

Web. DWF is a 2D, vector-based description of drawings and illustrations. 

LEADTOOLS ePrint 5 Professional supports DWF versions .4, .5, .55 and .6. 

When DWF files are rasterized, they are 24 BPP.

The following table indicates which objects LEADTOOLS ePrint 5 Professional can save:

	Object:
	Save:

	Arc
	Not Supported

	Attdef
	Not Supported

	Attrib
	Not Supported

	BoundaryPolydraw
	Not Supported

	Circle
	Supported

	Dimension
	Not Supported

	Ellipse
	Supported

	Hatch
	Not Supported

	Insert
	Not Supported

	Leader
	Not Supported

	Lines
	Supported

	Mline
	Not Supported

	Mtext
	Not Supported

	Polygons
	Not Supported

	Polyline
	Supported

	PureLine
	Not Supported

	PurePolygon
	Not Supported

	PurePolyline
	Not Supported

	Segment
	Not Supported

	Spline
	Not Supported

	Text
	Supported

	Vertex
	Not Supported

	Wpolyline
	Not Supported

	3Dface
	Not Supported

	3Dsolid
	Not Supported


LEADTOOLS ePrint 5 Professional also supports text and embedded raster objects.

 

Related Formats: CGM - Computer Graphics Metafile, DRW - Micrografx Designer DRaWing, DXF - Drawing Interchange Format, EMF - Windows Metafile Formats, GBR - Gerber Format, PCL - Printer Command Language Format, PCT - Macintosh Pict Format, PDF - Portable Document Format, PLT - PLT / HPGL Format, SHP - ESRI Shape Format, SVG - Scalable Vector Graphics Format, VEC - Vector Dump Format, WPG - WordPerfect Vector Format, WMF - Windows Metafile Formats
 XE "SHP " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT 

 XE "ESRI Shape Format " \* MERGEFORMAT ESRI Shape Format (SHP)

The ESRI Shape format is a vector format created by the Environmental System Research Institute. The SHP file can support point, multi-point, polygon, polyline and multi-patches. This file format has a much faster drawing speed and more editing capabilities than other data sources. It is supported by the ARC Explorer 2.0 and ARCView.

This file format contains three files:

Main file: *.shp

Index file: *.shx

DBase file: *.dbf

This file format does not support layers, grouping objects or embedded raster objects. 

When SHP files are rasterized, they are 24 BPP. 

The following table indicates which objects LEADTOOLS ePrint 5 Professional can save:

	Object:
	Save:

	PolyDraw
	Not Supported

	Polyline
	Supported

	Vertex
	Not Supported


 

Related Formats: CGM - Computer Graphics Metafile, DRW - Micrografx Designer DRaWing, DWF - DWF Format, DXF - Drawing Interchange Format, EMF - Windows Metafile Formats, GBR - Gerber Format, PCL - Printer Command Language Format, PCT - Macintosh Pict Format, PDF - Portable Document Format, PLT - PLT / HPGL Format, SVG - Scalable Vector Graphics Format, VEC - Vector Dump Format, WPG - WordPerfect Vector Format, WMF - Windows Metafile Formats
 XE "Gerber Format " \* MERGEFORMAT 

 XE "GBR " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT Gerber Format (GBR)

The Gerber file format is a vector – based format used by GerbTools, ViewMate and CamTastic as a simple way of transferring printed circuit board information to a wide variety of devices. The Extended Gerber Format (RS-274X) handles information for defining shapes and sizes of lines and other features. This format supports Polygons, Circles, Ovals, Outlines, Arcs, Lines, Rectangles, Moire and Thermal.

The default extension used by this format is: GBR.

This file format does support layers.

The following table indicates which objects LEADTOOLS ePrint 5 Professional can save:

	Object:
	Save:

	Arc
	Supported

	Chord
	Supported

	Circle
	Supported

	Lines
	Supported

	Polygons
	Supported

	Rectangle
	Not Supported


 

Related Formats: CGM - Computer Graphics Metafile, DRW - Micrografx Designer DRaWing, DWF - DWF Format, DXF - Drawing Interchange Format, EMF - Windows Metafile Formats, PCL - Printer Command Language Format, PCT - Macintosh Pict Format, PDF - Portable Document Format, PLT - PLT / HPGL Format, SHP - ESRI Shape Format, SVG - Scalable Vector Graphics Format, VEC - Vector Dump Format, WPG - WordPerfect Vector Format, WMF - Windows Metafile Formats
 XE "Vector Dump Format " \* MERGEFORMAT 

 XE "VEC " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT Vector Dump Format (VEC)

The main advantage of using this format is the speed of writing and the capability of maintaining all the details of the vector data. It can be used to save the status of the vector toolkit, which can provide undo and redo capabilities.

Two versions of this format exist, version 12 and version 13. LEADTOOLS ePrint 5 Professional will maintain compatibility between different versions.

This format supports layers, grouping of objects and embedded raster objects.

The default extension used by this format is: VEC.

When VEC files are rasterized, they are 24 BPP.

The following table indicates which objects LEADTOOLS ePrint 5 Professional can save:

	Object:
	Save:

	Arc
	Supported

	Chord
	Supported

	Circle
	Supported

	Clone
	Supported

	Ellipse
	Supported

	Elliptical Arc
	Supported

	HPolyBezier
	Supported

	Lines
	Supported

	Pie
	Supported

	PolyDraw
	Supported

	Polygons
	Supported

	Polyline
	Supported

	Raster
	Supported

	Rectangle
	Supported

	Spline
	Supported

	Text
	Supported

	Vertex
	Supported


 

Related Formats: CGM - Computer Graphics Metafile, DRW - Micrografx Designer DRaWing, DWF - DWF Format, DXF - Drawing Interchange Format, EMF - Windows Metafile Formats, GBR - Gerber Format, PCL - Printer Command Language Format, PCT - Macintosh Pict Format, PDF - Portable Document Format, PLT - PLT / HPGL Format, SHP - ESRI Shape Format, SVG - Scalable Vector Graphics Format, WPG - WordPerfect Vector Format, WMF - Windows Metafile Formats
 XE "PLT " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT PLT (PLT)

PLT (also HPGL) is the standard language for printing line drawings created by Hewlett-Packard. HPGL is supported by many CAD programs, charting programs and word processors.

LEADTOOLS ePrint 5 Professional supports HPGL and HPGL/2. 

When PLT files are rasterized, they are 4 BPP.

The following table indicates which objects LEADTOOLS ePrint 5 Professional can save:

	Object:
	Save:

	Arc
	Supported

	Circle
	Supported

	Lines
	Supported

	Pie
	Supported

	PolyDraw
	Not Supported

	Polygons
	Not Supported

	Polyline
	Not Supported

	Rectangle
	Supported

	Text
	Not Supported


 

Related Formats: CGM - Computer Graphics Metafile, DRW - Micrografx Designer DRaWing, DWF - DWF Format, DXF - Drawing Interchange Format, EMF - Windows Metafile Formats, GBR - Gerber Format, PCL - Printer Command Language Format, PCT - Macintosh Pict Format, PDF - Portable Document Format, SHP - ESRI Shape Format, SVG - Scalable Vector Graphics Format, VEC - Vector Dump Format, WPG - WordPerfect Vector Format, WMF - Windows Metafile Formats
 XE "Printer Command Language Format " \* MERGEFORMAT 

 XE "PCL " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT Printer Command Language Format (PCL)

The Printer Command Language vector format was developed by Hewlett-Packard, specifically to provide a means of communication between computers and printers. The PCL files contain the commands and the HP printers parse and decode those commands. This format also includes HPGL. For more information about HPGL, refer to PLT.

LEADTOOLS ePrint 5 Professional supports version 3.0 and 5.0 of this file format.

The default extensions used by this format are: PRN, PRT and PCL.

This format is used by Visual PCL, PCLTOOLS, redtitan EscapE and AutoVue.

This file format does not support layers or grouping, but it does support embedded raster objects.

PCL filter supports many features such as:

Support for Raster, text and rectangular area.

Support for Macros.

Enhanced performance of the filter.

Support for HPGL mode in PCL

Raster fonts

RTL Raster data

Support for all compression methods (RLE, TIFF, Delta, Adaptive and Unencoded).

Support for old versions of PCL v.3, besides v.5.

Viewing PJL with POSTSCRIPT data (requires the PDF filter)

Support for user-defined and pre-defined patterns

Support for Unicode symbols

Detecting non-standard PCL/HPGL files that lack a correct header

When PCL files are rasterized, they are 24 BPP.
When PLT files are rasterized, they are 4 BPP.

The following table indicates which objects LEADTOOLS ePrint 5 Professional can save:

	Object:
	Save:

	Arc
	Supported

	Circle
	Supported

	Lines
	Supported

	Pie
	Supported

	Point
	Supported

	PolyBezier
	Not Supported

	PolyDraw
	Not Supported

	Polygons
	Not Supported

	Polyline
	Not Supported

	Raster
	Supported

	Rectangle
	Supported

	Text
	Supported


 

Related Formats: CGM - Computer Graphics Metafile, DRW - Micrografx Designer DRaWing, DWF - DWF Format, DXF - Drawing Interchange Format, EMF - Windows Metafile Formats, GBR - Gerber Format, PCT - Macintosh Pict Format, PDF - Portable Document Format, PLT - PLT / HPGL Format, SHP - ESRI Shape Format, SVG - Scalable Vector Graphics Format, VEC - Vector Dump Format, WPG - WordPerfect Vector Format, WMF - Windows Metafile Formats
 XE "XML " \* MERGEFORMAT 

 XE "SVG " \* MERGEFORMAT 

 XE "Scalable Vector Graphics Format " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT Scalable Vector Graphics Format (SVG)

The Scalable Vector Graphics file format is an Internet standard vector format for describing two-dimensional graphics in XML. SVG supports vector graphic shapes, images, and text. For more information about this format please refer to the World Wide Web Consortium (W3C) website http://www.w3c.org.

The default extension used by this format is: SVG.

This file format is supported by Adobe SVG Viewer, CorelDraw! 10.0, JASC WebDraw and Apache Batik SVG browser.

This file format does not support layers, but it will save embedded raster objects. 

When saving SVG files, the images are stored externally and a reference to the image(s) is added to the file.

When SVG files are rasterized, they are 24 BPP.

The following table indicates which objects LEADTOOLS ePrint 5 Professional can save:

	Object:
	Save:

	Rectangle
	Supported

	Circle
	Supported

	Ellipse
	Supported

	Lines
	Supported

	Polyline
	Supported

	Polygons
	Supported

	PolyDraw
	Supported

	Raster
	Supported

	Vertex
	Supported

	PolyBezier
	Supported

	Spline
	Supported

	HPolyBezier
	Supported

	Text
	Supported

	Filling,Stroking, and Marker
	Supported

	Gradients and Patterns
	Not Supported

	Color
	Supported

	Clipping, Masking, and Compositing
	Not Supported

	Filter Effects
	Not Supported

	Interactivity
	Not Supported

	Linking
	Not Supported

	Animation
	Not Supported

	Fonts
	Supported


 

Related Formats: CGM - Computer Graphics Metafile, DRW - Micrografx Designer DRaWing, DWF - DWF Format, DXF - Drawing Interchange Format, EMF - Windows Metafile Formats, GBR - Gerber Format, PCL - Printer Command Language Format, PCT - Macintosh Pict Format, PDF - Portable Document Format, SHP - ESRI Shape Format, VEC - Vector Dump Format, WPG - WordPerfect Vector Format, WMF - Windows Metafile Formats
 XE "WMF " \* MERGEFORMAT 

 XE "Windows Metafile Formats " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT 

 XE "EMF " \* MERGEFORMAT Windows Metafile Formats (WMF and EMF)

The Windows Metafile (WMF and EMF) formats are vector formats that may or may not also contain a raster image. 

EMF/WMF Vector files can be written as raster images in the non-vector toolkits.

When WMF and EMF files are rasterized, they are either 8 or 24 BPP.

The following table indicates which objects LEADTOOLS ePrint 5 Professional can save:

	Object:
	Save:

	Arc
	Supported

	Background color and mode
	Supported

	Chord
	Supported

	Circle
	Supported

	Color
	Supported

	Ellipse
	Supported

	HPolyBezier
	Supported

	Lines
	Supported

	Pie
	Supported

	PolyBezier
	Supported

	PolyDraw
	Supported

	Polygons
	Supported

	Polyline
	Supported

	Raster
	Supported

	Rectangle
	Supported

	Round Rectangle
	Restricted Support

	Spline
	Supported

	Text
	Supported

	Text(Color and Font Type)
	Supported

	Vertex
	Supported


 

Related Formats: CGM - Computer Graphics Metafile, DRW - Micrografx Designer DRaWing, DWF - DWF Format, DXF - Drawing Interchange Format, EMF - Windows Metafile Formats, GBR - Gerber Format, PCL - Printer Command Language Format, PCT - Macintosh Pict Format, PDF - Portable Document Format, PLT - PLT / HPGL Format, SHP - ESRI Shape Format, SVG - Scalable Vector Graphics Format, VEC - Vector Dump Format, WPG - WordPerfect Vector Format
 XE "WPG " \* MERGEFORMAT 

 XE "WordPerfect Graphics Format " \* MERGEFORMAT 

 XE "VWPG " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT WordPerfect Graphics Format (WPG and VWPG)

The WordPerfect (WPG) format can contain vectored or raster images. LEADTOOLS ePrint 5 Professional handles both the raster images and the vector images.

Special notes for the Vector Images:

VWPG (Vector Word Perfect Graphics) is a vector format created by COREL. There are two versions (version1 and version2) of the VWPG file format. Each has its own format and specifications. LEADTOOLS ePrint 5 Professional supports only version2 of this format. This file format is supported by COREL DRAW 8.0.

The default extension used by this format is: WPG.

This file format does support layers and embedded raster objects, but not grouping.

LEADTOOLS ePrint 5 Professional can save the following objects: Line, Polyline, Rect, Polygon, Ellipse, Circle, Arc, Elliptical arc, Pie, Chord, Text, Polydraw, Polybezier, and Image.

When vector WPG files are rasterized, they are 24 BPP.

Related Formats: 

CGM - Computer Graphics Metafile, DRW - Micrografx Designer DRaWing, DWF - DWF Format, DXF - Drawing Interchange Format, EMF - Windows Metafile Formats, GBR - Gerber Format, PCL - Printer Command Language Format, PCT - Macintosh Pict Format, PDF - Portable Document Format, PLT - PLT / HPGL Format, SHP - ESRI Shape Format, SVG - Scalable Vector Graphics Format, VEC - Vector Dump Format, WMF - Windows Metafile Formats
Document

 XE "Portable Document Format " \* MERGEFORMAT 

 XE "PDF File Format " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT Portable Document Format (PDF)

Portable Document Format (PDF). PDF was developed by the Adobe Corporation to allow the exchange and viewing of electronic documents easily and reliably, independent of the environment in which they were created. This format lets you compress large documents to a size small enough to download very quickly. It is also becoming a powerful format for reproducing documents over the web.

PDF file can contain raster or document format.

Special notes for the PDF Raster Format

LEADTOOLS ePrint 5 Professional supports versions 1.2, 1.3 and 1.4 of this format. LEADTOOLS ePrint 5 Professional also supports saving multi-page files in this format.

This filter can save PDF files that are JPEG, LZW, CCITT G1 1D, CCITT G3 2D, or CCITT G4 compressed, or uncompressed. In addition, this filter supports JBIG2 compressed PDF files. 

(Note that not all flavors of JBIG2 decompression are supported.)

Related Formats:

PCL - Printer Command Language Format
PLT - PLT / HPGL Format
 XE "Word File Format " \* MERGEFORMAT 

 XE "MS Word File Format " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT 

 XE "Document file format " \* MERGEFORMAT 

 XE "DOC File Format " \* MERGEFORMAT MS Word Format (DOC)

MS Word Format (DOC). DOC is the file format written by MS Word ®; Features supported in the Word documents include text formatting with full support for fonts, colors, and styles. The doc save also supports images, shapes and drawings, including all the vector primitives.

This format is widely used and provides the user with a flexibility needed to convert almost any type of file into an MS-Word document.

The version, which LEADTOOLS ePrint 5 Professional is supporting now, is the MS-WORD 97 format.

LEADTOOLS ePrint 5 Professional saves two types of MS Word documents: Framed-text and enhanced-text documents.

	Note:
	LEADTOOLS ePrint 5 Professional supports Unicode. It also supports URL detection, and allows the user to specify document information like Title, Author, Subject, Manager and company


 XE "RTF File Format " \* MERGEFORMAT 

 XE "Rich Text Format " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT 

 XE "Document file format " \* MERGEFORMAT Rich Text Format (RTF)

The Rich Text Format (RTF) specification is a method of encoding formatted text and graphics for easy transfer between applications. Currently, users depend on special translation software to move word-processing documents between different MS-DOS®, Windows, OS/2, Macintosh, and Power Macintosh applications.

RTF uses the ANSI, PC-8, Macintosh, or IBM PC character set to control the representation and formatting of a document, both on the screen and in print. With the RTF Specification, documents created under different operating systems and with different software applications can be transferred between those operating systems and applications.

LEADTOOLS ePrint 5 Professional saves two types of RTF documents: Framed-text and enhanced-text documents.

	Note:
	LEADTOOLS ePrint 5 Professional supports Unicode. It also supports URL detection, and allows the user to specify document information like Title, Author, Subject, Manager and company


 XE "Hyper Text Markup Language Format " \* MERGEFORMAT 

 XE "HTML File Format " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT 

 XE "Document file format " \* MERGEFORMAT Hyper Text Markup Language Format (HTML)

The HTML file format is used to create web pages on the Internet. The files of this format are small and can be downloaded easily. The problem with this format is that the major web browsers (Internet Explorer, Netscape, Opera. etc. ) have different support for the language and they have some extensions made specially for them. This means that a document may be viewed differently from one browser to another. 

LEADTOOLS ePrint 5 Professional produces three types of HTML files which are compatible with the most commonly used browsers (IE 5.0 +, Netscape 4.6 and Netscape 6.0+). The HTML documents which are compatible with IE 5.0+ use the Microsoft VML(Vector Markup Language) to draw vector objects. Netscape on the other hand doesn’t support VML, so Java script is used instead to produce the same result. The documents which are produced to be compatible with IE 5.0+ and Netscape use both VML and Java script

	Note:
	LEADTOOLS ePrint 5 Professional supports Unicode. It also supports URL detection, and allows the user to specify document information like Title, Author, Subject, Manager and company


 XE "UNICODE " \* MERGEFORMAT 

 XE "TXT " \* MERGEFORMAT 

 XE "File formats " \* MERGEFORMAT 

 XE "Document file format " \* MERGEFORMAT 

 XE "ASCII Text Format " \* MERGEFORMAT 

 XE "ASCII " \* MERGEFORMAT 

 XE "ANSI " \* MERGEFORMAT ASCII Text format (TXT)

The Text format supports strings only, i.e, no vector objects or images are supported. Saving any document to this format will maintain text strings and positioning only, without any formatting.

TXT format supports ANSI, UNICODE, and UNICODE Big endian text subtypes.

Appendix

 XE "Word to .pdf conversion " \* MERGEFORMAT 

 XE "TIFF to PDF " \* MERGEFORMAT 

 XE "TIFF conversion " \* MERGEFORMAT 

 XE "Text to PDF " \* MERGEFORMAT 

 XE "RTF to PDF " \* MERGEFORMAT 

 XE "RTF converter " \* MERGEFORMAT 

 XE "PPT to PDF " \* MERGEFORMAT 

 XE "Powerpoint to PDF " \* MERGEFORMAT 

 XE "PDF to TIFF " \* MERGEFORMAT 

 XE "PDF to JPG " \* MERGEFORMAT 

 XE "PDF to JPEG " \* MERGEFORMAT 

 XE "pdf printer " \* MERGEFORMAT 

 XE "pdf creator " \* MERGEFORMAT 

 XE "PDF converter " \* MERGEFORMAT 

 XE "MS DOC file conversion " \* MERGEFORMAT 

 XE "Limitations When Printing to Vector and Document File Formats " \* MERGEFORMAT 

 XE "image conversion " \* MERGEFORMAT 

 XE "html to Word " \* MERGEFORMAT 

 XE "HTML to DOC " \* MERGEFORMAT 

 XE "File conversion " \* MERGEFORMAT 

 XE "DRW conversion " \* MERGEFORMAT 

 XE "DOC converter " \* MERGEFORMAT 

 XE "Converting files " \* MERGEFORMAT 

 XE "Adobe writer " \* MERGEFORMAT 

 XE "Adobe converter " \* MERGEFORMAT 

 XE ".txt to .pdf " \* MERGEFORMAT 

 XE ".tif to .pdf " \* MERGEFORMAT 

 XE ".rtf to .pdf " \* MERGEFORMAT 

 XE ".ppt to .pdf " \* MERGEFORMAT 

 XE ".pdf converter " \* MERGEFORMAT 

 XE ".html to Word " \* MERGEFORMAT 

 XE ".html to .doc " \* MERGEFORMAT 

 XE ".doc converter " \* MERGEFORMAT Limitations When Printing to Vector and Document File Formats

When printing from your application to a vector or document file format, only certain types of objects can be put into each of the various vector and/or document files.

For example, suppose your application is printing a page, which looks like this: 

[image: image434.png]



When printing to a CGM file, which supports text and shape objects, but does not support raster objects, the output will appear like this: 

[image: image435.png]



See the table below for a list of which objects are supported for each format.

Document Formats:

	Format
	Raster
	Shapes
	Text
	Notes

	MS Word
	Supported
	Supported
	Supported
	

	PDF
	Supported
	Supported
	Supported
	Raster operations on drawings are not supported.

	Rich Text Format (RTF)
	Supported
	Supported
	Supported
	

	ASCII (Text)
	Not supported
	Not supported
	Supported
	Shapes and raster objects are not supported. Positioning for text is not supported by the format, enhancing algorithms were used.

	HTML
	Supported
	Supported
	Supported
	VML should be supported in IE to view the document shapes correctly. Filled shapes lose the filling when the document is viewed on Netscape.


Vector Formats:

	Format
	Raster
	Shapes
	Text
	Notes

	VEC
	Supported
	Supported
	Supported
	

	DWF
	Not supported
	Supported
	Supported
	Filling is not supported, - format restriction.

	DXF
	Supported (R13 only)
	Supported
	Supported
	Filling is not supported, - format restriction.

	CGM
	Not supported
	Supported
	Supported
	No raster, format - restriction

	PLT
	Not supported
	Supported
	Supported
	No colors, no filling - format restriction.

	PCT
	Not supported
	Supported
	Supported
	Elliptical arcs not supported.

	DRW
	Not supported
	Supported
	Supported
	Elliptical arcs not supported.

	WMF
	Supported
	Supported
	Supported
	

	EMF
	Supported
	Supported
	Supported
	

	GBR
	Not supported
	Supported
	Supported
	Two colors only, - format restriction

	SHP
	Not supported
	Supported
	Supported
	No raster - format restriction

	PRN
	Supported
	Supported
	Supported
	No colors, no filling - format restriction.

	SVG
	Supported
	Supported
	Supported
	

	WPG
	Supported
	Supported
	Supported
	


 XE "Table Detection " \* MERGEFORMAT 

 XE "Menus " \* MERGEFORMAT Table Detection

When printing a Microsoft Word Doc file, the document engine uses table detection. The document engine will try to detect tables in the document and add them as objects, instead of drawing them as shapes. In the past, drawing tables as shapes has generated many problems.

For the end-user's convenience, table detection is enabled optionally using a check box from within the MS Word Options dialog.

Table detection is more successful with simple tables. Complicated tables may produce unpredictable document output.

LEADTOOLS Products and Licensing

 XE "Licensing " \* MERGEFORMAT 

 XE "License Agreement " \* MERGEFORMAT 

 XE "End User Edition " \* MERGEFORMAT 

 XE "Adding a license key " \* MERGEFORMAT ePrint SOFTWARE LICENSE AGREEMENT – End User Edition

THIS SOFTWARE LICENSE AGREEMENT ("AGREEMENT") IS A LEGAL CONTRACT BETWEEN YOU (EITHER AN INDIVIDUAL OR AN ENTITY) AND LEAD TECHNOLOGIES, INC. ("LEAD"). BY INSTALLING OR USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, REMOVE THE PRODUCT FROM YOUR HARD DRIVE AND PERMANENTLY ERASE ALL COPIES OF THE PRODUCT. IF THE SOFTWARE HAS BEEN DELIVERED TO YOU ON PHYSICAL MEDIA, SUCH AS A CD OR DISKETTE, YOU MUST PROMPTLY RETURN THE SOFTWARE WITH PROOF OF PURCHASE TO THE PLACE WHERE IT WAS PURCHASED FOR A FULL REFUND OF THE AMOUNT PAID. IF THE SOFTWARE YOU HAVE DOWNLOADED IS OFFERED AS "DOWNLOAD ONLY", YOU HAVE BEEN REQUIRED TO ACCEPT THIS LICENSE AGREEMENT PRIOR TO DOWNLOADING THE SOFTWARE. LEAD DOES NOT PROVIDE REFUNDS FOR SOFTWARE OFFERED AS "DOWNLOAD ONLY".

GRANT OF LICENSE. This License Agreement permits you to use one copy of the accompanying LEAD software program known as LEADTOOLS ePrint Professional, in machine readable binary object code form, (the "Software"), which may include electronic documentation, on a single computer/workstation. The Software is "in use" on a computer when it is loaded into the temporary memory (i.e., RAM or Cache) or installed into a permanent memory (e.g., hard disk, CD-ROM drive or other storage device) of that computer. This License does not constitute a sale and does not authorize a sale of the Software or anything created thereby. All intellectual property rights (including copyright, trademark and patent) in the Software are owned by LEAD and its suppliers and licensors, and are protected by the United States laws and international treaty provisions. LEAD and its suppliers and licensors retain all rights not expressly granted herein. You must treat the Software like any other copyrighted material, except that you may make one copy of the Software solely for backup or archival purposes. You may transfer your rights under this Agreement on a permanent basis provided you transfer the license granted by this Agreement, and the Software and all associated printed materials, and you retain no copies, and the recipient agrees to all of the terms of this Agreement.
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You may not use the Software on or over a network or any other transfer device (including the Internet). Use of the Software on more than one computer constitutes copyright infringement and may be punishable by civil fines, criminal penalties, or both.
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You may not rent or lease the Software 
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You may not translate, reverse engineer, decompile or dissemble the Software, except to the extent expressly permitted by applicable law.
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You may not remove any proprietary notices or labels in the Software.
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You may not copy the printed materials accompanying the Software or distribute printed copies of any user documentation provided in electronic format.
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You may not publicly perform or publicly display the Software.

In the event you fail to comply with any of the terms or conditions of this license, your rights to use the Software will end, you shall stop using the Software, remove the Software from your computer and permanently erase all copies of the Software. You may terminate this License at any time by destroying the Software and all copies thereof. You may not export or re-export the Software or any underlying information or technology except in full compliance with all United States and other applicable laws and regulations.

LIMITED WARRANTY. LEAD and its suppliers and licensors warrant to the original installer of the Software, for a period of thirty (30) days from the date of purchase, that the media on which the Software is distributed is substantially free from defects in materials and workmanship. Except as set forth above, the Software is sold "as is," without any express or implied warranties of any kind. ANY AND ALL IMPLIED WARRANTIES WITH RESPECT TO THE SOFTWARE AND THE ACCOMPANYING WRITTEN MATERIALS, INCLUDING, BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE AND NONINFRINGMENT ARE EXPRESSLY DISCLAIMED.

REMEDIES. Your exclusive remedy shall be, at LEAD’s sole option, (a) the refund of the amount you paid for the Software or (b) repair or replacement of the Software, provided that the defective Software is returned to LEAD (at LEAD Technologies, Inc., 1201 Greenwood Cliff, Suite 400, Charlotte, NC 28204, telephone 704-332-5532) along with proof of the date of purchase within thirty (30) days from the date of purchase. This limited Warranty is void if failure of the Software has resulted from accident, abuse, neglect or misapplication. Any replacement Software will be warranted for thirty (30) days. 

LIMITATION OF LIABILITIES. IN NO EVENT WILL LEAD OR ITS SUPPLIERS AND LICENSORS BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL, ECONOMIC, COVER, CONSEQUENTIAL, EXEMPLARY OR PUNITIVE DAMAGES ARISING OUT OF THE USE OF OR INABILITY TO USE THE SOFTWARE, USER DOCUMENTATION, OR RELATED TECHNICAL SUPPORT, INCLUDING, WITHOUT LIMITATION, DAMAGES OR COSTS RELATING TO THE LOSS OF PROFITS, BUSINESS, GOODWILL, DATA, TIME OR COMPUTER PROGRAMS, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT WILL LEAD’S AND ITS SUPPLIERS’ AND LICENSORS’ LIABILITY EXCEED THE AMOUNT PAID BY YOU FOR THE SOFTWARE REGARDLESS OF THE FORM OF THE CLAIM (INCLUDING, WITHOUT LIMITATION, ANY CONTRACT, PRODUCT LIABILITY OR TORT CLAIM). BECAUSE SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

U.S. GOVERNMENT RESTRICTED RIGHTS. The Software and user documentation is provided with RESTRICTED RIGHTS AND LIMITED RIGHTS. Use, duplication, or disclosure by the government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer Software-Restricted Rights at CFR 52.227-19, as applicable. LEAD Technologies, Inc., 1201 Greenwood Cliff, Suite 400, Charlotte, NC 28204.

INDEMNIFICATION  In the event that a claim is filed in a court of competent jurisdiction alleging that the Software used within the scope of the license granted hereunder directly infringes any copyright or trade secret of any third party ("Infringement Action"), LEAD shall indemnify, defend and hold Licensee harmless from and against such Infringement Action and any and all costs, damages, penalties and expenses, including reasonable attorneys’ fees, finally resulting from or awarded in actions attributable to such claim, provided that (a) Licensee promptly notifies LEAD in writing of the existence of such Infringement Action when Licensee becomes aware of such Infringement Action, (b) LEAD has control of the defense of such Infringement Action and all related settlement negotiations, and (c) Licensee provides all reasonable assistance and cooperation in such defense. In the event of an infringement claim for which LEAD is obligated to indemnify Licensee, LEAD may, at its sole discretion, (i) obtain a license that allows Licensee to continue using the Software, or (ii) replace or modify the Software so as to be non-infringing in a manner that does not materially affect its functionality. The foregoing represents LEAD’s sole responsibility to Licensee in the event of a third party infringement claim of any kind, and it is agreed that LEAD will have no responsibility or liability whatsoever in connection with any third party patent claims.

MISCELLANEOUS. No change or modification of the License will be valid unless it is in writing and is signed by LEAD. The provisions of this Agreement are severable; if any provision is held to be invalid or unenforceable, it shall not affect the validity or enforceability of any other provision. If the Software was acquired outside the United States, then local law may apply. Any and all disputes arising hereunder will be heard and settled exclusively in state or federal courts located in the city of Charlotte, County of Mecklenburg, North Carolina, and you hereby submit to the jurisdiction of such courts.
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	THIS SOFTWARE LICENSE AGREEMENT ("AGREEMENT") IS A LEGAL CONTRACT BETWEEN YOU (EITHER AN INDIVIDUAL OR AN ENTITY) AND LEAD TECHNOLOGIES, INC. ("LEAD"). BY INSTALLING OR USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, REMOVE THE PRODUCT FROM YOUR HARD DRIVE AND PERMANENTLY ERASE ALL COPIES OF THE PRODUCT. IF THE SOFTWARE HAS BEEN DELIVERED TO YOU ON PHYSICAL MEDIA, SUCH AS A CD OR DISKETTE, YOU MUST PROMPTLY RETURN THE SOFTWARE WITH PROOF OF PURCHASE TO THE PLACE WHERE IT WAS PURCHASED FOR A FULL REFUND OF THE AMOUNT PAID. IF THE SOFTWARE YOU HAVE DOWNLOADED IS OFFERED AS "DOWNLOAD ONLY", YOU HAVE BEEN REQUIRED TO ACCEPT THIS LICENSE AGREEMENT PRIOR TO DOWNLOADING THE SOFTWARE. LEAD DOES NOT PROVIDE REFUNDS FOR SOFTWARE OFFERED AS "DOWNLOAD ONLY".


	
	
	1.
	Definitions. As used in this Agreement, the following terms, when capitalized, will have the following meanings:

	
	
	
	

	
	
	
	(a)
	"End Users " means customers, employees, contractors and other third parties who receive a license to use the Combined Product solely for personal or business use, and not for further distribution, modification or remarketing. 

	
	
	
	
	

	
	
	
	(b)
	"Combined Product" means the product created by bundling the Software and the Application Software.

	
	
	
	
	

	
	
	
	(c)
	"ePrint Redistributables" means Software files which may be copied and redistributed to End Users as part of the Combined Product. The ePrint Redistributables are those files identified in the Software help file as being redistributable.

	
	
	
	
	

	
	
	
	(d)
	"Licensee" refers to you, the person who has licensed the Software and is accepting the terms of this Agreement.

	
	
	
	
	

	
	
	
	(e)
	"Application Software" means the software program Licensee is integrating with the Software to create the Combined Product. The Application Software must have substantial independent functionality and value separate and apart from the Software.

	
	
	
	
	

	
	
	
	(f)
	"Software" means the accompanying LEAD software program known as LEADTOOLS ePrint API, in machine readable binary object code form, (the "Software"), which may include electronic documentation. 

	
	
	
	

	
	
	
	

	
	
	2.
	License Grants. LEAD hereby grants and Licensee hereby accepts the following nonexclusive licenses and rights with respect to the Software.


	
	
	
	(a)
	Grant of License to use the Software for Development Purposes. LEAD hereby grants to Licensee and Licensee hereby accepts a worldwide, nonexclusive and nontransferable license to install the Software on one (1) computer and use the Software application programming interface ("API") for the purpose of integrating the Software with the Application Software to create the Combined Product. Licensee may make a reasonable number of archival copies of the Software. 

	
	
	
	
	

	
	
	
	(b)
	Grant of Distribution and Deployment License. So long as this Agreement remains in effect and subject to the terms hereof, including payment of the runtime license fees described in paragraph 3 hereof, LEAD grants Licensee a worldwide, nonexclusive and nontransferable license to copy, have copied, publish and duplicate the ePrint Redistributables and distribute with the Combined Product, and to grant licenses in the Combined Product to End Users, directly, and through customary reseller and distribution channels. Licensee is further granted a worldwide, nonexclusive and nontransferable license to install and deploy the Combined Product, on computers owned or controlled by Licensee for use by Licensee End Users for internal use.

	
	
	
	
	

	
	
	
	(c)
	Restrictions. Licensee may not use, copy, distribute, publish, sublicense, lease or transfer the Software except as expressly provided for in this Agreement and may not grant any rights in the Software inconsistent with the terms of this Agreement. Licensee may not distribute or use the Software as a stand-alone product; the Software may only be used or offered in connection with the Combined Product. Licensee will not modify, decompile, disassemble or reverse engineer the Software or attempt to do so except to the extent expressly permitted by applicable law. Licensee will not include the Software or any portion thereof in a product that is intended for use by computer programmers such as a developer toolkit product. No rights to the source code version of the Software are granted herein.

	
	
	
	
	

	
	
	
	(d)
	Proprietary Rights. Except for the limited license granted herein, LEAD and its suppliers retain exclusive ownership of all proprietary rights (including all ownership rights, title, and interest in all associated intellectual property rights) in and to the Software. Licensee will not remove or destroy any proprietary markings or notices placed on the Software.


	
	
	3.
	Runtime Licenses. A runtime license is required for each "Deployment" of the Combined Product. A "Deployment" of Combined Product includes: (i) each copy of the Combined Product installed by Licensee for internal use and (ii) each copy of the Combined Product distributed to third parties by Licensee and its resellers/distributors. If the Combined Product is installed on a network or server by Licensee or any of its customers, a runtime license is required for each computer that is connected to the network or server having access to the Application Software. Ten (10) runtime licenses are included with the initial purchase of the Software and Licensee will receive 10 unique serial numbers. A unique serial number is required to install the Software. Additional runtime licenses (serial numbers) can be purchased in the quantity blocks as follows:


	
	Quantity Prepaid
	Price Per Copy
	Minimum Prepayment

	
	1+
	$30.00
	$30.00

	
	5+
	27.00
	135.00

	
	10+
	25.00
	250.00

	
	25+
	23.00
	575.00

	
	50+
	22.00
	1,100.00

	
	100+
	21.00
	2,100.00

	
	250+
	19.00
	4,750.00

	
	500+
	17.00
	8,500.00

	
	1,000+
	15.00
	15,000.00


	
	
	4.
	Licensee End Users. Licensee is fully responsible for the marketing, sale, support, installation, and distribution of the Combined Product to Licensee’s End Users. Licensee will indemnify and hold LEAD harmless from and against all liability, loss, cost, damage or expense, including reasonable attorneys fees, arising from Licensee’s distribution of the Combined Product, including any claims made by Licensee’s customers and other third parties.


	
	
	5. 
	Limited Warranty. LEAD and its suppliers and licensors warrant to the original installer of the Software, for a period of thirty (30) days from the date of purchase, that the media on which the Software is distributed is substantially free from defects in materials and workmanship. Except as set forth above, the Software is sold "as is," without any express or implied warranties of any kind. ANY AND ALL IMPLIED WARRANTIES WITH RESPECT TO THE SOFTWARE AND THE ACCOMPANYING WRITTEN MATERIALS, INCLUDING, BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE AND NONINFRINGMENT ARE EXPRESSLY DISCLAIMED.

	

	
	
	5.
	Remedies. Your exclusive remedy shall be, at LEAD’s sole option, (a) the refund of the amount you paid for the Software or (b) repair or replacement of the Software, provided that the defective Software is returned to LEAD (at LEAD Technologies, Inc., 1201 Greenwood Cliff, Suite 400, Charlotte, NC 28204, telephone 704-332-5532) along with proof of the date of purchase within thirty (30) days from the date of purchase. This limited Warranty is void if failure of the Software has resulted from accident, abuse, neglect or misapplication. Any replacement Software will be warranted for thirty (30) days. 

	

	
	
	6.
	Limitation of Liabilities. IN NO EVENT WILL LEAD OR ITS SUPPLIERS AND LICENSORS BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL, ECONOMIC, COVER, CONSEQUENTIAL, EXEMPLARY OR PUNITIVE DAMAGES ARISING OUT OF THE USE OF OR INABILITY TO USE THE SOFTWARE, USER DOCUMENTATION, OR RELATED TECHNICAL SUPPORT, INCLUDING, WITHOUT LIMITATION, DAMAGES OR COSTS RELATING TO THE LOSS OF PROFITS, BUSINESS, GOODWILL, DATA, TIME OR COMPUTER PROGRAMS, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT WILL LEAD’S AND ITS SUPPLIERS’ AND LICENSORS’ LIABILITY EXCEED THE AMOUNT PAID BY YOU FOR THE SOFTWARE REGARDLESS OF THE FORM OF THE CLAIM (INCLUDING, WITHOUT LIMITATION, ANY CONTRACT, PRODUCT LIABILITY OR TORT CLAIM). BECAUSE SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY TO YOU.


	
	
	7.
	U.S. Government Restricted Rights. The Software and user documentation is provided with RESTRICTED RIGHTS AND LIMITED RIGHTS. Use, duplication, or disclosure by the government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer Software-Restricted Rights at CFR 52.227-19, as applicable. LEAD Technologies, Inc., 1201 Greenwood Cliff, Suite 400, Charlotte, NC 28204.

	

	
	
	8.
	Indemnification. In the event that a claim is filed in a court of competent jurisdiction alleging that the Software used within the scope of the license granted hereunder directly infringes any copyright or trade secret of any third party ("Infringement Action"), LEAD shall indemnify, defend and hold Licensee harmless from and against such Infringement Action and any and all costs, damages, penalties and expenses, including reasonable attorneys’ fees, finally resulting from or awarded in actions attributable to such claim, provided that (a) Licensee promptly notifies LEAD in writing of the existence of such Infringement Action when Licensee becomes aware of such Infringement Action, (b) LEAD has control of the defense of such Infringement Action and all related settlement negotiations, and (c) Licensee provides all reasonable assistance and cooperation in such defense. In the event of an infringement claim for which LEAD is obligated to indemnify Licensee, LEAD may, at its sole discretion, (i) obtain a license that allows Licensee to continue using the Software, or (ii) replace or modify the Software so as to be non-infringing in a manner that does not materially affect its functionality. The foregoing represents LEAD’s sole responsibility to Licensee in the event of a third party infringement claim of any kind, and it is agreed that LEAD will have no responsibility or liability whatsoever in connection with any third party patent claims.

	

	
	
	9.
	Miscellaneous. No change or modification of the License will be valid unless it is in writing and is signed by LEAD. The provisions of this Agreement are severable; if any provision is held to be invalid or unenforceable, it shall not affect the validity or enforceability of any other provision. If the Software was acquired outside the United States, then local law may apply. Any and all disputes arising hereunder will be heard and settled exclusively in state or federal courts located in the city of Charlotte, County of Mecklenburg, North Carolina, and you hereby submit to the jurisdiction of such courts.
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License Pricing

LEADTOOLS ePrint API ("LEAD SDK") requires licensing based on your use/deployment of the end user application that you will be bundling with ePrint ("Application Software"). If none of LEAD’s licensing models satisfy your requirements, we work with you to develop a licensing program that will fit into your business model. Contact oemsales@leadtools.com to further discuss licensing options.

The basic licensing model for the LEAD SDK requires that a runtime license be purchased for each "Deployment" of the Application Software. A "Deployment" of Application Software includes: (i) each copy of the Application Software installed by customer for internal use and (ii) each copy of the Application Software distributed to third parties by customer and its resellers/distributors. If the Application Software is installed on a network or server by customer or any of customer’s licensees, a runtime license is required for each computer that is connected to the network or server having access to the Application Software. Ten (10) runtime licenses are included with the initial purchase of the LEAD SDK. Customers also have the option of purchasing additional runtime licenses in prepaid quantity blocks as follows:

	Quantity Prepaid
	Price Per Copy
	Prepayment

	1+
	$30.00
	$30.00

	5+
	27.00
	135.00

	10+
	25.00
	250.00

	25+
	23.00
	575.00

	50+
	22.00
	1,100.00

	100+
	21.00
	2,100.00

	200+
	19.50
	3,900.00

	500+
	17.00
	8,500.00

	1,000+
	15.00
	15,000.00


If the foregoing licensing model does not satisfy your requirements, we will work with you to develop a licensing program that will fit into your business model. Contact oemsales@leadtools.com to further discuss licensing options.

LEAD also offers an OEM edition of ePrint API which allows the user to change the name of the printer driver, make other UI changes and create a private label version of ePrint. To obtain licensing information for the OEM edition, contact oemsales@leadtools.com.
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Important Note Concerning Licensed Fonts Some fonts are subject to a license granted by the owner of the font that provides that the font may NOT be embedded or otherwise distributed without a license from the font owner. These fonts will be referred to herein as "Licensed Fonts". Users of ePrint are responsible for obtaining the necessary license from the owner of a Licensed Font if the user wishes to embed the Licensed Font. To determine if a font is a Licensed Font, see the list of Fonts in the Custom Font Embedding section of The Font Embedding Tab. Licensed Fonts display a locked padlock icon in the License column of the Custom Font Embedding list. Failure to obtain the necessary licenses may expose the user to legal claims by the owners of the Licensed Font. LEAD Technologies, Inc. assumes no responsibility for such claims.

 XE "Topic Selection " \* MERGEFORMAT 

 XE "Products " \* MERGEFORMAT LEADTOOLS Products and Licensing

LEADTOOLS products are ideal for developers involved in still frame, multimedia, document, medical, and vector imaging projects, including Internet/Intranet applications. Independent of the specific application requirement – scanning, file format support/conversion, compression, image processing, annotation, database support, multimedia, etc. – LEADTOOLS provides the most comprehensive, robust, flexible, and powerful imaging solutions available.
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	Double-click this button to launch the Licensing help file and review the license agreements governing the use of LEADTOOLS software.
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	Double-click this button to launch the Products help file and review the full line of LEADTOOLS Products.


Contact Us:

	LEAD Technologies, Inc.
Suite 400
1201 Greenwood Cliff
Charlotte, NC 28204


	Email:

Website:

Phone: 

FAX:

Tech Support: 
	 sales@leadtools.com
 http://www.eprintdriver.com, http://www.leadtools.com
(704) 332-5532

(704) 372-8161

See the Technical Support page.
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